About the Author

Frederic Jones, PhD, (Masters at FST/GTU, Masters/PhD(ABD) at Florida State Univ., PhD at International College), is an experienced multimedia artist, filmmaker, and author. He has written over 30 books including: How to do Everything with Digital Video (McGrawHill) and Desktop Digital Video (PrenticeHall), Sing to the Lord a New Song: Contemporary Songs, Rituals and Liturgy (Judith Jones, co-author, Speak from the Heart Press). He co-authored and produced, with Judith Jones, Beyond Time, a major CD-ROM game published by Virgin Interactive which sold over 400,000 copies worldwide. He has written, animated, and produced several international hit interactive CD-ROM children’s titles. He produced a number of videos for a wide variety of clients including: Herman Miller Corporation, Westinghouse, Lightolier, and so on. He is also a Christian pastor.

Author’s Acknowledgments

I would like to thank Dr. Judith K. Jones for her contribution to the book, editorially, photographically, and intellectually. She also kept bringing me Diet Coke and chips long into the dark nights. Thanks to the folks at Adobe for the review software and other technical assistance. Gateway generously provided a great digital camera for my use throughout the book. Thanks to the many models for the photos, including: Molly Jones, Regina Melendez, Ken Babauta, Judith Jones, Doug and Mark Northrip, Mary Atchison, Andrea and James Olson, Ruth and John Jewell, Heather and Erik Iversen, and Angel and Shawna Miller. Judith Jones and Mary Atchison contributed several photos. I would particularly like to thank my agent, Craig Wiley of Waterside Productions. He gets the job done. Steve Hayes, the Wiley Acquisitions Editor has been great to work with, and Kyle Looper is the best Project Editor I have ever worked with (and that’s saying something). Kyle deserves co-author credit (but I think I will keep the royalties). Finally, thanks to my loyal parishioners who have patiently listened to me complain about my totally reasonable editorial deadlines.

I hope you, the reader, enjoy using this book and that it will excite you about using digital photography as much as writing about it has excited me. Digital photography is so much more fun and useful than film photography ever was. It’s an amazing world!

Dedication

For Mom and Dad. I wish they could have seen this book. For Judith my love and for Molly my smart, funny, and ambitious daughter.
Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form located at www.dummies.com/register/.

Some of the people who helped bring this book to market include the following:

**Acquisitions, Editorial, and Media Development**
- **Project Editor:** Kyle Looper
- **Acquisitions Editor:** Steven Hayes
- **Copy Editor:** Rebecca Senninger
- **Technical Editor:** Dan DiNicolo
- **Editorial Manager:** Leah P. Cameron
- **Editorial Assistant:** Amanda Foxworth
- **Cartoons:** Rich Tennant ([www.the5thwave.com](http://www.the5thwave.com))

**Composition**
- **Project Coordinator:** Maridee Ennis
- **Layout and Graphics:** Karl Brandt, Lauren Goddard, Denny Hager, Joyce Haughey, Stephanie D. Jumper, Barry Offringa, Jacque Roth, Mary Gillot Virgin, Erin Zeltner
- **Special Art:** Corbis Digital Stock: *Dog*, ANI0073E; *Field of flowers*, FSE0001E; *Sunflower against blue sky*, NLA0061D
- **Proofreaders:** Jacqui Brownstein, Jessica Kramer, Carl William Pierce, Brian H. Walls
- **Indexer:** Ty Koontz
- **Special Help**
  - Alfred DeBat

**Publishing and Editorial for Technology Dummies**
- **Richard Swadley,** Vice President and Executive Group Publisher
- **Andy Cummings,** Vice President and Publisher
- **Mary Bednarek,** Executive Acquisitions Director
- **Mary C. Corder,** Editorial Director

**Publishing for Consumer Dummies**
- **Diane Graves Steele,** Vice President and Publisher
- **Joyce Pepple,** Acquisitions Director

**Composition Services**
- **Gerry Fahey,** Vice President of Production Services
- **Debbie Stailey,** Director of Composition Services
# Contents at a Glance

## Introduction

### Part I: Acquiring Digital Photos

- Chapter 1: Selecting a Camera and Accessories ...........................................5
- Chapter 2: Setting Up and Using the Camera ..................................................25
- Chapter 3: Snapping Digital Pictures ..............................................................35
- Chapter 4: Viewing and Transferring Images ..................................................49
- Chapter 5: Digitizing Existing Pictures .............................................................59

#### Part II: Editing and Enhancing Digital Photos

- Chapter 6: Manipulating Image Attributes .....................................................71
- Chapter 7: Fixing Common Image Problems ...................................................81
- Chapter 8: Repairing Digital Images ...............................................................89
- Chapter 9: Adding Photo Editor Special Effects .............................................99
- Chapter 10: Adding Photoshop Elements Effects .........................................109
- Chapter 11: Using Layers ..............................................................................117

#### Part III: Keeping and Sharing Your Photos

- Chapter 12: Choosing and Using a Printer .....................................................133
- Chapter 13: Organizing and Sharing Photos .................................................143

#### Part IV: Special Projects

- Chapter 14: Taking Close-Up Photos for eBay .............................................155
- Chapter 15: Restoring Old Photos .................................................................165
- Chapter 16: Documenting Your Travels .........................................................173
- Chapter 17: Creative Mini-Projects .................................................................181

### Index

**197**
Part II: Editing and Enhancing Digital Photos ......................................69

Chapter 6: Manipulating Image Attributes ..............................71
- Open an Image to Edit ..................................72
- Change the Image Size .....................................73
- Convert an Image to a New Format .........................74
- Flip or Rotate an Image ..................................76
- Crop an Image ...........................................77
- Invert an Image’s Colors ..................................78
- Save an Image for the Web .................................79

Chapter 7: Fixing Common Image Problems .........................81
- Adjust Image Brightness or Contrast .......................82
- Adjust Hue and Saturation ................................82
- Sharpen an Image ........................................83
- Posterize an Image .......................................84
- Soften an Image ..........................................85
- Smudge an Image ........................................86
- Despeckle an Image ......................................87

Chapter 8: Repairing Digital Images .................................89
- Fix Contrast and Brightness Problems in Quick Fix View .90
- Fix Faded Photos in Quick Fix View .......................91
- Fix Focus Problems with Auto Sharpen .................92
- Rotate an Image in Quick Fix View .......................92
- Remove Red Eye .........................................93
- Remove Dust and Scratches ................................94
- Remove Creases and Blemishes ..........................95
- Fix a Torn Photo ..........................................96
- Convert a Color Photo to Grayscale .......................97
- Make a Photo Collage ....................................97

Chapter 9: Adding Photo Editor Special Effects .......................99
- Make an Image Look Like a Chalk-and-Charcoal Drawing .................................................................100
- Emboss an Image to Make It Appear Raised ................101
- Make an Image Resemble a Watercolor Painting ........102
- Make an Image Resemble Textured Paper ...............103
- Make an Image Resemble Stained Glass ..................104
- Add a Textured Look to an Image .........................105
- Make an Image Look Like a Pen-and-Ink Drawing ......106
- Outline an Image’s Edges ................................107

Chapter 10: Adding Photoshop Elements Effects .....................109
- Blow Motion into Images ................................110
- Make a Photo Look Like a Mosaic .........................110
- Give a Photo a Chromed Metallic Look ..................111
- Change a Photo to a Colored Pencil Drawing ............112
- Change Photo Lighting ....................................113
- Distort a Photo Around an Axis ..........................114
- Use the Difference Clouds Effect .........................115

Chapter 11: Using Layers ........................................117
- Select an Area to Move to a Layer .........................118
- Move the Selection to a New Layer ......................119
- Add a New, Blank Layer to an Image ...................120
- Rename a Layer ..........................................121
- Link a Layer to Another Layer ...........................121
- Change the Layer Order ................................122
- Edit a Layer ..............................................123
- Hide or Display a Layer ................................124
- Delete a Layer ............................................124
- Add a Text Layer to an Image ............................125
- Move Image Elements to a New Photo ................126
- Paint on an Image .......................................127
- Add a Digital Frame to a Photo .........................128
- Add a Background Element from Another Photo ....128
# Table of Contents

## Part III: Keeping and Sharing Your Photos  
131

### Chapter 12: Choosing and Using a Printer  
133

- Choose a Printer Type  .  134
- Evaluate Printer Resolution  .  134
- Evaluate Printer Speed  .  135
- Evaluate Other Printer Features  .  135
- Set Printer Options  .  136
- Choose Print Media  .  138
- Evaluate the Cost of Printing Photos  .  138
- Print from a Memory Card  .  139
- Print from a Digital Camera Using PictBridge  .  140
- Use Online Photo Printing Services  .  141
- Use In-Store Photo Printing Services  .  142

### Chapter 13: Organizing and Sharing Photos  
143

- Import Photos into Photoshop Album  .  144
- Organize Photos with Photoshop Album  .  145
- Categorize Photos with Tags  .  146
- Search for Photos Bearing Particular Tags  .  147
- Rename a Group of Photos at the Same Time  .  147
- Make a Digital Slideshow  .  148
- Create a Photo Album  .  150
- Create a Greeting Card  .  150
- Burn a Video CD  .  151
- Share Photos via E-Mail  .  152

## Part IV: Special Projects  
153

### Chapter 14: Taking Close-Up Photos for eBay  
155

- Set Up the Camera for a Close-Up  .  156
- Set Up Lighting for the Item  .  157
- Use a Copy Stand to Support the Camera  .  158
- Set Up and Shoot  .  159
- Shoot Particular Item Types  .  160
- Upload Your Photos to eBay  .  163
- Host eBay Pictures at a Hosting Service  .  164

### Chapter 15: Restoring Old Photos  
165

- Scan a Photo  .  166
- Crop the Image  .  167
- Adjust Photo Color  .  167
- Remove Scratches and Specks  .  168
- Remove Spots and Damaged Areas  .  169
- Touch-Up with the Airbrush Tool  .  170
- Archive Printed Photos  .  171

### Chapter 16: Documenting Your Travels  
173

- Research and Plan Your Photo Shoots  .  174
- Gear Up for the Trip  .  175
- Tell the Story  .  176
- Include People and Pets in Your Photos  .  177
- Take Creative Travel Pictures  .  178
- Edit Photos on the Road  .  179
- E-Mail Photos from the Road  .  180
- Create a Photo Travel Blog  .  180

### Chapter 17: Creative Mini-Projects  
181

- Plan a Wedding Shoot  .  182
- Make a Wedding Announcement  .  184
- Plan a Digital Family Album  .  185
- Make a Digital Family Album  .  188
- Make an Insurance Inventory  .  189
- Make a Photo T-Shirt  .  190
- Set a Digital Image as Your Wallpaper  .  191
- Create an Organization Photo Directory  .  192
- Show Photos on Your TV  .  194
- Make a Mini-Movie Clip  .  195
- Record Sound Notes  .  196

## Index  
197
Polar Coordinates
The image is bent around the inside or outside of a sphere. This is an extreme effect. The step-by-step procedure to employ this effect can be found in “Distort a Photo Around an Axis” in Chapter 10.
Chrome Filter
This filter gives images an embossed, chromed look. Choose an image that has bold objects rather than fussy detail for best results. The step-by-step procedure to employ this effect can be found in “Give a Photo a Chromed Metallic Look” in Chapter 10.
Colored Pencil Filter
This is a lovely fine art filter. Print the image on matte grey or off white paper for a spectacular print. The step-by-step procedure to employ this effect can be found in “Change a Photo to a Colored Pencil Drawing” in Chapter 10.
Lighting Effect
This is just one of many lighting effects that can dramatically improve a dull composition. The step-by-step procedure to employ this effect can be found in “Change Photo Lighting” in Chapter 10.
Wind Effect
The effect is in the medium range. Light “wind” can give the sense of motion and direction to an image. Try it on a moving bike or car. The step-by-step procedure to employ this effect can be found in “Blow Motion into Images” in Chapter 10.
Posterize Effect
Silk screen prints are evoked with this popular effect. Print the image on oversized white paper and add text for your own travel poster. The step-by-step procedure to employ this effect can be found in “Posterize an Image” in Chapter 7.
Color to Black and White Conversion

One of the key strengths of digital photography is that the type of film can be changed after the photo has been taken. Print on sepia toned digital photo paper for an art photography look. See “Convert a Color Photo to Grayscale” in Chapter 8 for the step-by-step procedure.
Adjust Image Values
Don’t let poor photo-taking conditions make for unusable digital photos. With image editing software, you can easily adjust color hue and saturation, as well as brightness and contrast. Chapters 7 and 8 give you some insight into the tools and techniques available in Adobe Photoshop Elements.
Invert Positive to Negative
This filter can be used for a dramatic effect or it can be used to change scanned negatives to positive images for printing. To employ this effect, consult the steps in “Invert an Image’s Colors” in Chapter 6.
Lightened Image
A good example of an image rescued from the darkness. Digital photos capture more information than is first apparent. Procedures for fixing brightness problems in an image can be found in most image editing software. Check out the simple steps in “Adjust Image Brightness or Contrast” in Chapter 7.
Mosaic Tile Effect
The Mosaic Tile effect is a simple one to use for art prints. It prints well on large paper. Combine this with color enhancement filters for more dramatic prints. For the steps to implement this effect, see “Make a Photo Look Like a Mosaic” in Chapter 10.
Note Paper Effect
The Note Paper effect resembles a fine etching. Print it on rich matte paper and add a deeply matted frame. Check out the steps for achieving this effect in "Make an Image Resemble Textured Paper" in Chapter 9.
Adding a New Sky

The sky can make the difference between a tossed-away photo and a picture postcard. Print the image on glossy postcard paper and mail it to friends. Find out how to add a new sky with “Add a Background Element from Another Photo” in Chapter 11.
Difference Clouds Effect

This is a dramatic effect that works well on images with interesting and rich textures. It can also be applied to skies for drama. The step-by-step instructions for this effect can be found in Chapter 10 in the task titled “Use the Difference Clouds Effect.”
Move People to a New Image

You can visit San Francisco without ever leaving Cleveland when you use Photoshop Elements to combine multiple images. Chapter 11 explains using layers to achieve effects like this.
Retouch a Damaged Photo

Photoshop Elements can be a first aid kit for favorite photos that have met with disaster. Some patience and practice are required to become expert at photo retouching. Don’t be afraid to use the Undo command. Chapter 8 provides tasks to repair image problems in Adobe Photoshop Elements.
Welcome to the world of digital photography! Whether digital photography is a new interest of yours or whether it’s your passion, there’s something in Digital Photography Just the Steps For Dummies for you.

About This Book

Like anything else, digital photography is easy — if you know what you’re doing. It’s getting to the point of knowing what you’re doing that can be frustrating. This book gives you the little bit of help you need. The steps for using this book are:

1. Pick the task. You know what you want to do, and if you don’t, the intro page on each chapter gives you an idea of what’s covered in that chapter.

2. Find it fast. That’s easy because tasks are grouped logically into parts and chapters. The coverage proceeds from basic to advanced topics.

3. Get it done. Just follow the steps and look at the figures on the side of the steps to make sure you’re following them right. What could be simpler?

Why You Need This Book

Digital Photography Just the Steps For Dummies gives you just what you want — in a step-by-step format. The Just the Steps For Dummies series was designed for those people who constantly find themselves saying, “I don’t need to know all that; just give me the steps!” If you just want to know how to do stuff with your digital camera without having to read a tome the size of War and Peace, then this book is for you!

This book takes you through digital photography from soup to nuts. You start out by figuring out what type of digital camera and accessories you need, and you progress through using the camera to editing digital photos to great digital photography projects.
How This Book Is Organized

Digital Photography Just the Steps For Dummies is divided into four parts.

Part I: Acquiring Digital Photos

Digital photos can come from a variety of sources. Of course, you can take them with a digital camera (and Chapter 1 tells you about the types of cameras and accessories that are available). But you can also acquire digital photos by scanning the figures. Everything you need to get digital photos onto your computer — including, of course, taking the pictures themselves — is covered in this part.

Part II: Editing and Enhancing Digital Photos

The great thing about digital photos is that after you take the photo, you’re not at the mercy of the development studio. You can fix most problems yourself. I show you how with two editing tools: Microsoft Photo Editor, which comes with Microsoft Office, and Adobe Photoshop Elements, a popular image editing program that costs around $100.

Part III: Keeping and Sharing Your Photos

Digital photos are subject to entropy, especially on your computer. Before all becomes chaos, check out the organizational tips in this part.

Part IV: Special Projects

The Special Projects part gives you much to choose from. Interested in taking pictures of items that you want to sell on eBay? Turn to Chapter 14. Want to know how to plan and take great vacation photos? Check out Chapter 15. Looking to restore and archive your precious family photos? Go to Chapter 16. And finally, Chapter 17 provides a large group of simple projects that covers a host of other great uses of your digital camera, from taking insurance photos to wedding pictures. Have fun!

Get Ready To

Don’t feel like you have to do anything in order. You’re the driver and Digital Photography Just the Steps For Dummies is your vehicle. You decide where you want to go. But time’s a’ wastin’. There’s no time like the present to get started!
Part I

Acquiring Digital Photos

The 5th Wave

By Rich Tennant

"Of course graphics are important to your project, Eddy, but I think it would've been better to scan a picture of your worm collection."
Chapter 1: Selecting a Camera and Accessories ..........................5
Choose a Camera Form Factor ..............................................6
Choose Camera Resolution ..................................................7
Evaluate Lens Features .......................................................8
Evaluate Picture Storage Solutions .......................................10
Evaluate Zoom Lenses .......................................................11
Choose a Tripod ................................................................12
Evaluate Camera Power Solutions .......................................13
Evaluate Supported Output Formats ....................................14
Review Image Statistics .......................................................15
Evaluate Camera Functions ................................................16
Evaluate Image Transfer Solutions .......................................18
Evaluate Supported Camera Technologies .............................19
Choose Flash Features .......................................................20
Choose Other Features .......................................................21
Choose Other Accessories ................................................23

Chapter 2: Setting Up and Using the Camera .........................25
Set Up Your Camera ..........................................................26
Point and Shoot in Auto Mode .............................................27
Zoom In on an Object .........................................................28
Adjust Brightness in Program Mode ......................................28
Snap a Portrait Using Automatic Settings ............................29
Stop Action Using Automatic Settings ..................................29
Lengthen Depth of Field .....................................................30
Use Shutter Priority Mode ...................................................30
Reduce Battery Usage .........................................................31
Use a Tripod .................................................................31
Use a Flash Attachment .....................................................32
Use Attachment Lenses .......................................................33

Chapter 3: Snapping Digital Pictures .................................35
Compose Your Photograph ..................................................36
Frame a Stationary Subject ..................................................38
Focus the Camera .............................................................39
Move the Subject Out of the Center with Focus Lock ...........40
Shoot in Poor Illumination ..................................................41
Shoot a Portrait Indoors .......................................................42
Shoot a Portrait Outdoors ...................................................43
Snap a Landscape Picture ....................................................44
Photograph Pets and Animals .............................................45
Shoot Scenic Nature ..........................................................46

Chapter 4: Viewing and Transferring Images .......................49
Review and Delete Pictures in Your Camera .......................50
Connect Your Camera or Card Reader to a Computer .............51
Install Camera or Card Reader Drivers ................................52
Transfer Digital Images to a Computer ...............................53
Delete Camera Images from Windows ................................54
Rename Photos ...............................................................55
View and Manage Photos ...................................................56

Chapter 5: Digitizing Existing Pictures .............................59
Scan a Photo Using Windows Scanner Wizard .....................60
Scan a Photo Using HP Photo and Imaging Director ..........62
Scan a Slide ...............................................................63
Scan a Negative .............................................................64
Use the Scanner Resize Option ...........................................65
Use the Scanner Lighten/Darken Option .............................66
Use the Scanner Sharpen Option .......................................67
Use the Scanner Color Adjustment Option .......................67
Selecting a Camera and Accessories

Choices, choices, choices. Although any number of prices and features are available, three principal grades of digital camera exist: consumer, midrange, and professional. The first step you have to undertake is, of course, deciding which type of camera and which accessories are really important to you as a photographer. You may regard a digital camera as an easy way to handle photographs for family events and things that happen along the way — an inexpensive and user-friendly little camera for casual use. On the other hand, you may be interested in increasing your skill and understanding of photography and want to learn all the “bells and whistles” to become really proficient in photo shooting and editing.

Regardless of which goal you currently embrace (and, make no mistake, many, many people begin with the first and segue into the second), you want to take good, clear pictures and enjoy those camera features and accessories that can help you do that.

This chapter helps you through the process of evaluating and choosing a camera, features, and accessories that are appropriate for your needs and pocketbook. You may want to pay little and expect only a basic camera; or you may want a lot of flexibility and features, and therefore expect to pay more. You want to consider carefully how you expect to use your camera, and choose features and quality accordingly. If you have already purchased a camera, then you can either skip this chapter or read on and start choosing your second digital camera!
Choose a Camera Form Factor

<table>
<thead>
<tr>
<th>Style</th>
<th>Comments</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ultra Compact</strong></td>
<td>Size of a credit card, depth &lt;1&quot;, fits comfortably in front jeans pocket.</td>
<td>$300–$1400 (average $400)</td>
</tr>
<tr>
<td><strong>Subcompact</strong></td>
<td>Fits comfortably in shirt pocket.</td>
<td>$200–$800 (average $300)</td>
</tr>
<tr>
<td><strong>Point and Shoot</strong></td>
<td>Normal size automatic camera that has more features for the price than compacts (requires a camera bag).</td>
<td>$40–$600 (average $300)</td>
</tr>
<tr>
<td><strong>Prosumer</strong></td>
<td>Size similar to SLR cameras. Usually lacks detachable lenses.</td>
<td>$600–$1200 (average $500)</td>
</tr>
<tr>
<td><strong>Single Lens Reflex (SLR)</strong></td>
<td>For serious hobbyists and professionals. High quality cameras that look and function like 35mm cameras, including detachable lenses.</td>
<td>$800–$15,000 (average $1400)</td>
</tr>
</tbody>
</table>

Buy the most camera your budget allows, but budget for the type and frequency of use. Buying a $5000 digital camera to take the occasional snapshot makes no sense. On the other hand, don’t trust a $15 throwaway to take the wedding or first baby pictures except in an emergency, in which case you should buy a throwaway film camera instead.
Choose Camera Resolution

<table>
<thead>
<tr>
<th>Megapixels</th>
<th>What You Can Do with It</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1</td>
<td>Acceptable Web graphics</td>
<td>$30–$100</td>
</tr>
<tr>
<td>1-2</td>
<td>Very good Web graphics. Acceptable prints up to 4”×6”</td>
<td>$50–$350</td>
</tr>
<tr>
<td>2-3</td>
<td>Excellent Web graphics. Good prints up to 5”×7”</td>
<td>$150–$400</td>
</tr>
<tr>
<td>3-4</td>
<td>Excellent prints up to 4”×6”. Very good prints up to 10”×12”</td>
<td>$200–$500</td>
</tr>
<tr>
<td>4-5</td>
<td>Excellent prints up to 5”×7”. Very good prints up to 11”×14”</td>
<td>$250–$600</td>
</tr>
<tr>
<td>5-6</td>
<td>Excellent prints up to 8”×10”. Very good prints up to 16”×20”</td>
<td>$400–$750</td>
</tr>
<tr>
<td>&gt;6</td>
<td>Excellent prints up to 16”×20” and beyond</td>
<td>$800–$15,000</td>
</tr>
</tbody>
</table>

Bigger is better when it comes to resolution. You can always set your camera to take smaller resolution photos, but you can’t increase the camera’s maximum resolution. Buy the highest resolution camera you can afford that also has the other features you desire. On the other hand, balance is the watchword. Many professional photographers use 4 to 6 megapixel cameras on a daily basis.
Evaluate Lens Features

<table>
<thead>
<tr>
<th>Lens Feature</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focal length</td>
<td>The focal length of a lens is the distance between the optical center of</td>
</tr>
<tr>
<td></td>
<td>the lens and the place where it focuses its image (film or digital CCD</td>
</tr>
<tr>
<td></td>
<td>chip) and is expressed in millimeters. This determines the area of</td>
</tr>
<tr>
<td></td>
<td>coverage from narrow to wide. Digital cameras generally rate their</td>
</tr>
<tr>
<td></td>
<td>focal lengths as equivalent to 35mm film camera lenses.</td>
</tr>
<tr>
<td>20mm or less</td>
<td>= Extreme Wide Angle</td>
</tr>
<tr>
<td>24mm to 35mm</td>
<td>= Wide Angle</td>
</tr>
<tr>
<td>50mm to 80mm</td>
<td>= Normal</td>
</tr>
<tr>
<td>100mm to 300mm</td>
<td>= Telephoto</td>
</tr>
<tr>
<td>400mm and above</td>
<td>= Super Telephoto</td>
</tr>
<tr>
<td>Macro mode or lens</td>
<td>This enables close-up photos of small objects. Good cameras have a</td>
</tr>
<tr>
<td></td>
<td>macro mode built into their lenses.</td>
</tr>
<tr>
<td>Normal lens</td>
<td>Usually a 55mm focal length equivalent and is the most commonly used</td>
</tr>
<tr>
<td></td>
<td>fixed lens.</td>
</tr>
<tr>
<td>Wide angle</td>
<td>A lens less than 35mm focal length equivalent. It allows shooting a</td>
</tr>
<tr>
<td></td>
<td>more inclusive image in tight spaces. Lenses much wider than 28mm are</td>
</tr>
<tr>
<td></td>
<td>referred to as fish-eye lenses because of their image distortion.</td>
</tr>
<tr>
<td>Telephoto</td>
<td>Lenses with more than 55mm focal length equivalent. These usually range</td>
</tr>
<tr>
<td></td>
<td>from 75mm to over 1000mm and are used to snap photos of subjects at a</td>
</tr>
<tr>
<td>Zoom</td>
<td>Zoom lenses have variable focal lengths and can be changed from wide</td>
</tr>
<tr>
<td></td>
<td>angle to normal to telephoto. Digital cameras feature both optical and</td>
</tr>
<tr>
<td></td>
<td>digital zooms. Optical zooms result in highest quality.</td>
</tr>
</tbody>
</table>

Figure 1-5: A shot taken with a lens with a wide focal length

Figure 1-6: The same shot taken with a lens with a narrow focal length
Lens Feature | Comments
---|---
Interchangeable lenses | Prosumer and professional cameras permit the use of different lenses. These can range from wide angle to telephoto. Some digital cameras allow the use of the same manufacturers film camera lenses for flexibility.

Lens extenders | These are available to multiply the magnification of zoom or macro lenses. They attach to the camera’s lens. Some cameras don’t accept extenders.

Filters | Better quality cameras allow the use of filters on the end of the camera lens. These can compensate for light color differences and can create special effects.

Most digital cameras, from consumer to prosumer, come with non-changeable optical zoom lenses. Most also have digital zoom features. Buy the camera with the largest zoom ratio you can afford. They range from 1.2x to 10x or more.

To see more examples of the effect of different focal lengths, point your browser to www.usa.canon.com/html/eflenses/lens101/focallength/.

**Figure 1-7:** A variety of detachable lenses

**Figure 1-8:** A lens extender goes between the camera and lens
Evaluate Picture Storage Solutions

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Sizes Available</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Floppy Disk</td>
<td>1.44MB</td>
<td>Sony made floppy disk-based cameras for a while. These have generally been replaced by CD-ROM or memory cards.</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>156MB</td>
<td>Some cameras have onboard CD-ROM burners. These are slow to save images.</td>
</tr>
<tr>
<td>Compact Flash Card Type I &amp; II</td>
<td>16, 32, 64, 128, 256, 512MB; 1GB</td>
<td>Most common memory storage for digital cameras and PDAs. This is the largest format.</td>
</tr>
<tr>
<td>Memory Stick</td>
<td>32, 64, 128, 256, 512MB; 1GB</td>
<td>Sony’s memory solution that is interoperable with a wide range of Sony products.</td>
</tr>
<tr>
<td>Smart Media Card</td>
<td>32, 64, 128, 256MB</td>
<td>Olympus and Fuji primarily use this memory type. They have started to use XD memory.</td>
</tr>
<tr>
<td>MMC Card</td>
<td>32, 64, 128, 256MB</td>
<td>They lack security facilities and are usually compatible with devices using SD cards.</td>
</tr>
<tr>
<td>SD Card</td>
<td>64, 128, 256, 512MB; 1GB</td>
<td>These are also a widely used storage card format.</td>
</tr>
<tr>
<td>XD Card</td>
<td>32, 64, 128, 256, 512MB</td>
<td>XD are recent innovations and store images faster than earlier formats. This memory type is largely specific to Olympus and Fuji cameras.</td>
</tr>
</tbody>
</table>

Some camera models, Sony for example, use floppy disks or CD-ROMs as alternative storage systems for digital photos. Many of these cameras now also support memory cards or sticks of at least one format. Some cameras accept more than one memory card format. Both of these alternatives can add flexibility in the field. Storage media can store approximately 25 pictures at 1600–1200 resolution per 16MB. So a 128MB card can store approximately 100 pictures.
Evaluate Zoom Lenses

<table>
<thead>
<tr>
<th>Feature</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optical</td>
<td>Optical zoom uses the lens mechanism to change the focal length of the lens and allows the lens to zoom closer or farther away from the subject. Optical zoom maintains its quality at all levels. This is the most important type of zoom in a digital camera. A 10x zoom on a digital camera is roughly the equivalent of a 28mm to 200mm zoom lens on a 35mm film camera. The zoom factor of most optical zoom lenses ranges from 1.2x to 10x.</td>
</tr>
<tr>
<td>Digital</td>
<td>Digital zoom does much the same thing as zoom in Photoshop. The camera selects part of the digital image and saves only that part of the photo. Digital zoom reduces the actual resolution of your image, increases noise, and emphasizes shaky camera syndrome. Avoid using digital zoom if possible. If you need to accomplish a digital zoom effect, cropping the best photo you can get in Photoshop later is best. Digital zooms range from 2x to 10x.</td>
</tr>
<tr>
<td>Zoom Ratio</td>
<td>The difference between the size of the image that is projected onto the film at the widest (or smallest focal length) setting of a zoom lens and the size at the narrowest (or longest focal length). A 10x zoom lens magnifies the image in the narrow end of the lens exactly 10 times as much as the image at the wide-angle end.</td>
</tr>
</tbody>
</table>

Figure 1-11: Subject at normal range

Figure 1-12: Same subject at 9x optical zoom
Choose a Tripod

<table>
<thead>
<tr>
<th>Type</th>
<th>Weight</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Still photo</td>
<td>Light</td>
<td>A tripod designed for still photography is designed to position the camera and then lock it into place. Stability and durability are key factors. Good for point-and-shoot cameras.</td>
</tr>
<tr>
<td></td>
<td>Medium</td>
<td>Good for all weight cameras.</td>
</tr>
<tr>
<td></td>
<td>Pro</td>
<td>Good for pro and prosumer cameras. Has extra features, such as levels and fancy angle adjustments.</td>
</tr>
</tbody>
</table>

| Video       | Light to Heavy  | A video tripod is designed to steady the camcorder and allow smooth pans and other camera movements as well as a stable platform when the camera is locked down. |

| Table top   |                 | Good for subcompact and for close-up photography.                      |

| Monopod     | Light to Heavy  | The monopod is a single tripod leg that you can attach a camera to. It doesn’t stand by itself but works well to stabilize a shot and is ultra portable. |

Figure 1-13: A lightweight tripod

Figure 1-14: A monopod
# Evaluate Camera Power Solutions

<table>
<thead>
<tr>
<th>Battery Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alkaline</td>
<td>Alkaline batteries come in all standard sizes. If your camera uses a standard sized battery, it’s probably AA. Alkaline batteries in cameras used with a flash last only a few photos. This is an expensive solution for frequent use.</td>
</tr>
<tr>
<td>Lithium</td>
<td>Disposable batteries. These may be called “photo batteries.” They last well but are very expensive. They are available in most formats.</td>
</tr>
<tr>
<td>Nickel Cadmium</td>
<td>Rechargeable. These must be fully discharged before recharging to avoid “charge memory” and poor performance. Be careful not to overcharge.</td>
</tr>
<tr>
<td>NiMH (Nickel-Metal Hydride)</td>
<td>Nickel-Metal Hydride are excellent batteries and are rechargeable. These are the best value. They come in all standard sizes. Many proprietary batteries used in digital cameras are NiMH. These are powerful batteries and last about 400 charges.</td>
</tr>
<tr>
<td>Lion (Lithium Ion)</td>
<td>Lithium ion batteries are a good choice. They don’t have “charge memory” and they last twice as long as NiMH batteries. These are usually after-market optional batteries and are purchased as extras. These are newer and not as widely available. They last about 400 charges.</td>
</tr>
<tr>
<td>External battery packs</td>
<td>You can power some cameras through the AC power socket using external battery packs. These come in many of the previous formats. These can be much larger with greater storage capacity. Clip them to your belt with a wire running to the camera. These are great on vacations or long shoots like weddings.</td>
</tr>
</tbody>
</table>

More expensive cameras may use proprietary batteries rather than standard AA, AAA, and so on. This means that you must purchase the manufacturers’ batteries or after-market batteries designed for your camera when you need extras or replacements.
## Evaluate Supported Output Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Compression</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>Lossy</td>
<td>This file format is the most common. It’s universally recognized. You can select the amount of compression and subsequent quality or loss of quality in the camera or in the computer.</td>
</tr>
<tr>
<td>TIFF</td>
<td>Lossless</td>
<td>TIFF is a standard photo or digital publishing format. It can be somewhat compressed but in order to lose no quality, the amount of compression is limited. This is a good finished file format and retains high image quality. You can select to shoot TIFF photos with many cameras.</td>
</tr>
<tr>
<td>CCD RAW</td>
<td>Lossless</td>
<td>You can set the more expensive prosumer and professional cameras to save the data directly from the CCD chip in the camera. This saves a huge amount of image information and is used by professional photographers and graphic artists to gain maximum image quality and flexibility. It’s a very large file and severely limits the number of images that can be stored on common memory cards.</td>
</tr>
</tbody>
</table>

When a lossless compression image is uncompressed, its quality matches the original source. Lossy compression degrades images to some degree, and more compression equals more image loss. Use the least compression you can for the original image. You can always compress it more with editing software.
## Review Image Statistics

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Image Size</th>
<th>File Size</th>
<th>Print Size</th>
<th># on 32MB Card</th>
<th># on 1GB Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW</td>
<td>2272x1704</td>
<td>3.3MB</td>
<td>11x8.5</td>
<td>10</td>
<td>359</td>
</tr>
<tr>
<td>TIFF</td>
<td>2272x1704</td>
<td>3.3MB</td>
<td>11x8.5</td>
<td>10</td>
<td>359</td>
</tr>
<tr>
<td>Super Fine JPEG</td>
<td>2272x1704</td>
<td>2.2MB</td>
<td>11x8.5</td>
<td>14</td>
<td>512</td>
</tr>
<tr>
<td>Fine JPEG</td>
<td>2272x1704</td>
<td>1.4MB</td>
<td>11x8.5</td>
<td>27</td>
<td>910</td>
</tr>
<tr>
<td>Normal JPEG</td>
<td>2272x1704</td>
<td>.76MB</td>
<td>11x8.5</td>
<td>54</td>
<td>1726</td>
</tr>
<tr>
<td>Fine JPEG</td>
<td>1600x1200</td>
<td>.76MB</td>
<td>8x6</td>
<td>54</td>
<td>1726</td>
</tr>
<tr>
<td>Fine JPEG</td>
<td>1024x768</td>
<td>.28MB</td>
<td>5x4</td>
<td>94</td>
<td>2981</td>
</tr>
<tr>
<td>Fine JPEG</td>
<td>640x480</td>
<td>.12MB</td>
<td>3x2.5</td>
<td>196</td>
<td>5466</td>
</tr>
</tbody>
</table>

Use this table to determine the amount of memory required to store images of various sizes. You can easily plan memory needs for a vacation or photo shoot.

---

**Figure 1-19:** Choose a low resolution, such as 640x480 if you only want to e-mail your photo.

**Figure 1-20:** Choose a high-resolution setting with no (or low) compression for photos that you want to print and frame.
### Evaluate Camera Functions

<table>
<thead>
<tr>
<th>Function (Mode)</th>
<th>How to Use It</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>Both aperture and shutter speed are set automatically.</td>
<td></td>
</tr>
<tr>
<td>Exposure Compensation</td>
<td>A dial or control that allows you to increase or decrease the exposure one or two stops.</td>
<td>This is used to lighten or darken an image.</td>
</tr>
<tr>
<td>Shutter Priority</td>
<td>The shutter speed is set manually and the camera automatically sets the aperture.</td>
<td>Good for sports shots.</td>
</tr>
<tr>
<td>Aperture priority</td>
<td>The aperture is set manually and the camera automatically sets the shutter speed.</td>
<td>Good to control the depth of field in close-up shots.</td>
</tr>
<tr>
<td>Burst mode</td>
<td>Shoots a “burst” or group of photos rapidly and automatically.</td>
<td>Good when you need to take several shots to assure one is good as in a wedding or sport events.</td>
</tr>
<tr>
<td>Time-lapse mode</td>
<td>Sets the camera to automatically shoot an image at a set interval.</td>
<td>Good for nature photos.</td>
</tr>
<tr>
<td>Video mode</td>
<td>Allows the recording of short limited resolution video clips.</td>
<td></td>
</tr>
<tr>
<td>Manual</td>
<td>Allows you to set all the controls manually.</td>
<td></td>
</tr>
</tbody>
</table>

---

**Figure 1-21:** Exposure compensation can clean up overexposed photos like this

**Figure 1-22:** Aperture priority allows you to shorten depth of field in a close-up shot.
<table>
<thead>
<tr>
<th>Function (Mode)</th>
<th>How to Use It</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Focus</td>
<td>Simple camera lenses that can’t be manually or automatically focused.</td>
<td>Found only in inexpensive and disposable cameras.</td>
</tr>
<tr>
<td>Automatic Focus</td>
<td>The camera adjusts the focus automatically.</td>
<td>Better cameras allow you to turn off this feature to allow manual focus.</td>
</tr>
<tr>
<td>Manual Focus</td>
<td>You manually focus the camera.</td>
<td>Good for busy pictures and patient photographers.</td>
</tr>
<tr>
<td>Focus &amp; Exposure Lock</td>
<td>The camera automatically sets the focus and exposure when you hold down the shutter button while pointing to the subject.</td>
<td></td>
</tr>
<tr>
<td>White Balance</td>
<td>The camera adjusts the image to compensate for differences in light.</td>
<td>Maintains color accuracy in daylight, fluorescent, and incandescent lighting situations.</td>
</tr>
<tr>
<td>Sport</td>
<td>Automatically presets the camera for sports photos.</td>
<td></td>
</tr>
<tr>
<td>Portrait</td>
<td>Automatically presets the camera for portraits.</td>
<td></td>
</tr>
<tr>
<td>Landscape</td>
<td>Automatically presets the camera for landscape shots.</td>
<td></td>
</tr>
</tbody>
</table>

Choosing a camera is always a compromise. Choose the feature set that addresses most of your needs or those you anticipate.
Evaluate Image Transfer Solutions

<table>
<thead>
<tr>
<th>Mode</th>
<th>Rate</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Transfer from memory cards</td>
<td>150Kbsec–2Mbsec</td>
<td>This is easy but the slowest way to transfer large numbers of photos. A full 128MB memory card takes 2–4 minutes to transfer to your hard drive.</td>
</tr>
<tr>
<td>Infrared Connection</td>
<td>4Mbsec</td>
<td>This is a faster connection but most cameras don’t support it. A full 128MB memory card takes 30 seconds to transfer to your hard drive.</td>
</tr>
<tr>
<td>USB cable</td>
<td>12Mbsec</td>
<td>This is the most common connection and as fast as most people need. A full 128MB memory card takes 10 seconds to transfer to your hard drive.</td>
</tr>
<tr>
<td>IEEE 1394 (Firewire)</td>
<td>100–400Mbsec</td>
<td>This is the fastest connection but depends on the network speed.</td>
</tr>
</tbody>
</table>

File transfer speeds in real life are slower because of the nature of opening and transferring individual files by Microsoft Windows.
## Evaluate Supported Camera Technologies

<table>
<thead>
<tr>
<th>Technology</th>
<th>What It Does</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge</td>
<td>Allows a camera to plug directly into a supported printer.</td>
<td>Becoming available in new cameras and printers. It can be handy for portable printers.</td>
</tr>
<tr>
<td>Exif 2.1</td>
<td>The current standard physical file format used in most digital cameras.</td>
<td>Stores additional camera and other information beyond the JPEG image information. The physical file format is read by the software used to view and edit the photos.</td>
</tr>
<tr>
<td>Exif 2.2</td>
<td>The newest physical file format. Not yet widely used.</td>
<td>Includes a file header portion specifically designed to be interpreted by printer drivers and printers, which enables them to synchronize before printing.</td>
</tr>
<tr>
<td>PIM</td>
<td>Print Image Matching. Saves image information that assists printing more accurately.</td>
<td>A proprietary Epson technology that’s not yet widely available outside Epson products. Exif 2.2 is a new industrywide standard addressing the same issues.</td>
</tr>
</tbody>
</table>

PictBridge and PIM are the only two of these technologies that you need to consider in choosing a camera. The others are a function of the state of the art at the time you purchase a camera. Because of the rapid development of new technology, choosing a new camera and a recent model is always best when purchasing digital cameras.

Figure 1-27: PictBridge allows you to print directly to a printer

Figure 1-28: Exif 2.2 and PIM give the printer better information about the photo
# Choose Flash Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>What It Does</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash range</td>
<td>Maximum range in which the flash is effective.</td>
<td>Expressed in feet or meters.</td>
</tr>
<tr>
<td>Auto mode</td>
<td>Turns the flash on when it’s needed.</td>
<td>Good feature.</td>
</tr>
<tr>
<td>Auto mode off</td>
<td>Allows you to override auto flash.</td>
<td>Important feature for better cameras.</td>
</tr>
<tr>
<td>Fill or forced mode</td>
<td>Flash fires even when there is enough light to fill in shadows.</td>
<td>Good for portraits.</td>
</tr>
<tr>
<td>Slow sync mode</td>
<td>Allows the adjustment of relative brightness of foreground subject with the background.</td>
<td>This is an advanced tool.</td>
</tr>
<tr>
<td>Red-eye reduction</td>
<td>Fires an initial flash to close the subjects iris before taking the photo to prevent red eye.</td>
<td>This is great for portraits and group shots.</td>
</tr>
<tr>
<td>Hot shoe connector</td>
<td>Allows the use of external flash.</td>
<td>This allows for maximum flexibility.</td>
</tr>
</tbody>
</table>

The more expensive the camera, the more features you find. Choose the minimum set for your needs and budget.
## Choose Other Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size and weight</td>
<td>A heavier camera is easier to hold steady, but a lighter camera is easier to store and carry. Prosumer cameras split the difference between size and features.</td>
</tr>
<tr>
<td>Panoramic</td>
<td>Some digital cameras can capture a single-image panorama; others feature multiple-image panorama that you can assemble in the computer later.</td>
</tr>
<tr>
<td>Multiple exposures</td>
<td>Takes a preset number of images when you hold the button.</td>
</tr>
<tr>
<td>Tripod mount</td>
<td>Allows you to attach a tripod to the camera.</td>
</tr>
<tr>
<td>Self-timer</td>
<td>Camera automatically shoots after a set period of time.</td>
</tr>
<tr>
<td>Remote control</td>
<td>Camera may be set and operated from a distance.</td>
</tr>
<tr>
<td>Date/time indicators</td>
<td>Stamps the header of images with the time and date the photo was shot. This information doesn’t show up on the image but the camera or software displays it while being viewed.</td>
</tr>
<tr>
<td>Sound recording</td>
<td>Enables the recording of audio notes or comments with the camera’s built-in microphone.</td>
</tr>
</tbody>
</table>

(continued)

---

**Figure 1-31:** A prosumer camera splits the difference between size, cost, and performance

**Figure 1-32:** A tripod mount is necessary to use a tripod
<table>
<thead>
<tr>
<th>Feature</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>Most digital cameras are bundled with editing and other software. The software supplied might be a factor when choosing a camera.</td>
</tr>
<tr>
<td>LCD viewfinder</td>
<td>Better cameras include these. Choose the largest available. These use battery power.</td>
</tr>
<tr>
<td>Eyepiece viewfinders</td>
<td>Most cameras have these even if they have LCD viewfinders. These work best in bright light. They also increase battery life.</td>
</tr>
<tr>
<td>Through the lens viewing</td>
<td>Single lens reflex professional cameras allow viewing directly through the camera lens. This is the most accurate view.</td>
</tr>
</tbody>
</table>

No ultimate camera exists for everyone. In the end, you must choose the camera that you like best and that does what you want it to do.

Figure 1-33: An LCD viewfinder allows you to see exactly what the picture will look like.

Figure 1-34: How you view the object through the lens of an SLR camera.
## Choose Other Accessories

<table>
<thead>
<tr>
<th>Accessory</th>
<th>What It’s Used For</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera bag</td>
<td>To carry and protect camera.</td>
<td>Don’t get one too large or small; waterproof is good.</td>
</tr>
<tr>
<td>Lens cloth</td>
<td>Clean the lens without scratches.</td>
<td></td>
</tr>
<tr>
<td>LCD shield</td>
<td>Shield the LCD viewfinder from bright sunlight.</td>
<td>Not available for all cameras.</td>
</tr>
<tr>
<td>Battery charger</td>
<td>Charge rechargeable batteries.</td>
<td>Comes with cameras that use rechargeable batteries. If your camera uses AA or similar batteries you may need to supply your own recharger.</td>
</tr>
<tr>
<td>Card reader</td>
<td>Attaches to a computer via USB port and copies images from memory cards onto a computer.</td>
<td>Most work with multiple card formats. Make sure you choose one that includes the card or cards you use. Many new computers come with these built in.</td>
</tr>
<tr>
<td>Straps</td>
<td>Prevents dropping your camera.</td>
<td>Usually supplied with cameras. You might purchase heavier duty straps or more comfortable ones.</td>
</tr>
</tbody>
</table>

Many of us enjoy the study, acquisition, and occasional use of photo stuff. You don’t need to get carried away with unnecessary accessories to become a good digital photographer. You can always use an old briefcase as a camera case!
Chapter 1: Selecting a Camera and Accessories
Before you can use a camera, you need to set its features to meet your particular needs. The good news is that digital cameras are pretty easy to set up, and they make taking good pictures easy, too. All you need to know is what your cameras features are for and how to use them.

Camera manufacturers tend to build their products to be a little different from their competitors’ products. Fortunately for us, most cameras have some common traits and functions that let them work the same way. In this chapter, I show you how to apply these commonalities to get the best out of your own camera.

Inexpensive consumer cameras, while they take great photos, don’t have all the features that more expensive cameras do. In particular, they allow fewer manual settings, such as shutter speed and aperture settings. This is good and bad news. If you’re not a camera expert (and don’t care to become one), then you can count on the camera to automatically focus and set the internal computer to take really good photos. The bad news is that if you want to become a photo expert, you may be frustrated with the lack of control.

After you set up your camera, finally you get to take photos! This chapter guides you through the process of choosing the proper camera mode to use for taking particular types of photos. Experiment with each of the settings, and because digital film is reusable, see what the settings do to actual images. Bon voyage on a new journey of photo excitement and creativity!
**Set Up Your Camera**

1. Install batteries in the camera according to the camera’s instruction manual. Figure 2-1 shows a typical lithium ion battery and a AA battery.

   The decision as to the kind of battery that your camera takes is an important one. Rechargeable AA batteries don’t hold a charge as long as lithium ion batteries, particularly in flash photography, but the ability to buy AA batteries almost anywhere can be important on vacations if your battery runs out.

2. Install memory in the camera according to the camera’s instruction manual. See Figure 2-2 for an example of installing memory and a lithium ion battery in a typical camera. Figure 2-3 shows the battery and memory card installed.

3. Using the camera’s menu, set the time and date of your camera.

4. Set compression settings to meet your needs. Most cameras have three or more settings:
   - **Best**: Uses the least possible compression for the best possible image quality. Requires more memory to store each image.
   - **Standard**: Splits the difference between image size and quality.
   - **Economy**: Highest amount of compression results in more noise in the image but allows for storage of more pictures.

5. Set resolution settings to meet your immediate needs.
• 5 megapixels: Images are 5MB in size, and a 128MB memory card stores 56 images.
• 3 megapixels: Images are 2MB, and a 128MB memory card stores 93 images.
• 1.2 megapixels: Images are less than 1MB, and a 128MB memory card stores 174 images.
• 800×600: Images are 250 KB, and a 128MB memory card stores 602 images.

Most camera manuals provide a detailed memory usage chart for every configuration of compression and resolution. Refer to the chart in planning what storage capacity memory cards to buy, and for planning the number of memory cards to take with you. Check out Chapter 1 to help make your decision.

6. Take your first photos with your new camera.

Point and Shoot in Auto Mode

1. Set the Mode dial (or buttons) on your camera to the Auto mode, as shown in Figure 2-4.

   In Auto mode, the camera automatically focuses, adjusts the speed and aperture, and turns the flash on or off depending on the light conditions. This mode is the true “point and shoot” setting. Using preset modes can save time and be a salvation for the beginning photographer.

2. Compose your shot in the viewfinder or by looking at the LED screen.

3. Press the shutter button down halfway to allow the camera to adjust. The camera provides an audible signal that it has adjusted to take your picture.

4. Press the button down fully to take your photo.
Zoom In on an Object

1. Activate the zoom button or lever on your camera to zoom in or out to change your optical zoom level. The quality of the photo is identical whether the lens is zoomed or not when you use optical zoom. Figures 2-5 and 2-6 show a shot before and after using optical zoom.

2. If you want to zoom further using digital zoom, turn the digital zoom feature on in your camera’s setup menu.

   ![Figure 2-5: A shot with lens zoomed out](image1)
   ![Figure 2-6: The same shot with lens zoomed in](image2)

   Most cameras that support both optical and digital zoom first zoom as far as they can optically, as indicated by a message in the viewfinder or on the LED screen. When the extent of the zoom has reached optically, the message indicates the digital zoom is taking effect and continues to zoom beyond the optical limits.

Adjust Brightness in Program Mode

1. Set the mode dial (or buttons) on your camera to the Program mode.

   ![Figure 2-5](image1)

   ![Figure 2-6](image2)

   In Program mode, your camera adjusts both the shutter speed and aperture based on the brightness of the key object in the viewfinder. The white balance, light meter, and exposure compensation is generally adjustable. See your user manual for instructions on adjusting these settings for your particular camera.

2. Compose your shot in the viewfinder or by looking at the LED screen.

3. Press the shutter button down halfway to allow the camera to adjust. The camera provides an audible or visible signal that it’s ready to take your picture.

4. Press the button down fully to take your photo.
Snap a Portrait Using Automatic Settings

1. Set the mode dial or buttons on your camera to the Portrait mode.
   In Portrait mode, your camera automatically adjusts the shutter speed and aperture setting to make people stand out and to keep the background in focus. In addition, cameras equipped with a red-eye reducing flash employ that setting in Portrait mode.

2. Compose your shot in the viewfinder or using the LED screen.

3. Press the shutter button down halfway to allow the camera to adjust.

4. Press the button down fully to take your photo. Figure 2-7 shows a portrait taken in this fashion.

Stop Action Using Automatic Settings

1. Set the mode dial or buttons on your camera to the Sport mode.
   In Sport mode, your camera automatically adjusts the shutter speed and Aperture setting to work best with fast-moving subjects and the prevailing light conditions.

2. Compose your shot in the viewfinder or using the LED screen.

3. Press the shutter button down halfway to allow the camera to adjust.

4. Press the button down fully to take your photo. Figure 2-8 shows a stop-action photo.
Lengthen Depth of Field

1. Set the mode dial or buttons on your camera to the Aperture Priority mode.
2. Set the aperture of the camera according to the manufacturer’s manual. 
   
   ![A larger aperture or smaller f-stop setting reduces the depth of field; a larger f-stop increases it, as shown in Figure 2-9.]

3. Compose your shot.
4. Press the shutter button down halfway to allow the camera to adjust.
5. Press the button down fully to take your photo.

Use Shutter Priority Mode

1. Set the mode dial or buttons on your camera to the Shutter Speed Priority mode.
2. Set the shutter speed of the camera according to the manufacturer’s manual.
   
   ![Use shorter shutter speeds when you’re holding the camera. Doing so helps to eliminate blurriness due to jiggling the camera. On the other hand, if you’re using a tripod, you can afford to use longer shutter speeds.]

3. Compose your shot.
4. Press the shutter button down halfway to allow the camera to adjust.
5. Press the button down fully to take your photo.

Figure 2-9: Lengthening depth of field keeps the background in focus

Two camera functions adjust for depth of field. One is the aperture setting, which controls the actual size of the small opening behind the lens that directs light to the image chip that captures the image. The other is shutter speed, which determines how long the shutter stays open. In Aperture Priority mode, you can increase depth of field (bringing distant objects into focus) by selecting a larger aperture setting or decrease it (blurring distant objects to focus attention only on your subject) by selecting a smaller aperture setting. The camera then automatically chooses the correct shutter speed based on the aperture you choose and the prevailing light conditions.

Shutter speed and aperture size combine to freeze movement in action shots without blurring the picture. The shutter speed is the more important of the two, because the faster the shutter opens and closes, the shorter the moment in time that you capture.
Reduce Battery Usage

1. To set your camera in battery saving mode, access the camera setup menu. Most cameras have settings for the following options:
   - **LED on and off**: Shuts the LED display off. You can shoot in this mode using the viewfinder and save power.
   - **LED brightness**: If you turn the brightness down, it conserves energy.
   - **Flash on and off**: The flash takes a lot of power. Turn it off if you’re shooting outdoors.
   - **Auto power shut-off**: Automatically turns the camera power off after an interval to save power.

2. Choose the settings for your situation and save them to memory.

   ![Figure 2-10: Shooting a horizontal picture on a tripod](image)

   ![Figure 2-11: Shooting a vertical picture on a tripod](image)

   Turn off your camera’s power whenever you’re not using it. Also remember to carry spare, recharged batteries with you.

Use a Tripod

1. Most tripods include a quick connect plate. Attach the camera to the quick connect plate.

2. Adjust the legs of the tripod to the height you wish to use.

3. Adjust the head and camera angle until you achieve the view you want and snap your photos, as shown in Figures 2-10 and 2-11.
Use a Flash Attachment

1. Select the appropriate flash for your needs. Virtually all digital cameras, except the most professional, come with a built-in flash. Midrange and professional cameras usually allow the addition of external flashes, as illustrated in Figure 2-12.

Built-in flashes are easy to use and convenient. The down side is their limited range and fixed position. Pointing an external flash slightly away from the subject can eliminate red eye, washed-out shadows, and flattened textures. Use these larger flashes when the shot requires more light or more control of the light. Reposition flashes when you need to; if it’s connected with cables, hold the flash by hand for more flexibility.

2. Attach the flash to your camera. Several attachment options on those digital cameras are capable of using external flashes. They are

- **Hot shoe**: The top of most better cameras comes with an accessory shoe, illustrated in Figure 2-13, that has a power and control connection when the flash is snapped into the shoe. Cameras with “cold” or unpowered accessory shoes require the use of a cable from the flash to the camera.

- **Sync Connector**: Most cameras with external flash capability can accept a flash mounted on a special bracket that fastens to the tripod socket on the bottom of the camera. Connect these flashes to power and the camera controls with a supplied cable.

3. Adjust the camera setting to recognize and adjust for the use of external flash attachments.

4. Take photos as you normally do.
Use Attachment Lenses

1. Select attachment lenses to meet your needs.

   The normal zoom lenses that come with digital cameras have limitations. Inexpensive consumer cameras leave you nothing to do about this but to upgrade to a better camera. More expensive cameras allow you to use lens extenders or to exchange lenses to expand the limits, as shown in Figure 2-14.

   The types of attachment lenses are

   - **Wide angle lenses**: These attachments change the “normal” focal length lenses into wide angle lenses. These are not true wide angle lenses, but expand the width perspective of digital cameras.

     When using a wide angle extender, make sure that you set the normal zoom to the widest setting to maximize the effect.

   - **Telephoto lenses**: These change “normal” lenses into telephoto lenses. They function as telephoto lens adapters. They narrow the frame of the lens and bring distant objects closer.

     When you use telephoto adapters, set the normal zoom lens to the longest setting to maximize the telephoto effect.

   - **Close-up lenses**: These enable macro or super-close-up shots. They screw on the front of cameras with lens extension features. In many cases multiple adapters can be ganged to adjust the macro capacity of the camera.

     When using a telephoto lens with a plastic adapter, set the normal zoom to the longest setting to maximize the telephoto effect.

2. Attach the lens extender to the normal lens, as shown in Figure 2-15, and shoot photos normally.
Snapping Digital Pictures

Digital cameras have some distinct advantages over traditional film cameras. They're easy to use, most of their functions are automatic, and you can instantly review the images. Most spectacular, however, is the mere fact that they're digital — they store their images on solid-state memory cards. Therefore, you don't have to buy, load, or unload film (risking exposure and ruination), and you can take many pictures before you have to change memory cards. Having the ability to instantly review images on your digital camera helps you learn from your mistakes. You can delete unsuccessful images, making room for new and better ones. Thus, you can afford to take shots from different angles and use a variety of settings in order to ensure that at least one of your shots is splendid.

Photographs range from snapshots recording an event or scene (possibly of little or no interest to anyone except you) to great shots with visual and emotional punch. Portraits can be the kind the subject wants burned or buried in the bottom of a box, or they can capture personality and reveal character. The rules for taking good photographs are the same for digital camera pictures as they are for pictures taken with film cameras. Good, effective lighting, careful composition, and attention to detail are all elements in taking pictures that are not just good, but great. This chapter shows you how to compose winning photos and use your camera effectively.
Compose Your Photograph

1. Decide on your main point of interest and try to frame your picture to eliminate elements that may distract from your subject (unless the picture is of a general landscape or crowd scene where everything is part of the subject, as shown in Figure 3-1).

   Signs, extra people, trash, or bright colors are especially distracting elements that you should try to eliminate. In essence, your photo is a mini-story — make sure the story you’re telling comes through to the viewer. Edit as you shoot!

2. Hold the camera to take best advantage of the subject:
   - **Horizontal subject**: If you’re shooting a horizontal subject such as a landscape, group of people, and so on, hold the camera horizontally.
   - **Vertical subject**: If you’re shooting a tall tree or building, the picture is much more dramatic if you turn the camera so that it’s vertical.

3. Adjust the picture’s composition by shifting the camera from side to side or up or down. Don’t hesitate to stand on something to get a higher shot or squat down to get a lower one. Just don’t do anything dangerous!

   Change your position and viewpoint so that your picture follows the rule of thirds. Imagine a tick-tack-toe grid superimposed over your picture frame. Make sure that your main point of interest is not in the center square, but rather is placed at one of the intersections of the grid as shown in Figure 3-2.

---

**Figure 3-1**: A crowd scene has no particular focus of interest

**Figure 3-2**: If you point to the center of this image, you find that everything of interest is off-center
Look through the camera’s viewfinder or look at the LCD screen to compose your photograph. Keep the following general composition rules in mind:

- **Aim for the eyes.** When you’re taking pictures of people, shooting at the subject’s eye level is usually best, even if you must stoop down or climb up to do so.

- **Avoid bull’s-eyes.** Pictures are much more interesting and dramatic if the main point of interest is off-center, as shown in Figure 3-3.

- **Avoid the center horizon line.** In landscapes, angle the camera so the horizon line is not in the center of the picture. A horizon above center makes the scene appear close. A horizon below center emphasizes the sky or the distance.

- **Use leading lines to create movement and establish mood.** See Figure 3-4. Fences, roads, lines of trees, railroad tracks, and even lines of people can lead the viewer’s eye toward the point of interest.

- **Establish scale in a photograph, such as a landscape, by including a person or object in the foreground.** Frame a scene by including a visible doorway or gate, or show overhanging branches at the edge of the scene to create depth and drama.

- **Get in close.** The most common mistake of beginning photographers is failing to get close to the subject.

- **Fill the frame.** Make sure that the most important object or person, the one that you are taking the picture of, is the most prominent in the frame.
Frame a Stationary Subject

1. Frame a stationary shot by pointing your camera at a subject and looking through the viewfinder. (You can also use the LCD viewer.)

2. Locate the marks around the edge of the frame in the viewfinder, indicating exactly what part of the image is in the picture (what the camera lens sees differs a little from what the viewfinder sees). If you see a second set of frame lines, they are for closeup photos.

   The problem of the wandering image is called parallax, and it’s most noticeable when you take a close-up. The viewfinder of most digital cameras is placed above or on the side of the lens. The image in the viewfinder does not always accurately reflect the actual image you’re capturing. The inner frame marks compensate for closeup photography. Try some test shots and adjust the viewfinder to compensate for the slight shift. Doing so assures that the picture you take is the one you want. The LCD screen reflects the actual image being captured.

3. Shift the camera position until the subject appears within the framing marks.

4. Pause and make sure that the image is in focus and that the lighting is appropriate.

5. Snap the picture and review it to make sure the subject is completely in the picture.

   If the image is badly positioned, as shown in Figure 3-5, delete the picture from memory. Then shift the subject’s position in the viewfinder by moving the camera or by moving your own position and try again until you get a well-placed image, as shown in Figure 3-6.
Focus the Camera

1. Most digital cameras have autofocusing. And a few are fixed focus models, which can’t be adjusted but are pre-focused for subjects at distances from about five feet to infinity. Other cameras have manual focus settings, which usually are for infinity, mid-distance, and closeup. The mid-distance setting is safe for most picture taking.

   In lieu of a mid-distance setting, your camera may offer a Landscape setting.

2. Choose the subject of the photo. The mid-distance setting is effective for shots such as a street sculpture, a house, or a field with horses.

   If your camera has a manual focus feature, then you can use it to manually set the focus. Select the Manual Focus feature according to your camera’s instruction manual.

3. Take your picture and review it for focus. If the main part of the image is fuzzy, as shown in Figure 3-7, the subject is either too far or too near for the mid-distance setting.

4. To adjust the focus, change your position relative to the subject as necessary until what you want to take a picture of is in focus, as seen in Figure 3-8.

   Most manual focus camera lenses focus either by rotating a focus ring on the lens or moving the lens tube in or out. Use the proper method to focus the camera. For another way to outwit autofocus, see the next task.

5. Take your shot.
Move the Subject Out of the Center with Focus Lock

1. Select the Autofocus feature according to your camera’s instruction manual. Use this setting for close-ups and for near subjects, as shown in Figures 3-9 and 3-10, respectively.

   Autofocus cameras choose the dominant object or person in the center of the screen. People at the edge of the photo may not be in focus. You can overcome this deficiency using focus lock. This feature allows you to point the camera at a subject outside of the picture center to focus the lens and then hold or lock that focus when you reframe the camera to include more dominant subjects in the picture center.

2. Frame your subject in the viewfinder and note the autofocus target in the center of the viewfinder (usually an X or a cross).

3. Depress the shutter release button halfway and wait until the camera adjusts its focus on the subject. When the image is focused, the camera either beeps or a light appears.

4. Keep the shutter button halfway depressed and reframe your picture with the subject anywhere in the frame.

5. When the picture is properly framed, depress the shutter button fully to snap the photo and review your picture.
Shoot in Poor Illumination

1. When you’re outdoors, wait to take pictures until the lighting conditions improve (if you can). Or, use the camera’s built-in flash outdoors to illuminate subjects as close as 10 to 15 feet. Whether you’re shooting indoors or outdoors, try to shoot in good lighting conditions. If you can’t wait for better lighting conditions, these steps provide tips to improve a poor lighting situation.

2. When indoors, you can employ other available lighting, such as table lamps or pole lights, to brighten the scene. If possible, reposition the light sources to improve the picture and adjust the white light balance.

3. Improve indoor or outdoor shots through the use of a flash (either the camera’s flash or an external flash) to light near- and mid-distance objects. Using a flash is ineffective for landscape photos or for large objects in the distance. Something has to be close by to reflect the light for a flash to be effective.

4. In poor lighting conditions, mount the camera on a tripod (or steady flat surface) and let the autoexposure program determine the exposure. Some cameras have slow shutter speeds — up to as long as 30 seconds — causing moving objects to be blurred. Using a tripod is a good approach for outdoor night photography.

5. If using the flash does not lighten the photo enough and if your camera allows it, you can increase the exposure setting on your camera by one or two f-stop equivalents. Even if the picture is dark, you can often adjust the brightness of the photo later using your editing software, as shown in Figures 3-11 and 3-12. Don’t depend on this work around if you can avoid it. The camera records a great deal of information, but it does have limits: You can’t bring out images that aren’t recorded.

Figure 3-11: This photo is too dark

Figure 3-12: Image-editing software lightens the picture
Shoot a Portrait Indoors

1. Set your camera to Portrait mode.

2. Choose a subject — a person or object.

3. Place your subject to eliminate the kind of background clutter shown in Figure 3-13. You can also change your own position so the clutter is not visible.

   Any photo with a subject is improved if the background is uniform and contrasting rather than busy and confusing.

4. Reposition yourself so that no small area of bright light, such as a reflection from a window or from a shiny surface like the subject’s eyeglasses (called a hot spot), is visible in the frame.

   If you can’t move to eliminate the hot spot, use something to block the glare — a shade or curtain, for example.

5. Take the picture and review it for adequate lighting. If the picture’s too dark, turn the flash feature on and take the picture again using the flash to fill in detail. Because electronic flash and daylight are the same color light, they can be used together for natural-looking illumination.

   When using a flash to fill in details, be careful not to photograph a subject who wears glasses directly from the front. Photographing from an angle, as shown in Figure 3-14, avoids creating a hot spot with the flash.
Shoot a Portrait Outdoors

1. Set your camera to Portrait mode.

   A common problem when shooting people outdoors is lighting. When the sun or a bright background, such as a light colored building is behind a subject, the automatic aperture frequently adjusts to the background rather than the face, as shown in Figure 3-15.

2. If possible, position your subjects so that the available sunlight falls on their faces. Doing so helps to assure that the face stands out in the picture. However, if the sun is directly overhead it may produce unattractive dark eye sockets.

   Try using side light from the sun or other strong source. This can result in dramatic shadows or a soft halo effect. Avoid midday lighting if possible. Strong sunlight is a time to try side or backlighting.

3. If the light is strong behind your subject, use the flash to brighten your subject’s face, as shown in Figure 3-16. The flash helps to avoid the common problem of a dark foreground in backlit pictures.

   Using the flash is particularly good for head-and-shoulders portraits, since the flash fill in the face plus the sunlight produces an attractive halo around the subject’s hair. If your camera has a center spot light meter mode, use it for flash-fill portraits.

   Your flash may be automatic, but in Automatic mode, it flashes only when the camera calculates that you need more light. When using a flash outdoors or in a brightly lit room, you likely need to turn it on manually rather than depending on the Automatic Flash function.

4. Make sure your subjects don’t squint at the sun.

5. Take the picture!
Snap a Landscape Picture

1. Set your camera to Landscape mode.

2. Shoot landscape pictures early morning or late in the afternoon as the lighting is best at these times for attractive landscape pictures.

   Keeping the sun behind you at about a 45-degree angle is usually best. This results in good shadows and modeling of faces. On the other hand, you can shoot great dramatic photos with the sun in the photo. Find ways to screen or block the direct image of the sun with foliage, people, buildings, and so on. This results in a dramatic halo effect.

3. Hold the camera horizontally, in general.

   Normally, landscapes call for a horizontal picture, but you may want to hold the camera vertically if your subject is a tall tree or something similar, as shown in Figure 3-17.

4. Choose a main point of interest in the scene, such as a cow in a field or a red barn.

5. If leading lines are available — fences, lines of trees, or roads that lead toward the point of interest — place yourself so these lines direct the eye toward the subject.

6. Following the rule of thirds, move the camera until the point of interest falls along one of the imaginary lines, being careful it does not occupy the center square of your grid.

7. Lift or lower the camera until the horizon line is either above or below the center of the frame, as shown in Figure 3-18.

8. Take the picture! Review it to make sure your composition follows all the main compositional rules and is pleasing to the eye.
Photograph Pets and Animals

1. Get as close as possible to the animal.

   Use a zoom or telephoto lens for photographing wild animals. Extremely small animals, such as birds, require the use of a strong telephoto lens (such as a 200mm or greater focal length) to fill the frame from 20 feet away. Bird photographers can expect to spend more money on equipment because of the need for an interchangeable zoom lens and a camera body and tripod that can support it.

2. Snap photos that show something characteristic of the animal. A kitten playing with yarn or ribbon, as shown in Figure 3-19, or a cat stalking a bug shows off the pet and speaks volumes about its personality.

3. Aim for an appropriate background. A shot of a cat stalking a bug is much more effective in the backyard than in the kitchen.

4. Frame the pet as the dominant subject of the composition, as shown in Figure 3-20.

   Outdoor animal photography is a combination of planning, luck, and patience. Choose locations where you have a high probability of seeing the animal you want to photograph. Take the proper gear (such as a tripod and flash). Then wait patiently for that lucky shot to happen.

   The photo is more interesting if it’s natural rather than artificial. Animals in a zoo cage can be compelling, but shots in zoo areas that replicate a natural environment tell more about the animal. Pets, on the other hand, photograph well in a domestic setting. A kitten playing under the edge of bedclothes or a dog sleeping at the master’s feet make great images.
Shoot Scenic Nature

1. Decide whether your composition works better as a landscape, subject photo, or close-up and follow the composition rules for that particular type of photo.

   Flower photos are the most popular outdoor close-ups. If you’re shooting flowers, choose the best and most interesting blossoms. Beautiful flowers make beautiful photos.

2. Pay attention to the background of your primary subject. Avoid excessive leaves, your feet, or other distracting elements, as shown in Figure 3-21.

   If you’re allowed, using a pair of clippers judiciously can improve a composition.

3. Use diffuse lighting to the greatest possible extent.

   If the daylight alone is not adequate, or if you have unwanted shadows, have a friend focus a reflector of white cardboard or foam core on the subject, as shown in Figure 3-22. If you need sharper light to accent shadows, cover the cardboard with aluminum foil for a budget reflector. Also available are small, wireless slave flash units that will fire at the same moment the camera’s built-in unit flashes. Professionals use these too!

4. Ensure that the background is uniform and doesn’t distract from the subject.

   If you need a background to accent or isolate a particular object or blossom, have someone hold a neutral color poster board behind the subject while you frame the shot.

Figure 3-21: The background of this photo is simplified to set off the subject

Figure 3-22: Using a homemade reflector to provide diffuse lighting
5. Pay attention to depth of field (that is, the size of the area that appears with acceptable sharpness in your framed subject).

You can increase the depth of field on automatic cameras by increasing the light on the subject. The automatic camera decreases the aperture opening accordingly.

6. Frame the subject.

When framing a shot, consider shooting from below. A flower against the sky can be a dramatic image.

7. Check the focus. If you’re using autofocus, prefocus the shot by holding the shutter release button halfway down for a second to allow autofocus to work, and then take advantage of focus lock to reframe the subject. Use manual focus if possible.

When shooting a group of flowers or objects, focus on one or two key subjects and let some be out of focus to form a background or texture for the composition.

8. Shoot close-ups of petals or leaves and create an abstract image, as shown in Figure 3-23.

Shoot a series of ultra-close-ups and create a set of framed abstract images for your home. Choose deep and lush mattes to surround the images. Try enhancing the images with Photoshop effects to accent the textures or shapes, as shown in Figure 3-24.

9. Bracket your shot by choosing the -2, 0, and +2 exposure value (EV) settings, if your camera is so equipped.

The world is composed of an infinite number of images. Go find and tame them — or at least, record them with your digital camera. It will open your eyes, mind, and heart!
Viewing and Transferring Images

One of the neat things about digital cameras is that after you buy a memory card, you can use it over and over again. It's like a magic roll of film that's ready to pop back in your camera right after you develop it.

Of course, in order to reuse the memory card, you first need to do something with the last group of images you stored on it. You can delete unwanted images, and you can transfer images that you want to keep to a more permanent location, such as your hard drive, a CD-R, or DVD. Instead of hooking up your camera to a computer every time you want to transfer images to your hard drive, you can also purchase and use a memory card reader. Just leave the card reader attached to a USB port or USB hub, remove the memory card from the camera, and insert it into the card reader slot when you're ready to transfer your photos.

Every camera is a bit different in exactly what hoops you need to jump through to move or delete your images, but I can give you the general gist of what you have to do — enough so that you can fake it if you don't have access to your owner's manual. On the other hand, the camera owner's manual provides the exact steps to take for your particular camera, so keep it in a drawer somewhere.

This chapter gives you the instructions you need to

- Review your pictures and delete unwanted snapshots from your camera
- Connect to and transfer pictures to your Windows computer
- Use Windows to organize and display your photos
Review and Delete Pictures in Your Camera

1. To delete unwanted images and make room for new ones, choose Preview mode on your camera. Exactly how you get your camera into Preview mode differs from camera to camera, but usually you access Preview mode from the main selector or from your camera’s menu. Consult your owner’s manual for detailed instructions.

2. Scroll through the images in the camera’s memory card using the right and left arrow buttons, like those shown in Figure 4-1. Evaluate the pictures as you go.

3. Use your camera’s delete function (usually available through the camera’s menu or via a dedicated button) to delete the image you’re currently viewing on the LCD screen. Most cameras allow the following deletion capabilities:
   • **Delete This Picture**: Deletes only the picture currently showing on the LCD screen.
   • **Delete All Pictures**: Deletes all the pictures from the memory card.

If your camera is connected to your computer or your memory card is inserted into the slot on a card reader (which is hooked up to the USB port on your computer), you can view and delete images from your memory card using the Windows Camera Wizard, or by opening the directory on the memory card using Windows file management tools.

Figure 4-1: A digital camera’s LCD window

Some secure memory cards have small switches on the edge that prevent you from accidentally deleting photos. Most of these switches are marked “Lock.” After you fill each memory card with pictures that you want to save, be sure to protect those pictures by locking the memory card. The switch is reversible, so you can clear the switch after you successfully download the images to your computer. In addition, the menus in many cameras allow you to individually protect certain pictures from deletion.
Connect Your Camera or Card Reader to a Computer

1. Connect the USB cable supplied with your camera or card reader to one of your computer’s USB ports.

   - If you receive a message stating that the port does not have enough power to sustain the camera connection, then you must connect the cable directly to the computer’s USB port rather than via a USB hub or USB port extension cord (which is shown in Figure 4-2). USB 2 is faster than USB 1.1.

   - If your computer does not have a USB port, then you can obtain a serial cable to use with your computer’s serial port.

2. Connect the USB cable to your camera, as shown in Figure 4-3, or to your card reader.

   - Each manufacturer has its own idea of the type of cables and connector formats to use. These cables may not be interchangeable among different products. Be sure to use the specified cable and refer to your equipment manuals for more detailed information.

3. If the Windows drivers for your camera or card reader are not installed on your computer, you must install them before your computer can recognize these devices.

   - You must switch some cameras to Connect mode or an equivalent mode before Windows recognizes the camera.
Install Camera or Card Reader Drivers

1. To install the drivers that enable your camera to work with Windows, choose Start ➤ Control Panel ➤ Printers and Other Hardware ➤ Scanners and Cameras ➤ Add an Imaging Device. The Scanner and Camera Installation Wizard opens with the Welcome screen.

For Windows XP to recognize your camera or card reader and allow you to access the photos on the memory card, you have to install the drivers that Windows needs to control the hookup. Windows generally recognizes and installs USB drivers for your digital camera or card reader automatically when you run the Scanner and Camera Installation Wizard.

2. Connect your camera or card reader to your computer (placing your camera in Connect mode if necessary) and then select the Automatic Port Detection option from the Available Ports list, as shown in Figure 4-4.

3. Click Next to open the Camera Selection window.

4. Search the Camera Manufacturer and Model lists and select your model; then click Next.

If your camera or card reader isn’t listed, then you need to install the driver from the disk supplied with your device. Place the disk in the appropriate drive and click the Have Disk button. The wizard walks you through the process.

5. Plug your digital camera’s or card reader’s USB cable into a USB-2 port on your computer and, if connecting to a camera, turn your camera’s power switch on. Click Next.

6. Type a name for your camera or device, as shown in Figure 4-5. Click Next.

7. To complete the Windows installation process, click Finished.
Transfer Digital Images to a Computer

1. To move the photos from your camera or card reader to the computer, plug your device's USB cable into a USB-2 port.
2. Turn your camera's power switch on (and place the camera in Connect mode, if necessary). Most card readers power up automatically.
3. Choose Start ➪ My Computer.
4. Choose the drive that represents the digital camera's memory card storage, as shown in Figure 4-6.

Some memory cards show up with a device name; others show up, as in Figure 4-6, as a numbered external drive. You may need to check your indicated external drives by clicking the drive icon that contains the DCIM (Digital Camera Internal Memory) folder.

5. Double-click the DCIM folder and then double-click the appropriate folder containing your photos. The photos in this folder appear just as if they were in a directory on your hard drive, as shown in Figure 4-7.
6. Select the image you want to transfer to your computer.

You can select multiple images by holding down the Control key and selecting more than one image to copy. To select all images, press Ctrl+A.

7. Choose Edit ➪ Copy to copy the image to the Clipboard.

You can use the Move to Folder command to copy the images to your computer and delete them from the memory card at the same time.

8. Navigate to the folder you wish to transfer the file to and paste the image into the folder.

Figure 4-6: Your memory card drive may appear exactly like your other hard drives (though it's usually last drive assigned)

Figure 4-7: Memory card picture folder
Delete Camera Images from Windows

1. To delete unwanted photos from your camera or card reader by using the Windows interface, plug your digital camera’s or card reader’s USB cable into a USB-2 port on your computer.

2. Turn your camera’s power switch on (and place the camera in Connect mode, if necessary).

3. Choose Start ➪ My Computer to open the My Computer window.

4. Double-click the drive identified as the digital camera or card reader.

5. Open the DCIM folder and then open the appropriate folder containing your images. The photos on the memory card display just as if they were on a directory on your hard drive.

   Different cameras name the folder containing their images differently. In Figure 4-8, my camera displays the folder as 100_PANA.

6. Select the image you wish to delete from your memory card folder, as shown in Figure 4-8.

   You can select multiple images by holding down the Ctrl key and selecting more than one image to delete.

7. Choose File ➪ Delete to delete the image or images, as shown in Figure 4-9.

   In Windows XP, you can also delete a file or files by clicking the Delete This File task within the File and Folder Tasks pane. The task is clearly marked with a bright red X. For all versions of Windows, you can delete pictures by highlighting them and pressing the Delete key on the keyboard.
Rename Photos

1. Renaming images is a frequent requirement as you work with an increasing collection of photos. In order to rename an image, select a photo in your photo folder, as shown in Figure 4-10.

2. Select the Rename This File task from the File and Folder Tasks pane, as shown in Figure 4-11. The filename under the image icon turns into a type-in box.

3. Type the new name for the file in the type-in box.

4. Click outside the type-in box (or press the Enter key) to lock in your change.

   If you make a mistake while typing the new name, you can press the Escape key to return to the original name. This works only while the type-in box is active.

Windows XP also contains a simple (though limited) batch-renaming function, which automatically adds a serial number to the end of a group of files. To use it, choose File➪My Documents and navigate to the folder containing the photos. Select all the photos that you want to rename by Ctrl+clicking each file. Choose File➪Rename. Type in your convention (such as 20031125_thanksgiving) and press the Enter key. The files are renamed 20031125_thanksgiving (1), 20031125_thanksgiving (2), 20031125_thanksgiving (3), and so on.

To exert even more control over managing your pictures, see Chapter 12, which tells you how to use Adobe Photoshop Album to name, organize, and search for your pictures.
View and Manage Photos

1. Open any folder on your computer that contains photos. You can have a folder on your hard drive or on a memory card plugged into the computer.

2. Choose View from the menu bar, as shown in Figure 4-12. A number of viewing options are available in the menu that appears. The options that specifically apply to displaying photos are:
   - **Filmstrip:** This option, as shown in Figure 4-13, presents the photos in the directory as a filmstrip at the bottom of the screen with the selected photo in a window above. You can click through the slideshow using the forward and reverse buttons. You can also rotate the image using the left and right rotate button.
   - ** Thumbnails:** This option, as shown in Figure 4-14, presents the images as thumbnail representations of the photos. You can easily select images to open or move from thumbnails instead of relying exclusively on filenames.

3. Manage your photos using the Picture Tasks pane. This menu, located on the left side of the folder, contains a number of file management tools. Whenever photos are contained in the folder you are viewing, the Picture Tasks pane displays (refer to Figure 4-13). The tool options are:
   - **Get Pictures from Camera or Scanner:** The Camera and Scanner Wizard opens, which assists you in scanning images or transferring images from your camera.
• **View as a Slide Show**: Creates a full-screen slideshow, as shown in Figure 4-15, from the images present in the open directory.

• **Order Prints Online**: This wizard guides you through the process of ordering prints from an online printing service that advertises with Microsoft.

• **Print Pictures**: This wizard guides you through the process of printing pictures on your printer.

• **Copy All Items to CD**: This wizard assists you in the process of burning a CD-ROM containing the pictures in the open directory.

From an open directory containing photos, you can rename the photos, create new directories to store photos, move photos into other directories, move to other folders on your computer, and perform any other Windows file management function.

Find a naming convention that works for you and then use it consistently. If you don’t already favor a particular convention, try this one: Enter six digits for year and month (if you’re a real shutterbug, then add two more digits for the day) and then a keyword or keywords. Separate the date and words with underscores, for example, 200311_thanksgiving. Using this convention, your photos are listed in date order when you view the filenames as a list, and the keyword can help you remember the occasion of the photos. Having your photos arranged in this way makes finding a photo easier than it is when you use the camera or scanner default naming convention. If you don’t start using a consistent method for naming your images, they soon become very difficult to find.
Digitizing Existing Pictures

Scanning existing photographic prints, drawings, slides, and negatives is a popular use for digital imaging. By scanning existing digital images, you can preserve vintage photographs on CD-Rs and CD-RWs, repair and retouch your family album, and share images with friends and family without losing control of your valuable negatives or original prints. You can e-mail or post your images on a Web site, even when they were not shot with your digital camera. In order to take advantage of these opportunities to use and share your existing photos in a digital format, you need to scan them into digital images. This chapter gives you the step-by-step procedures for scanning your existing prints.

After you scan your images, you can use them in exactly the same ways that you use images snapped with your digital camera. You can use images from either source to mix and match, cut and paste, e-mail, and blog away to your heart’s content.

I wrote the steps in this chapter using a commonly available Hewlett Packard (HP) Scanjet scanner. The first example uses the generic Windows Scanner Wizard to scan a photograph. The rest of the examples use the more flexible HP software that comes with the scanner. Scanners from other manufacturers and the software that comes with them are likely to have slight differences, although the general procedures are pretty similar. Even if you’re not using an HP scanner, these steps help guide you through the process.
Scan a Photo Using Windows Scanner Wizard

1. Place the photograph you wish to scan face up on your scanner glass plate and close the cover.

2. Choose Start ➪ All Programs ➪ Accessories ➪ Scanner & Camera Wizard.

   Your specific scanner may have special requirements or special software to scan with. In this case, follow the manufacturer’s instructions. I cover scanner-specific software in other examples in this chapter.

3. After the Scanner and Camera Wizard Welcome screen opens, click Next to move to the Choose Scanning Preferences screen, as shown in Figure 5-1.

4. Select the type of image you wish to scan from the Picture Type radio buttons. The options are

   • **Color Picture**: Choose this option when scanning color pictures. Figure 5-1 shows this option selected.

   • **Grayscale Picture**: Choose this option when scanning a black and white photograph. Grayscale pictures contain shades of white, black, and gray.

   • **Black and White Picture or Text**: Choose this option when scanning a black and white drawing or text. A black and white picture consists of solid black and white.

   • **Custom**: Choose this option if you wish to modify the color and brightness attributes of the scanned image.
5. Click Preview to have the scanner create a preview scan of your photograph, as shown on the right side of Figure 5-1. This scan is not final, but allows you to choose the section of the image you wish to include in your final scan.

6. After the preview scan is complete, drag the dotted select box around the portion of the photo you want to scan, as shown in Figure 5-2.

7. Click the Next button to continue to the Picture Name and Destination screen, shown in Figure 5-3.

8. Type or select (by clicking the downward-pointing arrow on the right side of each list box) your preferences for the image's location and file type. Specify these preferences:
   - **Type a Name for This Group of Pictures:** Create a folder name for your scanned images.
   - **Select a File Format:** Select the finished file type. The choices are: JPEG, BMP, TIFF, GIF, FPX, and PNG.
   - **Choose a Place to Save This Group of Pictures:** Select the folder on your hard drive to store the scanned images.

9. Click Next to begin the scan. After the scan finishes, the Other Options screen appears, as shown in Figure 5-4. Here, select whether you want to
   - **Publish these Pictures to a Web Site:** Select the picture or pictures you want to place on a Web site. You have to tell the wizard where to publish the pictures online.
   - **Order Prints of These Pictures from a Photo Printing Web Site:** Select a picture or pictures you want to print and you're offered a selection of online printing services to choose from.
   - **Nothing. I'm Finished with These Pictures:** A summary window appears; click Finish to exit the wizard.
Scan a Photo Using HP Photo and Imaging Director

1. Place the photograph you want to scan on your scanner glass plate and close the cover.

2. Start the HP Director software. For example, to start an HP scanner, choose Start ➪ Programs ➪ Hewlett-Packard ➪ HP Digital Imaging Device, and click Photo & Imaging Director.

   Some scanners have shortcut buttons on the hardware to give you a different method of starting the scanner software. Consult your scanner's instruction manual for the instructions for starting your model. (You can also find this information at the manufacturer's Web site.)

3. When Director opens, select your scanner from the drop-down list.

4. Choose Scan ➪ New Scan to commence a preview scan of your photograph, as shown in Figure 5-5.

5. When the preview scan is complete, drag the dotted select box around the portion of the photo you want to scan.

6. Click the Accept button to initiate the scan. The HP Image Gallery window stores the finished scan, as shown in Figure 5-6, for additional image processing or use.

   From time to time, clean the scanner bed with an ammonia-based glass-cleaning product. Doing so helps to prevent unnecessary dust, fingerprints, and dirt from scanning along with your images.
Scan a Slide

1. Place a slide in the slide holder on the top of your scanner lid.

   Your scanner may have a different slide scan arrangement than the HP scanner I use here. In this case, follow the manufacturer’s instructions. If no slide or negative scan device is built in to your scanner, you can’t scan slides using that particular scanner.

2. With Image Director open, choose Scan ➤ Accept ➤ Slides from TMA. The scanner creates a preview scan of your slide.

3. After the preview scan is complete, drag the dotted select box around the portion of the slide you want to scan.

   The default output type and other file attributes display below the Preview window. You can select different settings from the menu bar or, alternatively, from the option window. Scan slides you want to archive at the highest resolution possible — typically, 1200 dots per inch or greater. The file size of the finished image in the selected resolution is displayed below the Preview window.

4. Click the Accept button to initiate the scan, as shown in Figure 5-7. The HP Image Gallery window stores the finished scan, as shown in Figure 5-8, for additional image processing or use.

5. Answer the prompt asking whether you want to scan another slide. If you have more slides to scan, place a new slide in the scanner and click Yes. Otherwise, click No to return to the Image Gallery window.

   Wearing light, cotton gloves is a good idea while handling and scanning slides to prevent damaging or discoloring the slide with oil from your fingers.
Scan a Negative

1. Place a strip of negatives in the slide holder on the top of your scanner lid.

   ![Figure 5-9: The Preview window](image)
   
   Your scanner may have a different slide/negative scan arrangement than the HP scanner I use. In this case, follow the manufacturer’s instructions. If your scanner doesn’t have slide/negative scan device, you can’t scan negatives.

2. With Image Director open, select Scan ▶ Accept ▶ Negatives from TMA. The scanner creates a preview scan of your negatives.

3. After the preview scan finishes, drag the dotted select box around the portion of the negative you wish to scan, as shown in Figure 5-9.

   ![The scanner software automatically changes the negative to a positive image.](image)

4. Click the Accept button to start the scan.

5. The Image Gallery window stores the finished scan for additional image processing or use, as shown in Figure 5-10.

   ![Figure 5-10: The scanned negative rotated in the HP Image Editor window](image)

   Be exceedingly careful with your precious photo negatives! Except when carefully handling them during scanning, try to keep the negatives in plastic or paper non-acid sleeves. Store negatives in a dry, cool location and don’t expose them to bright light for extended periods. Photo stores and online catalog companies have special archival negative storage pages for safekeeping.
Use the Scanner Resize Option

1. Initiate the scan of a photo, slide, or strip of negatives.
2. When the preview scan is complete, drag the dotted select box around the portion of the image you want to scan, as shown in Figure 5-11.
3. Select the Resize option in the option window, as shown in Figure 5-11. You can make adjustments using the following options:
   - **Selection Area Dimensions**: These pull-down menus select the width and height of the scanned area.
     - You can resize the height and width of the scanned area more easily by dragging the selection box. Adjustments made this way display in the drop-down menu.
   - **Output Dimensions**: These pull-down menus select the width and height of the final image saved to your computer.
   - **Scale**: You can change the size of the output image by using the percentage pull-down menu.
   - **Units**: You can choose the measurement type used to adjust the image. The choices are inches, centimeters, points, or pixels.
4. When you have made your selections, click the Accept button.
5. The Image Gallery window stores the finished scan for additional image processing or use, as shown in Figure 5-12.
Use the Scanner Lighten/Darken Option

1. Initiate the scan of a photo, slide, or strip of negatives.
2. When the preview scan is complete, drag the dotted select box around the portion of the image you want to scan.
3. Select the Lighten/Darken option in the option window, as shown in Figure 5-13. You can adjust the following options:
   • **Highlights**: Adjusts the density and detail of image highlights.
   • **Shadows**: Adjusts the density and detail of image shadows.
   • **Midtones**: Adjusts the density and detail of image midtones.

   The Advanced options include
   • **White Level**: Adjusts the amount of white in the image. Moving to the left darkens the entire the image.
   • **Black Level**: Adjusts the image’s black content. Moving the slider to the right lightens the entire image.

   You can change the image density and detail of your photo prior to scanning using this option. The Auto button automatically adjusts the image to the software’s best judgment.

4. After you make your adjustments, click the Accept button.
5. The Image Gallery window stores the finished scan for additional image processing or use, as shown in Figure 5-14.
Use the Scanner Sharpen Option

1. Initiate a scan of a photo, slide, or strip of negatives.
2. When the preview scan finishes, drag the dotted select box around the portion of the image you want to scan.
3. Select the Sharpen option in the option window, as shown in Figure 5-15. From the pull-down menu, choose None, Low, Medium, High, or Extreme. The result of your choice appears in the Preview window.
4. After you make your adjustment, click the Accept button to start the scan.
5. The HP Image Gallery window stores the finished scan for additional image processing or use.

Use the Scanner Color Adjustment Option

1. Initiate the scan of a photo, slide, or strip of negatives.
2. When the preview scan finishes, drag the dotted select box around the portion of the image you want to scan.
3. Select the Color Adjustment option in the option window, as shown in Figure 5-16. You can adjust the color of the image by moving the magnifying glass. The color palette changes appear in the Preview window. Click the mouse when you’re satisfied with the color adjustment. Adjust the percentage of change using the slider to the right of the color wheel.
4. After you make your adjustments, click the Accept button.
5. The Image Gallery window stores the finished scan for additional image processing or use.
Part II

Editing and Enhancing Digital Photos

The 5th Wave

By Rich Tennant

"...and here's me with Cindy Crawford. And this is me with Madonna and Celine Dion..."
Manipulating Image Attributes

After you take some digital photos, you probably want to do something other than show them off on your camera’s teeny LED screen. The great thing about digital images is that you can use them in so many ways. Perhaps you want to jazz up your newsletter with pictures, maybe you want to add a picture to your digital scrapbook, or, quite possibly, you want to post your picture on the Web.

This chapter shows you how to use Adobe Photoshop Elements to accomplish simple, common tasks that come up frequently. The utility of many of Adobe Photoshop Elements’ editing functions are pretty intuitive, such as rotating an image that you turned your camera to take or cropping an image to concentrate on the subject.

The need for changing the file type, on the other hand, may not be so clear. The fact is that images you capture with your digital camera or scanner are initially created in a large, high-resolution JPEG (Joint Photography Experts Group) file with millions of colors, which is too big (both in the size of the photo and the file size) to use in many applications. You have to reduce the size of both the image and the file in order to use it. The good news is, you can adapt the size of your picture files to fit the requirements of the way you plan to use them and it’s an easy, step-by-step process!
Open an Image to Edit

1. In Adobe Photoshop Elements, choose File ➪ Open, as shown in Figure 6-1, to display the Open dialog box.

2. Navigate to the folder that contains the image you want to open. In many applications, you can take a shortcut by using the navigation bar on the left, as shown in Figure 6-2. Choose from the following options:
   - **My Recent Documents**: Finds files that you have recently used.
   - **Desktop**: Displays files stored on your computer’s desktop.
   - **My Documents**: Displays the contents of your My Documents folder.
   - **My Computer**: Displays your My Computer folder and allows you to search for additional folders and files.
   - **My Network Places**: Allows you to search for your file on other computers that you can connect to.

   If you don’t know where your picture is located, check in the My Pictures folder in the My Documents folder (many programs store digital pictures here by default). If you have no luck in the My Pictures folder, you can run a search for camera images by searching for jpg files. Choose Start ➪ Search ➪ For Files and Folders and type *.jpg in the Search for Files or Folders Named text box. Searching your hard drives gives you a list of all jpg images on your computer. Chapter 3 provides information about transferring images from your camera to your computer.

3. Select the file that you want to open and then click the Open button to open the file in your graphics program.
Change the Image Size

1. With an image open in Adobe Photoshop Elements, select Image ➤ Resize ➤ Image Size to display the Image Size dialog box shown in Figure 6-3.

2. Select the most appropriate size format for displaying the image from the Pixel Dimensions drop-down menus. The choices are
   - **Pixels**: This choice is good when you are adjusting images for displaying on your computer screen.
   - **Percent**: This choice is good when you are visually scaling in relationship to a page layout or another object.

3. From the Document Size area, you can resize the image printing characteristics as well as the image size and dimensions.

   ![](image.png)

   **Figure 6-3: Changing the image size in the Image Size dialog box**

   If you want to change only the print dimensions or the resolution, and proportionally adjust the total number of pixels in the image, select the Resample Image check box. If you want to allow the image to become distorted horizontally or vertically, deselect the Constrain Proportions check box. If you want the image to retain its proportions as one value is increased or decreased, select the Constrain Proportions check box.

4. Change the Width and/or Height of the image by entering values in the appropriate text boxes. You can adjust the size to be larger or smaller than the original.

5. Select the attributes you want and click OK to make the changes to your image, as shown in Figure 6-4.


   ![](image.png)

   **Figure 6-4: The image is scaled down**

   If you enlarge an image very much, detail is lost. When you shrink an image, the quality is also reduced. Make sure you review the results of a size change before you replace the original file.
Convert an Image to a New Format

1. With an image open in Adobe Photoshop Elements, choose File→Save As, as shown in Figure 6-5, to display the Save As dialog box.

   Another great use of the Save As dialog box is to change the filename of the image. Type a new filename in the File Name box and save the image.

2. Select the file format you want to change the image into from the Save as Type drop-down menu, as shown in Figure 6-6. The available types are

   - **TIFF:** A high-quality, information-rich (meaning large) graphic type. TIFF files are not used extensively in Web applications, but they are popular for newsletters, brochures, and other print media where image quality is important.

   - **GIF:** A compressed file type that is common on the Internet. GIF files are unique in that you can combine several images to create animated GIFs using special graphics programs, such as Adobe Photoshop. GIF files are often used for Web page buttons.

   - **PNG:** A PNG file is designed to work well with online viewing applications. It has a progressive display option similar to GIF.

   - **BMP:** A BMP file is a Windows bitmap file and is the default graphic file created by Windows graphics programs, such as Microsoft Paint.

   - **JPEG:** JPEG (Joint Photography Experts Group) file is the most common file created by digital cameras. JPEG is often used on the World Wide Web because the user can control the compression, and JPEGs are read by all Web browser programs.
Image editing programs provide variable JPEG compression options that usually include low, medium, high, and maximum quality settings or similar headings. A slider is often provided to select in addition to pull-down or radio button selections. Select the appropriate level of compression for your application. Figure 6-7 shows the slider in Adobe Photoshop Elements that allows you to select the compression ratio you need for your JPEG images.

3. Click the Save button.

After you change a file type, Windows automatically chooses the correct extension (the three letter code that Windows uses to determine the type of each file) and adds it to the end of the filename. Because the extension changes, you can retain the original filename without overwriting the original file. For example, scan0017.bmp is a different file from scan0017.tif. You can manually adjust what program Windows uses to open a particular file type: Shift+right-click one of the file icons and choose Open With ➤ Choose Program from the pop-up menu (see Figure 6-8). The Open With dialog box displays; select the program you want to open that type of file and select the Always Use the Selected Program to Open This Type of File check box.

4. Click the OK button if you wish to continue with the save. The image is saved as the new type.

Microsoft Paint allows you to save files from any format it can open into TIF, JPEG, GIF, and PNG files, as well as reduce the number of colors in the file. You can also create a monochrome file from a color file. If you want to convert a file to a format other than these, you have to use a more comprehensive application, such as Adobe Photoshop, Adobe Photoshop Elements, or Jasc Paint Shop Pro. Photoshop and similar programs also allow you to select from more options, such as variable compression in formats such as JPEG, GIF, and TIFF.
Flip or Rotate an Image

1. With an image open in Adobe Photoshop Elements, choose Image ➪ Rotate to see your orientation options. You also get help with rotating an image in the General Fixes palette in Quick Fix view, as shown in Figure 6-9. Your rotate options include the following:

   - **Rotate 90 degrees left**: Rotates the image to the left.
   - **Rotate 90 degrees right**: Rotates the image to the right.
   - **180 degrees**: Turns the image upside down.
   - **Transpose**: Mirrors and inverts the image simultaneously.
   - **Flip Vertical**: Flips the image on the vertical or top/bottom axis.
   - **Flip Horizontal**: Flips the image on the horizontal or left/right axis.
   - **Custom**: Rotates the image by the number of degrees you select.

2. Select the desired change.

3. Click OK to accept the change in the image. Figure 6-10 shows a rotated image.


Jasc Paint Shop Pro also has rotational commands that you can access by choosing Image ➪ Rotate.
Crop an Image

1. With an image open in Adobe Photoshop Elements, click the Crop tool (highlighted in Figure 6-11).

   ![Figure 6-11: Selecting a crop area in Photo Editor](image1)

   You can crop images in Jasc Paint Shop Pro using virtually the same steps.

2. Move your Crop tool over the image and place the cursor at the point within the image where you want the new upper-left corner to be located.

3. Click and drag the cursor down and to the right until the resulting dashed-line box encloses the part of the image that you want to retain, as shown in Figure 6-11. Then release the mouse button. The selected area remains visible.

4. Choose Image→Crop. The image is cropped to the selected area. If you don’t like the cropped image you see, click the Undo button and go back to Step 3.

5. When you’re satisfied with the trimmed-down look of your cropped image, you can move on to save or further edit the picture.

6. Choose File→Save. See Figure 6-12 for the resulting cropped image.

   ![Figure 6-12: The image after cropping](image2)
Invert an Image’s Colors

1. With an image open in Adobe Photoshop Elements, choose Filter ➪ Adjustments ➪ Invert, as shown in Figure 6-13.

2. The image changes from positive to negative (or negative to positive) depending on the original image, as shown in Figure 6-14.

Inverting is useful when you have scanned color negatives and need to change them into normal positive images. You don’t need the Invert function when you work with an image from your digital camera. It’s very useful, however, when you scan a color negative on your desktop scanner and want to make prints from it.

3. Choose File ➪ Save.

---

Figure 6-13: Inverting from positive to negative

Figure 6-14: An inverted image
Save an Image for the Web

1. To save an image for use on the Internet, start with an image open in Adobe Photoshop Elements and choose File ➪ Save For Web.

2. The Save For Web window opens with the original image on the left and a proposed version for use on the Web on the right, as shown in Figure 6-15. If the image is zoomed in too closely to see the entire picture on-screen, choose Fit on Screen or another view from the Zoom drop-down list in the lower-left corner of the Save For Web window. You may also use the Hand tool from the small toolbox in the upper-left corner to drag other areas into view. And you can change the zoom factor by clicking on the Zoom tool and then on the image, holding down the Alt key, and clicking to zoom out.

3. Choose one of the four formats for the Web image from the drop-down list directly below the Preset menu. The choices are GIF, JPEG, PNG-8, or PNG-24.

4. After you select the new image format, select the attributes appropriate to the file type you selected. Different optimization options appear for each format in the drop-down list. Choose predefined settings or select custom options as needed for the picture’s intended use.

5. Click OK to save the Web-ready image. A Save Optimized As dialog box opens, as shown in Figure 6-16.

6. Type a new filename in the File Name text box and click Save.
Fixing Common Image Problems

As you become more familiar with your digital camera and with the editing software associated with it, you encounter new photographic challenges. You may need to remove the speckles from a dusty scanned image or to soften the edges of an image that is harsh. The color of daylight and different artificial light sources makes skin and clothing appear different. You can adjust the colors in different shots to make them match. You can add many adjustments and effects to images transferred from your camera’s memory card to your computer.

Simple tools can easily correct most common problems with digital photographs. This chapter shows you how to use Adobe Photoshop Elements to edit and correct your photos.

Photoshop Elements is similar to other basic photo editing software such as Adobe PhotoDeluxe, Ulead Photo Express, Roxio PhotoSuite, and Microsoft Picture It. More advanced programs perform all the more basic functions as well. These include Adobe Photoshop and Paint Shop Pro. You can easily adapt the edit tricks I introduce in this chapter to most of these and similar packages.

Get ready to . . .
- Adjust Image Brightness or Contrast ........82
- Adjust Hue and Saturation.....................82
- Sharpen an Image ...............................83
- Posterize an Image .............................84
- Soften an Image .................................85
- Smudge an Image ...............................86
- Despeckle an Image ............................87
Adjust Image Brightness or Contrast

1. With an image open in Adobe Photoshop Elements, choose Enhance ➪ Adjust Lighting ➪ Brightness/Contrast to display the Brightness/Contrast dialog box shown in Figure 7-1.
2. Adjust the two sliders — Brightness and Contrast — until you’re satisfied with the effect on your photo.
3. Click OK to make the changes to your image and save your adjusted image by choosing File ➪ Save.

Adjust Hue and Saturation

1. With an image open in Adobe Photoshop Elements, choose Enhance ➪ Adjust ➪ Adjust Hue/Saturation to display the Hue/Saturation dialog box.
2. Select Master to adjust all colors at once. Or select the color you want to adjust from the Edit drop-down list at the top of the dialog box, as shown in Figure 7-2. The choices are Master, Reds, Yellows, Greens, Blues, Cyans, and Magentas.
3. Adjust the three sliders until you’re satisfied with the hue, saturation, and lightness of the color or colors in your photo. As you drag the sliders, the image adjusts to the new settings.
4. Click OK to make the changes to your image and choose File ➪ Save to save it.
Sharpen an Image

1. With an image open in Adobe Photoshop Elements, choose Filter ➪ Sharpen to display the Sharpen menu as shown in Figure 7-3. The Sharpen options are
   - **Sharpen**: Makes the edges of objects and faces in the photo become softer.
   - **Sharpen Edges**: Adds crispness to the edges of objects in the photo.
   - **Sharpen More**: Adds a stronger focus and enhances clarity. This choice creates a more pronounced effect than do the first two.
   - **UnSharp Mask**: Is modeled after a film technique and corrects blurring added during photographing or scanning. You can specify the radius of the region surrounding each pixel to be affected. Using this option creates a much more dramatic effect.

2. If you select Sharpen, Sharpen Edges, or Sharpen More, the effect is automatically applied to your image.
   - If you’re not satisfied, choose Edit ➪ Undo Sharpen to revert to the original image. You may then try other Sharpen options until you like the adjusted image.

3. If you select Unsharp Mask, a dialog box opens, as shown in Figure 7-4. Make and preview any adjustments here; then click OK.

Posterize an Image

1. To transform your photo into an image that looks like a poster or silk screen, open it in Adobe Photoshop Elements and choose Filter ➪ Adjustments ➪ Posterize, as shown in Figure 7-5.

2. When the Posterize dialog box appears, as shown in Figure 7-6, type a number in the Levels text box. This setting determines the extent of the Posterize effect.

3. Click OK to apply the effect.

4. Review the changes that appear in the After image. If you’re not satisfied, choose Edit ➪ Undo Posterize to revert to the original image. Then type a new number in the Levels text box and preview the changes until you’re satisfied with the adjusted image. Figure 7-6 shows a posterized image.

Check out page xvi in the front section for a larger example of the Posterize effect.

5. Choose File ➪ Save to make the effect permanent.
Soften an Image

1. With an image open in Adobe Photoshop Elements, choose Filters ➪ Blur ➪ Gaussian Blur to display the Gaussian Blur dialog box shown in Figure 7-7.

2. Adjust the slider to the right to make the softness stronger and to the left to make it weaker.

   Moving the slider to the right adds a gauze-like effect to a photo. Use this softening effect to de-emphasize blemishes or wrinkles in portraits or to reduce glare on shiny objects. You can also try different numbers of pixels in the Radius text box and preview the results.

3. After you make your softening adjustments, click OK.

4. Review the changes. If you’re not satisfied, choose Edit ➪ Undo Gaussian Blur to revert to the original image. You can then choose new settings until you’re satisfied with the adjusted image. Figure 7-8 shows a softened image.

5. Choose File ➪ Save.

   In Jasc Paint Shop Pro, try Effects ➪ Blur, Effects ➪ Blur More, or Effects ➪ Gaussian Blur.

Figure 7-7: Softening an image with the Gaussian Blur filter

Figure 7-8: The resulting softened image
Smudge an Image

1. To blur a selected area of a photo, open it in the Adobe Photoshop Elements Standard Edit mode and choose the Blur Tool near the bottom-left of the toolbar (shown in Figure 7-9).

   You can also use the Blur tool by clicking it on the top toolbar.

2. Select the size and shape of the brush that you want to use to smudge the photo in the top toolbar.

3. Choose an area in the photo to smudge and drag the cursor over the area.

4. Review the image. If you’re happy with the outcome, click OK. If you don’t like the effect, choose Edit ➪ Undo Blur Tool to revert to the image before you began using the Blur Tool. Figure 7-10 shows a smudged image.

   This effect is useful to obscure signs, unwanted faces, or other features in the photo. The Smudge tool does just what it sounds like. It’s ideal for keeping the identity of relatives in the witness protection program a secret.

5. Choose File ➪ Save.

   In Jasc Paint Shop Pro, use the Smudge option in the Retouch tool (the Retouch tool looks like a pointing finger).
Despeckle an Image

1. To get rid of dust and speckles on a photo, open the digital image in Adobe Photoshop Elements and choose Filter ➪ Noise ➪ Despeckle, as shown in Figure 7-11. The effect is automatically applied to the image you have open.

2. Review the changes. If you aren’t satisfied, choose Edit ➪ Undo Despeckle to revert to the original image.

3. Choose File ➪ Save when you get the result you want.

This image adjustment is a powerful tool when you are working from dirty and dusty prints or scanned slides. This adjustment can also improve digital photos shot with a low number of pixels.
Chapter 7: Fixing Common Image Problems
Repairing Digital Images

Nearly everyone has a trunk full of old family photographs that are faded or spotted with age (like that picture of your grandfather in his knickers), or recent pictures that are torn or damaged. Once you had to pay a photography professional serious money to rescue important images from decay. Now, however, the wonder of photo editing software puts that resuscitative power in your hands. Repairing damaged photos that you scan from your collection is one of the chief attractions of digital photography.

This chapter helps you explore some of the basic repair techniques and tools available in Adobe Photoshop Elements. This image editing software gives you Quick Fix functions, handy palettes, and great retouching tools. In this chapter’s step lists, I show you how to use these tools and functions to repair the most common types of damage to digital images.

But don’t stop there. As you gain experience, you’ll feel empowered to experiment with all the tools and features available in your photo editing software. And when you do, you’ll no doubt find pleasant surprises there. Happy editing.

Get ready to . . .

- Fix Contrast and Brightness Problems in Quick Fix View ......................................90
- Fix Faded Photos in Quick Fix View ............91
- Fix Focus Problems with Auto Sharpen........92
- Rotate an Image in Quick Fix View ..........92
- Remove Red Eye........................................93
- Remove Dust and Scratches........................94
- Remove Creases and Blemishes ..................95
- Fix a Torn Photo ........................................96
- Convert a Color Photo to Grayscale ............97
- Make a Photo Collage ................................97
Fix Contrast and Brightness Problems in Quick Fix View

1. Open your digital image in Adobe Photoshop Elements and click Quick Fix.
2. To correct a photo’s exposure problems in the Quick Fix view, choose Enhance ➤ Adjust Lighting ➤ Brightness/Contrast to open the Brightness/Contrast dialog box, as shown in Figure 8-1.
3. Move the appropriate slider to adjust either or both of the dialog box’s adjustment options. Your choices are
   - **Brightness**: Adjust slider to the right (higher percentage) to brighten the colors in the image and to the left (lower percentage) to darken the colors.
   - **Contrast**: Adjust slider to the right (higher percentage) to increase the separation between the colors and to the left (lower percentage) to reduce the separation between colors.
4. Review the adjustments you made in the After window.
5. Click OK to save your changes. To disregard changes, click Cancel.

The Auto Contrast option is a fast way to make the most common corrections. To apply this quick fix, choose Enhance ➤ Auto Contrast from the toolbar or click the Auto Contrast button on the Lighting palette at the right of the Quick Fix window.
Fix Faded Photos in Quick Fix View

1. Open your photo in the Adobe Photoshop Elements Quick Fix view and select Before and After (Portrait) from the View drop-down menu.

2. Select the Color palette at the right of the Quick Fix window.

3. Select an adjustment option. Your choices are
   - **Auto Color:** Click the Auto button, shown in Figure 8-3, to adjust the color balance using a built-in formula. This effect is automatic. If you don’t like it, use Hue/Saturation, Temperature/ Tint options for manual control.
   - **Saturation/Hue:** This area of the color palette enables manual adjustments that affect the hue (color from red through magenta) and saturation (intensity of the color) of the image. You simply move the sliders, as shown in Figure 8-4, to make these adjustments.
   - **Temperature/Tint:** This area of the color palette also gives you manual control. Move the sliders to adjust the Temperature (color from blue to red) and Tint (color from green through magenta) of the image.

4. Adjust the sliders for Hue/Saturation and Temperature/ Tint. For the Auto Color automatic adjustment, just click the Auto button (see Figure 8-3). Review your changes in the After window.

5. Click the check mark icon (shown in Figure 8-4) to commit to the changes you made. Click the no icon to cancel the changes. To reset your photo to its original look and start over, click the Reset button in the After window.

Fix Focus Problems with Auto Sharpen

1. Open your photo in the Adobe Photoshop Elements Quick Fix view and select Before and After (Portrait) from the View drop-down menu.
2. Click the arrow next to Sharpen to select that palette.
3. Select an adjustment option. Your choices are
   - **Auto Sharpen**: Sharpens the image as the program thinks it should
   - **Sharpen slider bar**: Gives you manual control of image sharpening
4. Click the Auto button, as shown in Figure 8-5, to automatically adjust the image sharpness. Continued clicks add further sharpening.
5. Drag the Amount slider to the right along the bar to sharpen the image. Click the check mark icon to commit to your changes or the no icon to cancel the changes.

Rotate an Image in Quick Fix View

1. Open your image in the Adobe Photoshop Elements Quick Fix view. Click the arrow to open the General Fixes palette, as shown in Figure 8-6.
2. Click one of the Rotate buttons at the top of the palette to rotate your image 90 degrees to the left or right.
3. The adjustment is automatic; if you accidentally chose the wrong rotation direction, click Reset in the After view.

You can choose Image-Rotate for a variety of other rotation options including 180-degree rotation, custom rotation, and flipping to a mirror image.
Remove Red Eye

1. Open your image in Adobe Photoshop Elements and click the Standard Edit button to access that view.

2. To fix the common problem of red eye, select the Zoom tool from the toolbox as shown in Figure 8-7.

The best cure for red eye is not to have it in your picture to begin with. Red eye is caused by the sudden, bright light of the flash reflecting off the retina’s blood vessels. Many cameras come with a red-eye reducing flash that flashes twice, once to contract the pupil and again to light the image. Having the pupil contracted reduces red eye quite a bit. Also, if you have a detachable flash, holding the flash off to the side helps to reduce red eye, because the light doesn’t reflect directly into the camera.

3. Click and hold at the upper-left corner of the left eye and drag the cursor to the lower-right corner of the right eye to magnify the eyes.

4. Choose the Red Eye tool from the toolbox, as shown in Figure 8-8.

5. Choose values from the drop-down lists of the Red Eye tool adjustment options (along the top of the Standard Edit window). Your choices are
   - **Pupil size**: Sets the proportion of the pupil, or dark center of the eye, to the rest of the eye.
   - **Darken amount**: Sets how dark you want to make the center of the eye.

6. Click on the center of an eye. The Red Eye tool automatically replaces the red reflection with a dark pupil. Repeat on the other eye.

7. Choose File ➪ Save.

Be sure to scan in old photos that suffer from red-eye syndrome and fix them, too!
**Remove Dust and Scratches**

1. To remove scratches and specks from scanned pictures, open the image in Adobe Photoshop Elements, click the Standard Edit button, and choose the Rectangular Marquee tool, as shown in Figure 8-9.

2. Drag the cursor around the area that contains specks or scratches.


4. Select the Preview check box, as shown in Figure 8-10, to preview changes in the image window.

5. Drag the Radius slider all the way to the left.

   The Radius slider tells the software what size specks to find and correct. Moving to the right increases the size of the speck in pixels.

6. Drag the Threshold slider all the way to the right.

   When you drag the Threshold slider to the right, it determines the amount of correction to apply to the selected area of the photo.

7. Drag the Threshold slider to the left until the lines or specks are removed.

8. Click the OK button to make the adjustments permanent.


---

**Figure 8-9:** A selected area of a photo

**Figure 8-10:** Adjust the sliders in the Dust & Scratches dialog box
Remove Creases and Blemishes

1. To remove spots and blemishes from a photo in Adobe Photoshop Elements, open the image in Standard Edit view and choose View ➪ Actual Pixels to view the picture at 100 percent size.

2. Select the Clone Stamp tool from the toolbox, as shown in Figure 8-11. It looks like a rubber stamp.

3. Select the soft-edged brush from the Brushes drop-down list on the Options bar, as shown in Figure 8-12.

   You can change the brush size by dragging the Size slider. A larger brush makes changes faster, while a smaller brush gives you more control to avoid changing an area accidentally.

4. Position the mouse pointer over an undamaged area with a similar color and texture as the damaged area.

5. Alt+click to select the undamaged area as a sample.

6. Drag the Clone Stamp over the damaged area and paint.

   For a more realistic effect, use short even strokes.

7. Continue until you remove all the spots and blemishes. Figure 8-12 shows the photo being repaired.

8. Click the OK button to make the adjustments permanent.


Figure 8-11: A crease and some blemishes in an otherwise precious photo

Figure 8-12: The repair process in progress
Fix a Torn Photo

1. With an image open in the Adobe Photoshop Elements Standard Edit view, drag the Zoom tool around the torn edge of the photo to magnify the area, as shown in Figure 8-13.

2. Select the Clone Stamp tool from the toolbox, as shown in Figure 8-14. (It looks like a rubber stamp!)

3. Select the soft-edged brush from the Brushes drop-down list on the Options bar.

   ![You can change the brush size by dragging the Size slider.]

4. Position the mouse pointer on an undamaged area with a similar color and tone as the torn corner.

5. Alt+click in the area to select it as a sample.

6. Drag the Clone Stamp over the damaged area and paint.

7. Repeat the steps until you repair the whole damaged area. See Figure 8-14.


   ![The Clone Stamp tool paints with a small selection of the actual photo. If the damage is extensive, you may need to use the Airbrush tool to make minor adjustments as well. Zoom in on the image so you can see the repair clearly.]

---

Figure 8-13: The upper-left corner of this photo needs help

Figure 8-14: The Clone Stamp tool to the rescue
Convert a Color Photo to Grayscale

1. With an image open in the Adobe Photoshop Elements Quick Fix view, choose Enhance ➪ Adjust Color ➪ Remove Color, as shown in Figure 8-15.

A grayscale image is usually called a black and white image. The correct name is grayscale to distinguish from line drawings with no gradations. This is a simple way to create a grayscale image from a color image. When you convert the image, you might need to use Quick Fix to adjust the contrast and brightness (as shown in the “Fix Contrast and Brightness Problems in Quick Fix View” section) for the best image quality.

2. Photoshop Elements automatically makes the adjustments permanent.

3. Choose File ➪ Save.

Make a Photo Collage

1. In Adobe Photoshop Elements, choose File ➪ New ➪ Blank File to open a new, blank image area.

2. From the Preset Sizes menu, select a size large enough to contain all the individual photos you want to include in the collage.

3. Choose File ➪ Open and select the first image or photo.

4. Select the Move tool button in the toolbox. Doing so allows you to move the selection where you want it with the mouse.

5. Drag the opened image into the collage image window, as shown in Figure 8-16.

Figure 8-15: Use Remove Color to make a grayscale image

Figure 8-16: Dragging an image into a new collage
6. Choose Image ➪ Transform ➪ Free Transform. This tool allows you to rotate, move, or resize the added image.
7. Drag the appropriate handle to transform the image.
   - **Move**: Click the cursor within the selected area of the image and drag it to a new location.
   - **Rotate**: Move the cursor near one of the square handles on the corners or mid-sides of the selected area until a curved arrow appears. Then click and drag the mouse to rotate the selected area.
   - **Resize**: Select one of the square handles of the selected area and drag it in or out to a new larger or smaller size.

8. When you have made all the desired changes, click OK on the Options bar.
9. Choose Window ➪ Layers to view the Layers palette.
10. Drag the Opacity slider in the Layers palette to adjust the opacity of the added image, as shown in Figure 8-17.
11. Repeat Steps 3 through 10 until you complete your collage, as shown in Figure 8-18.
12. Choose File ➪ Save and specify a filename, file type, and location; then click Save.
Adding Photo Editor Special Effects

Part of enjoying digital photography is enjoying yourself in the digital darkroom. Old-fashioned film photography doomed the photographer to one chance — what you snapped is what you got. Not only can you now fix many of the mistakes everyone makes, but you can also become a creative graphic artist. You can easily convert simple photos into watercolor paintings, pen-and-ink drawings, and images resembling stained glass windows. Basic editing software, such as Microsoft Photo Editor, has a number of popular creative options. You explore them in this chapter.

When you’re working with the Microsoft Photo Editor special effects in this chapter, keep the following in mind:

- You don’t need to add special effects to your entire image. Use the Select tool to outline an area of the image you’d like to draw attention to and add your special effect to just that part.

- If you really don’t like the result of the effect you just applied to your image, you can click the Undo button, choose Edit ➪ Undo, or press Ctrl+Z.

- You can be really adventurous by applying more than one special effect. For an interesting combination, try embossing and then texturing your image.

- You can undo only the last effect you apply. If you’ve applied more than one special effect and want to go back to the original look, close your image file without saving it. Then you can reopen your digital image and try again.

If you’re inspired to go beyond Photo Editor — or if you simply don’t have Photo Editor on your PC — check out some of the many Adobe Photoshop Elements effects in Chapter 10.
Make an Image Look Like a Chalk-and-Charcoal Drawing

1. If you want to make your photo gain an abstract look (as though the lines are rendered in charcoal pencil and the colors with chalk), choose Effects ➪ Chalk and Charcoal. The Chalk and Charcoal dialog box displays, shown in Figure 9-1.

   ![Figure 9-1: Converting an image with the Chalk and Charcoal effect](image1)

   In Adobe Photoshop Elements, choose Filter ➪ Sketch ➪ Chalk and Charcoal to achieve this effect.

2. Adjust the three sliders and click the Preview button. Review the results in the After window until you’re satisfied with the changes to your photo. The three sliders are:
   - **Charcoal Area**: Adjust the amount of charcoal effect (similar to the chalk effect, but darker) in the drawing.
   - **Chalk Area**: Decrease and increase the amount of the chalk effect (a light drawing effect) in the image.
   - **Stroke**: Imagine that you created your image with chalk and charcoal pencils. This setting changes the size of the chalk and pencil surface used in the rendering.

   ![Figure 9-1: Converting an image with the Chalk and Charcoal effect](image2)

   The Preview window shows the small area of the photo within the square on-screen, as shown in Figure 9-1. You can preview other parts of your image by dragging the small box within the larger image.

3. After you select the attributes, click the Apply button to make the changes to your image, as shown in Figure 9-2.

Emboss an Image to Make It Appear Raised

1. To change an image to make it appear embossed (or raised) on a metal plate in Microsoft Photo Editor, choose Effects → Emboss to display the Emboss dialog box shown in Figure 9-3.

   In Adobe Photoshop Elements, choose Filter → Stylize → Emboss to achieve this effect.

2. Adjust the Relief slider and the Light Position control to affect the Embossed effect:
   - **Relief**: This slider increases or decreases the depth of the three-dimensional embossed effect.
   - **Light Position**: This pull-down menu selects the position and direction of the light source that creates shadows on the embossing. The choices are: Bottom, Bottom Left, Left, Top Left, Top, Top Right, Right, and Bottom Right.

3. Click the Preview button and review the results in the After window. You can continue to make adjustments until you’re satisfied with the changes to your photo.

   Whenever you’re not happy with the outcome of an effect that you apply in Microsoft Photo Editor, you can always choose Edit → Undo right away to go back.

4. Click the Apply button. Figure 9-4 shows an example of this effect.

5. Choose File → Save.
Make an Image Resemble a Watercolor Painting

1. If you want your photo image to resemble a watercolor painting, choose Effects » Watercolor to display the Watercolor dialog box shown in Figure 9-5.

   You can create amazing art works from ordinary photographs with a little bit of experimentation. This effect is good to use with pictures of people. It creates great greeting card images.

   In Adobe Photoshop Elements, choose Filter » Artistic » Watercolor to achieve this effect.

2. Adjust the three sliders to affect the appearance of the Watercolor effect:
   - **Brush Detail**: Decrease and increase the size and intensity of the strokes used on the photo.
   - **Shadow Intensity**: Decrease and increase the intensity and contrast in the dark areas of the image.
   - **Texture**: Decrease and increase the surface or ground texture.

3. Click the Preview button and review the results in the After window. You can adjust the sliders until you’re satisfied with the changes to your photo, as shown in Figure 9-5.

4. Click the Apply button to commit the changes to your image, as shown in Figure 9-6.

5. Choose File » Save.
Make an Image Resemble Textured Paper

1. To make an image look as though it’s made of textured paper in Microsoft Photo Editor, choose Effects → Notepaper to display the Notepaper dialog box shown in Figure 9-7.

   ![Figure 9-7: Selecting Notepaper properties](image)

   In Adobe Photoshop Elements, choose Filter → Texture → Texturizer to achieve this effect.

2. Adjust the three sliders to affect the appearance of the Notepaper effect:
   - **Image Balance**: Decrease and increase the relationship between the image and the paper background and the sharpness of the image that’s embossed into the paper.
   - **Graininess**: Decrease and increase the size of the noise pixels combined with the image in the effect.
   - **Relief**: Decrease and increase the apparent 3-dimensional depth of the embossing effect.

3. Click the Preview button to review the results in the After window. You can continue to adjust the sliders until you’re satisfied with the changes to your photo. (See Figure 9-7.)

4. Click the Apply button to make the changes to your image, as shown in Figure 9-8.

5. Choose File → Save.

   For another example of this effect, see page xxii in the front section.

![Figure 9-8: An image with the Notepaper effect](image)
Make an Image Resemble Stained Glass

1. To make your image look like stained glass in Microsoft Photo Editor, choose Effects ➪ Stained Glass to display the Stained Glass dialog box shown in Figure 9-9.

2. Adjust the three sliders to manipulate how representational (or abstract) the Stained Glass effect appears:
   - **Cell Size**: Decrease and increase the size and number of individual stained glass bits the photo is converted into. As the size of cells increase the number of cells decreases.
   - **Border Thickness**: Decrease and increase the thickness of the lines between the glass elements.
   - **Light Intensity**: Decrease and increase the intensity of the light coming through the window.

3. Click the Preview button and review the results in the After window. You can readjust the sliders until you’re satisfied with the changes to your photo. (See Figure 9-9.)

4. Click the Apply button to make the changes to your image, as shown in Figure 9-10.

5. Choose File ➪ Save.
Add a Textured Look to an Image

1. To make your photo image look like it's printed on another texture (such as brick, canvas, or burlap) in Microsoft Photo Editor, choose Effects ➪ Texturizer to display the Texturizer dialog box shown in Figure 9-11.

In Adobe Photoshop Elements, choose Filter ➪ Texture ➪ Texturizer to achieve this effect.

2. Adjust the Effect controls to achieve the desired effect:
   • **Type**: Select the type of texture that applies to the image, such as burlap, sandstone, or brick.
   The TIFF selection in the Type menu allows you to use another photograph or drawing to create the basis for a textured effect. The effect is similar to embossing but is more subtle than a full embossed effect.

   • **Scaling (%)**: Decrease and increase the percentage of the effect applied to the photo.

   • **Relief**: Decrease and increase the depth of the 3-D effect.

   • **Invert Texture**: Invert the selected texture, so raised areas become lowered and vice-versa.

   • **Light Position**: Select the location of the light source and the apparent resulting shadows.

3. Click the Preview button and review the results in the After window. Readjust the sliders until you're satisfied.

4. Click the Apply button to make the changes to your image, as shown in Figure 9-12.

5. Choose File ➪ Save.
Make an Image Look Like a Pen-and-Ink Drawing

1. To make an image appear as though drawn in pen and ink in Microsoft Photo Editor, choose Effects ➤ Graphic Pen, which displays the Graphic Pen dialog box shown in Figure 9-13.

   This effect is the perfect choice for a note, a Christmas card of the family, or an announcement card for a new house.

   In Adobe Photoshop Elements, choose Filter ➤ Sketch ➤ Graphic Pen to achieve this effect.

2. Adjust the sliders for the effect you want:
   - **Stroke Length**: This slider decreases and increases the length of the individual pen strokes.
   - **Stroke Direction**: This pull-down menu selects the direction of the pen strokes.
   - **Light/Dark Balance**: This slider decreases and increases the lightness and darkness or amount of pen strokes used to render the image in the drawing.

3. Click the Preview button and review the results in the After window until you’re satisfied with the changes to your photo.

4. Click the Apply button to make the changes to your image, as shown in Figure 9-14.

5. Choose File ➤ Save.

---

*Figure 9-13: Using the Graphic Pen effect on an image*

*Figure 9-14: An image with the Graphic Pen effect*
Outline an Image’s Edges

1. To convert the image to an abstract outline of the photo’s edges in Microsoft Photo Editor, choose Effects ➪ Edge to display the Edge dialog box, as shown in Figure 9-15.

   In Adobe Photoshop Elements, choose Filter ➪ Sharpen ➪ Sharpen Edges command to achieve this effect.

2. Select the radio button for the effect you want. You can choose thick or thin edges, or only horizontal or vertical edges.

3. Click the OK button to make the changes to your image, as shown in Figure 9-16.

Chapter 9: Adding Photo Editor Special Effects
Adding Photoshop Elements Effects

When Adobe, Inc. came out with Photoshop Elements, digital photographers all over the world were effusive in their praise, and for good reason. Photoshop Elements takes many of the effects that you can synthesize in Photoshop and reduces the process to clicking a few buttons. What was once the realm of the few experts immediately became the forte of the masses. And what’s more, Photoshop Elements is priced hundreds of dollars less than its expert big brother.

In this chapter, I introduce you to some of the spectacular effects available in Photoshop Elements. You find out how to

- Add a wind effect to give the appearance of movement
- Give your photos different appearances, such as making them seem like colored-pencil drawings, mosaics, or metallic renderings
- Provide spectacular lighting effects
- Distort images

And these effects, even though they look spectacular, are simple enough for anyone to use with confidence. Just follow the steps!
Blow Motion into Images

1. To add motion to a static photo with wind effects in Adobe Photoshop Elements, choose Filter ➪ Stylize ➪ Wind. The Wind dialog box opens, as shown in Figure 10-1.

2. Select a method and direction to achieve your desired effect in the sample window. The options are
   • Method: Selects the power of the blast of wind.
   • Direction: Selects the direction of the wind.

3. Click OK to apply the effect to the photo.


For another example of the Wind effect, see page xv in the front section.

Make a Photo Look Like a Mosaic

1. Choose Filter ➪ Texture ➪ Mosaic Tiles. The Mosaic Tiles dialog box opens, as shown in Figure 10-2.

2. Move the sliders to achieve your desired effect.
   • Tile Size: Selects the size of the virtual tiles.
   • Grout Width: Selects the width of the spaces between the tiles.
   • Lighten Grout: Selects the amount of shadow in the grout spaces.

3. Click OK to apply the effect to the photo.

Give a Photo a Chromed Metallic Look

1. To make a photo resemble an exotic, chrome sculpture in Adobe Photoshop Elements, choose Filter ➪ Sketch ➪ Chrome. The Chrome dialog box opens, as shown in Figure 10-3.

2. Experiment with the options until you reach the desired effect in the sample window. The options are
   - **Detail**: Adjusts the depth of the embossing.
   - **Smoothness**: Adjusts the smoothness of the ridges and edges.

   Try the Chrome effect on block text that you want to use in a Web page banner. The Chrome effect really makes the text stand out!

3. Click OK to apply the effect to the photo, as shown in Figure 10-4.


   Apply the other artistic effects in Elements in a similar way. Experiment with a variety of effects. You can invent your own effects by applying effects to an image and continuing to add other effects to the changed image. The sky's the limit.

   For another look at this dramatic effect, check out page xii in the front section.
Change a Photo to a Colored Pencil Drawing

1. Photos can be given a subtle and elegant artistic look with the Colored Pencil effect. With an image open in Adobe Photoshop Elements, choose Filter ➪ Artistic ➪ Colored Pencil. The Colored Pencil dialog box opens, as shown in Figure 10-5.

2. Experiment until you achieve the desired effect in the sample window. The options are
   - **Pencil Width**: Adjusts the size of the pencil strokes.
   - **Stroke Pressure**: Adjusts the fuzziness of the strokes.
   - **Paper Brightness**: Determines the virtual effect of paper showing through the drawing.

3. Click OK to apply the effect to the photo, as shown in Figure 10-6.

   To see another image with this effect, check out page xiii in the front section.


   Using the artistic effects is a wonderful way to create paintings and drawings, even if you are not a graphic artist. In addition to the digital effects, the choice of paper and printing technique you use can add quality to the finished product.
Change Photo Lighting

1. Lighting is the source of drama in photos. If your images lack pop with real light, consider using these virtual lighting effects. With an image open in Adobe Photoshop Elements, choose Filter ➪ Render ➪ Lighting Effects. The Lighting Effects dialog box opens, as shown in Figure 10-7.

2. Experiment until you achieve the effect you want in the sample window. The options are
   - **Style**: Allows you to select the position and number of lights desired. There are a wide variety of choices. Select them one by one and review the effect in the Preview window.
   - **Light Type**: Selects spotlight, directional, or omni-directional light type.
   - **Properties**: Determines the virtual effect of the materials interacting with the light.
   - **Texture Channel**: Determines the way color filters are applied to the photograph.

3. Click OK to apply the effect to the photo, as shown in Figure 10-8.

   To see another image with spotlight lighting, see page xiv in the front section.


   Use the Lighting Effects filter for dramatic and special effects; improve the lighting in a less dramatic photograph or fix lighting problems. If you are trying for realistic effects, keep the selections subtle.
**Distort a Photo Around an Axis**

1. Create a dramatic 3-D reshaping of a photo with the Polar Coordinates Effect. With an image open in Adobe Photoshop Elements, choose Filter ➪ Distort ➪ Polar Coordinates. The Polar Coordinates dialog box opens, as shown in Figure 10-9.

2. Experiment until you achieve your desired effect in the sample window. The options are Rectangular to Polar and Polar to Rectangular.

3. Click OK to apply the effect to the photo, as shown in Figure 10-10.


   The Polar Coordinates effect is very extreme and dramatic. Use it to create an abstract art piece from a photograph.

---

To see a larger version of this image with this effect applied to it, check out page xi in the front section.
Use the Difference Clouds Effect

1. To add motion to a static photo with these wind effects in Adobe Photoshop Elements, choose Filter ▶ Render ▶ Difference Clouds, as shown in Figure 10-11.

2. The effect automatically applies to the photo.

3. Choose File ▶ Save. Figure 10-12 shows the same image after the Difference Clouds effect is added.

For a larger version of the Difference Clouds effect, see page xxiv in the front section.

Figure 10-11: The Difference Clouds menu

Figure 10-12: The Difference Clouds effect applied to a photo
Using Layers

Graphics professionals use the most powerful features of Adobe Photoshop to create amazing images, and Adobe Photoshop Elements puts many of the same tools in the hands of the average digital photographer. Among the most powerful and useful features shared by Photoshop and Photoshop Elements is the Layers feature, which allows you to select individual parts of an image to work on without fear of damaging the master image. The Layers feature also eliminates the tedium of detailed painting or processing in small areas. If you master only one advanced image-editing feature, the Layers feature should be the one.

Layers provide you with the ability to merge multiple images, moving a sky or figure from one image to another, for example, or changing the scene of a photograph. You can bring Aunt Beth along on your vacation trip (at least in the photo records), even if she decided to stay at home. And think of all the places you can add a pink plastic flamingo!
Select an Area to Move to a Layer

1. Select an area of your image (with the intent of moving it to another layer) in Adobe Photoshop Elements. Photoshop Elements displays the area surrounded by a dashed selection line. Choose from these three tools:

- **Brush**: “Painting” over an area of the photograph with the Brush tool merely selects that area. It doesn’t change the color, add color, or anything you normally associate with painting. To use the Brush tool, select it in the toolbox (as shown in Figure 11-1) and then move your cursor over the area that you want to select. You don’t have to hold the mouse button continuously. You can continue to add area to your selection using this tool by moving the brush to another area, depressing the mouse button, and adding selected areas.

- **Magic Wand**: This tool works best when selecting large and uniform areas of color, such as the sky. Areas with texture, such as waves, are broken into many subareas that are difficult to use. Select the Magic Wand tool (as shown in Figure 11-2) and click in the middle of the area you want to select.

  If you use the Magic Wand tool and find that the selected areas consist of a large number of small selection areas, deselect the areas (as in Step 3) and try using the Brush tool instead.

- **Rectangular Marquee**: This tool is the easiest way to select rectangular areas for cropping or cutting. To use the Rectangular Marquee tool, select it in the toolbox.
(as shown in Figure 11-3) and place the cursor in the upper or lower corner of the area. Click and drag the cursor diagonally away from the selected corner.

You can add to an area selected with the Rectangular Marquee tool by selecting the Brush tool and painting more selection area.

3. If your selection is unsatisfactory, choose Select➪Deselect to deselect the object. Repeat Step 1, substituting another of the tools as necessary.

4. Cut or copy the selected object to a new layer, as described in the next task.

**Move the Selection to a New Layer**

1. With an area of your image selected in Adobe Photoshop Elements, choose Layer➪New. You then can choose Layer Via Copy or Layer Via Cut to move the information to a new layer, as shown in Figure 11-4.

One of the most useful aspects of layers is moving a section of the existing photo onto a layer. You can apply effects, filters, and other changes only to the selected area and not to the entire image. This technique is particularly useful, for example, to dim an interior scene or enhance the color of one wall in a shot.

2. The section becomes a new and independent layer. You can name, modify, delete, or transform the layer without any change to the original layer.

3. Choose File➪Save.
Add a New, Blank Layer to an Image

1. With an image open in Adobe Photoshop Elements, choose Layer ➪ New ➪ Layer, as shown in Figure 11-5. Doing so creates a new layer.

   An alternative way of working with layers is to use the Layers palette, which you can display by choosing Window ➪ Layers. To add new layers, Alt+click the New Layer button at the bottom of the palette, as shown in Figure 11-6. Give the new layer a name in the New Layer dialog box. You can add as many layers as you need using this command.

   Using layers is similar to placing sheets of tracing paper on top of an original image, and making changes or adding elements to the overlays. While preserving the original, you can add text, effect changes on all or part of the image, add pictures or parts of other pictures, and much more. Layers are the key to easily manipulating and managing edits and additions to digital photos. This simple but sophisticated tool requires experimentation and practice to fully master its potential.

2. Click OK in the New Layer dialog box.

3. The new layer and the background layer now appear in the Layers palette.

   The checkerboard pattern you see in Figure 11-6 tells you which parts of the layer are transparent. In the case of Figure 11-6, you can tell that the new layer is completely transparent (for now) and that, as such, there is no change to the original image. However, the new layer is, in effect, a blank slate that you can use to add, change, color, or do anything you want to the original image, without altering the original image. Layers are a very powerful feature.

**Rename a Layer**

1. To change the name of a layer you created to something easier to remember than *Layer 1*, click the name of the layer in the Layers palette to select it.

   Taking the time to rename layers can make your image much easier to manage if you intend to work with more than three layers. As the number of layers increases, the need for an organized way of getting at your information increases as well.

2. Choose *Layer ➪ Rename Layer*.

3. Type a new name in the Layer Properties dialog box, as shown in Figure 11-7.

4. Click OK.

**Link a Layer to Another Layer**

1. With a layered image open in Adobe Photoshop Elements, select one of the layers that you want to link to make it the active layer.

   When you move, scale, or rotate one of two linked layers, the other layer moves, scales, or rotates with it.

2. In the layer that you want to link to the active layer (not the active layer itself), select the second check box nearest to the layer name in the Layer palette (the one to the right of the eyeball icon). A link icon appears in the box as shown in Figure 11-8.

3. To unlink the layers, click in the check box again.

![Figure 11-7: Renaming a layer](image1)

![Figure 11-8: A linked layer](image2)
Change the Layer Order

1. To change the order of layers in an image in Adobe Photoshop Elements, open a multilayer image and the Layers palette (drag it from the palette well on the right side of the shortcut menu onto your workspace to see it clearly).

2. Select the layer that you want to move in the Layers palette, as shown in Figure 11-9.

3. Choose Layer ▸ Arrange as shown in Figure 11-10. You then have a submenu that allows you to accomplish the following:
   • Bring to Front: Makes the layer you selected the top-most layer.
   • Bring Forward: Swaps the positions of the layer you selected and the layer that is immediately above it.
   • Send Backward: Swaps the positions of the layer you selected and the layer that is immediately behind it.
   • Send to Back: Makes the layer you selected just above the Background layer.

   The Background layer is the original image and is always the bottom-most layer.

4. Repeat Steps 2 and 3 for other layers until you’re satisfied with the order.

   To quickly rearrange the order of multiple layers, simply drag the layers in the Layers palette into the order you desire.

Figure 11-9: Selecting a layer

Figure 11-10: Arranging a layer
Edit a Layer

1. With a multilayer image open, select the layer you want to edit to make it the active layer. You can then edit the layer in a variety of ways:

   - **Resize an image on a layer:** Scale an image by choosing Image ➪ Resize ➪ Image Size, as shown in Figure 11-11. For fine-tuning, choose Image ➪ Resize ➪ Scale. You want to scale images down rather than up, because images that are scaled up become pixellated and grainy. If you want to enlarge a part of an image, scale down everything except that part of the image.

   - **Move an image on a layer:** Drag an image using the Move tool (a marquee appears around the selection that also allows you to resize or rotate the image) as shown in Figure 11-12. For fine control (1-pixel increments), press Ctrl key and the arrow keys on the keyboard.

   - **Clone and move an image on a layer:** To create a copy of the image and move it to a layer, select the Move tool and Alt+drag a copy of the image to its new location. You can also adjust color, apply affects, and anything you can do to a complete image in Photoshop Elements. If you want to adjust color without affecting the original color, create a new adjustment layer (choose Layer ➪ New Adjustment Layer). Changes that you make to the adjustment layer affect the layers beneath the adjustment layer, but you needn’t worry about making permanent changes to the original information.

2. Make your desired changes to the layer.

3. If you want to make the changes permanent (flattening all layers into one layer), choose Layer ➪ Flatten Image.

4. Choose File ➪ Save to save your work.
Hide or Display a Layer

1. To hide a layer from your current view, open a layered image and the Layers palette. Select the layer’s name in the Layers palette to make it the active layer.

2. Click the eyeball icon to the far left of the layer name to hide the layer, as shown in Figure 11-13.

   To hide all layers except one, Alt+click the eyeball icon of the layer that you want to view.

3. To display the layer again, click where the eyeball icon was previously.

   If you hide the background layer, then any areas that show through from the background to the active layer show up as a checkerboard pattern. Customize the pattern by pressing Ctrl+K to open the Preferences dialog box and choosing Transparency from the menu. You can also customize the size and color of the squares that Elements uses to show transparent parts in this dialog box.

Delete a Layer

1. With a layered image open in Adobe Photoshop Elements and the Layers palette visible, select the layer you want to delete.

2. Drag the layer to the trash can icon near the top of the Layers palette, as shown in Figure 11-14.
Add a Text Layer to an Image

1. With an image open in Adobe Photoshop Elements, choose Layer ➪ New ➪ Layer.

   You can also Alt+click the New Layer button at the bottom of the palette to add a new layer.

2. Select the Text tool from the tool palette, as shown in Figure 11-15, and move your text block into place on the photo. Add text to a photo to create an advertisement, a poster, a photo invitation, or for many other uses.

   You can rotate the text using the text position icons on the Options bar.

3. Type the text you want to include in the picture, as shown in Figure 11-15.

   You can select the font, style, color, and size of your type from the menu bar. Unless the file is flattened, the text remains active. You can select the text with the Text tool and change any of the attributes of the images.

4. Add effects to your text if you want to spice them up. Click the arrow to open the Styles and Effects palette. Select Effects from the left drop-down list and Text Effects from the right drop-down list. In the Layers palette, select your text layer and apply the chosen effect. Figure 11-16 demonstrates the Medium Outline effect.

   Figure 11-15: Type text on a new layer added to the image

   Figure 11-16: Apply effects to the text (Medium Outline effect shown)
Move Image Elements to a New Photo

1. With the first image open in Adobe Photoshop Elements, select the person or object you wish to move to the second image using one of the selection tools, such as the Marquee or Magic Wand, as shown in Figure 11-17.

2. Choose Layer➪New➪Layer Via Cut from the menu bar. The section becomes a new and independent layer. The new image is assigned to Layer 1, and the original image is assigned to the Background layer.

3. Select Layer 1 in the Layers palette to make it the active layer.

4. Choose Select➪All.

5. Choose Edit➪Copy.

6. Open the photo that you want to use as the background.

7. Select the second image and choose Edit➪Paste. The object from the first photo is added to a new Layer 3, as shown in Figure 11-18.

8. Choose Window➪Layers and select Layer 3, the new object layer from the Layers palette.

9. Adjust the location and size of the object until it fits the place on the new image.

10. Choose Window➪Layers and select the Background layer from the Layers palette. The original Background layer is on the bottom and the new object layer is on top.

Paint on an Image

1. With an image open in Adobe Photoshop Elements, select the Color Selector tool in the toolbox to open the Color Picker dialog box, as shown in Figure 11-19.

   Painting on an image with digital brushes and other tools is primary to touching up and editing photographs with Elements. Be sure to experiment with all the tools to discover their uses.

2. Click within the Color Picker’s foreground color box to select a paint color.

   Drag the vertical slider on the color bar to the right of the color palette to select a color family for the palette (see the highlight in Figure 11-19). You can select a color to paint with from the photograph by selecting the Eyedropper tool and selecting on a color.

3. Click OK.

4. Select the Paintbrush tool, as shown in Figure 11-20.

5. Use the Brush tool to paint an area with the selected color.

   The other paint tools work in similar ways to the Brush tool. The Fill tool floods a color into a selected area of the photo. This is great for filling broad areas. I could have masked or moved to a layer and filled the background instead of brushed in Figure 11-20.

6. You can paint other areas or process the image with other tools or effects. See Figure 11-20 for a completed image (note that the background has been painted over).

7. Choose File→Save.
Add a Digital Frame to a Photo

1. This simple feature of Photoshop Elements can give the finishing touch to photos to be shared with friends. With an image open in Adobe Photoshop Elements, click the arrow to open the Styles and Effects palette. Select Frames in the right drop-down list. Select the frame you want to apply to your photo. Figure 11-21 displays the Wild Frame.

   The tattered and torn edge frames work better with smaller photos where the effect shows up better. The larger the image size the less detailed these edges appear. These effects are great for Web pages in particular.

2. Choose File ➪ Save.

Add a Background Element from Another Photo

1. With an image open in Adobe Photoshop Elements, select a portion of the back of the images using one of the selection tools, such as the Rectangular Marquee or the Magic Wand tool.

2. Choose Layer ➪ New ➪ Layer Via Cut from the menu bar. The selection becomes a new and independent layer.

   The new image is assigned to Layer 1, and the original image is assigned to the Background layer. You can modify, delete, or transform these layers without any change to the original layer.

3. Open a photo that contains the element that you want to replace the selection with; a replacement sky is shown in Figure 11-22.

Figure 11-21: A frame adds panache

Figure 11-22: A bright, beautiful sky
4. Select the portion of the new image that you want to transfer to your image.

5. Choose Edit ➪ Copy.

6. Select the first image and choose Edit ➪ Paste. The new sky is added to a new Layer 3, as shown in Figure 11-23.

   To adjust the colors of the new image, choose Window ➪ Layers and select the layer containing the new sky layer from the Layers palette. Choose Enhance ➪ Adjust Color ➪ Hue/Saturation. By adjusting the hue, saturation, and lightness sliders, I was able to make my new sky dramatic and appropriate.

7. Choose Window ➪ Layers and then select the Background layer in the Layers palette to make it the active layer. The original Background layer (which becomes Layer 0 after cutting the sky) is on top and the new sky layer is the next layer down, as shown in Figure 11-24.

8. After making all your adjustments to the merged image, choose Layer ➪ Flatten Image.

   You should not flatten the image if you intend to continue to work on it later. The Flatten command combines all the layers into a single layer. A flattened image is best for sharing your photo via e-mail or Internet. You may choose to keep the layered image for later changes but save the flattened image using a different name for sharing.

Part III
Keeping and Sharing Your Photos

The 5th Wave
By Rich Tennant

"I found these two in the multimedia lab morphing faculty members into farm animals."
Chapter 12: Choosing and Using a Printer .............133

Choose a Printer Type ...........................................134
Evaluate Printer Resolution ..................................134
Evaluate Printer Speed .......................................135
Evaluate Other Printer Features .........................135
Set Printer Options ...........................................136
Choose Print Media ...........................................138
Evaluate the Cost of Printing Photos ..................138
Print from a Memory Card ....................................139
Print from a Digital Camera Using PictBridge ....140
Use Online Photo Printing Services ....................141
Use In-Store Photo Printing Services ....................142

Chapter 13: Organizing and Sharing Photos ..........143

Import Photos into Photoshop Album .................144
Organize Photos with Photoshop Album ..............145
Categorize Photos with Tags ................................146
Search for Photos Bearing Particular Tags ..........147
Rename a Group of Photos at the Same Time ....147
Make a Digital Slideshow ....................................148
Create a Photo Album ........................................150
Create a Greeting Card ......................................150
Burn a Video CD ..............................................151
Share Photos via E-Mail ......................................152
Choosing and Using a Printer

Digital photography is great for posting photos to the Internet and e-mailing photos around. But most digital photography enthusiasts also want to print hard copies of their photos. That’s where printers enter the equation.

Figuring out how successful a particular printer is in delivering a high-quality photo print is mostly a function of the printer’s resolution. Printer resolution refers to the number of dots that are transferred to the paper during the printing process. If you’re printing 8-megapixel photos directly to large format paper, you need a high resolution printer to get the best results. Typical snapshot prints from consumer grade digital cameras don’t require such high resolutions for good quality prints.

Resolution isn’t the whole story, however, because the way that printers transfer ink to the page is also important. Although dye sublimation and thermal wax printers produce results around 300 dots per inch (dpi), the output of dye sublimation printers is generally superior to ink jet printers.

You can print directly from your camera using a USB cable, by plugging your camera’s memory card into the printer, or you can transfer your photos to your computer and print from your photo editing or viewing software. You can also use printing services available at local retailers or on the Internet. You find out how to use all the basics methods of printing in this chapter.
## Choose a Printer Type

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>Advantages</th>
<th>Disadvantages</th>
<th>Printer Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portable Ink Jet Printer</td>
<td>Portable size</td>
<td>Output not waterproof</td>
<td>$300–$500</td>
</tr>
<tr>
<td>Desktop Ink Jet Photo Printer</td>
<td>Handles halftones and shades better than a regular ink jet printer</td>
<td>Output not waterproof</td>
<td>$80–450</td>
</tr>
<tr>
<td>Portable Dye Sublimation</td>
<td>Print snapshots on the go</td>
<td>High cost per print; small print size (4×6 max)</td>
<td>$200–$400</td>
</tr>
<tr>
<td>Dye Sublimation</td>
<td>Prints water-resistant, solid-color images</td>
<td>Slow print speed; high cost per print</td>
<td>$400–$800</td>
</tr>
<tr>
<td>Color Laser</td>
<td>Low cost per print; high durability</td>
<td>Prints at lower dpi than ink jet; high cost of unit</td>
<td>$1,000–$5,000</td>
</tr>
</tbody>
</table>

## Evaluate Printer Resolution

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>Photo Quality Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Jet</td>
<td>2400 to 4800 dpi or higher</td>
</tr>
<tr>
<td>Dye Sublimation</td>
<td>300 to 310 dpi or higher</td>
</tr>
<tr>
<td>Color Laser</td>
<td>2400 dpi or higher</td>
</tr>
</tbody>
</table>
Evaluate Printer Speed

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>A Fast Printer Prints</th>
<th>A Slow Printer Prints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Jet</td>
<td>16 color pages per minute</td>
<td>4 color pages per minute</td>
</tr>
<tr>
<td>Dye Sublimation</td>
<td>1 color page per minute</td>
<td>1 color page per 2.5 minutes</td>
</tr>
<tr>
<td>Color Laser</td>
<td>8 color pages per minute</td>
<td>1 color page per minute</td>
</tr>
</tbody>
</table>

Evaluate Other Printer Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge compatibility</td>
<td>Allows you to print photos directly from the camera without connecting to the PC.</td>
</tr>
<tr>
<td>PIM (Print Image Matching) compatibility</td>
<td>Allows the camera to store and transmit color-matching information that equate to more life-like color printouts.</td>
</tr>
<tr>
<td>EXIF 2.2</td>
<td>Allows the camera to embed information about shooting conditions that the printer interprets and automatically adjusts for under/overexposure and similar problems.</td>
</tr>
<tr>
<td>Direct Print</td>
<td>Allows camera to print from a variety of memory cards plugged directly into the printer.</td>
</tr>
<tr>
<td>LCD Display</td>
<td>Allows you to preview the image or images for selection.</td>
</tr>
</tbody>
</table>

When comparing printers for purchase, check the price of paper, inks, and other consumables for each printer. Sometimes, the cheapest printer to purchase may not be the cheapest to operate.

Figure 12-3: Ink jet printers are hares; dye sublimation printers are tortoises.

Figure 12-4: Color laser printers produce crisp results at a decent speed.
Set Printer Options

1. With a directory containing pictures open in My Computer, click the Print Pictures link in the Picture Tasks menu.
2. Click Next to open the Picture Selection window.
3. Select the photo to print by clicking the small box in the upper right of the picture icon of the photo.
4. Click Next to open the Printing Options window, as shown in Figure 12-5.
5. Select the printer you want to use from the What Printer Do You Want to Use pull-down menu.
6. Click the Printing Preferences button. The Properties window for your printer opens, as shown in Figure 12-6. Three tabs are in this dialog box: Main, Page Layout, and Maintenance. The Main Menu options are:
   - **Quality Type**: Selects the print quality appropriate for your image.
   - **Paper Options**: Selects the size and type of paper you place in your printer for this print session.
   - **Print Options**: Selects the order of printing for multipage printing or Photo Enhance if that option is available on your printer.
   - **Ink Levels**: Shows you how much ink you have left in your cartridges.
   - **Orientation**: Choose to print in landscape or portrait mode.
Your printer may have slightly different options from the Epson Photo 825 I use. Refer to your printer manual or online help for assistance where there are differences.

7. Choose the appropriate Main options, and then select the Page Layout tab. The Page Layout options are (as shown in Figure 12-7)

- **More Options**: Change the way the image is printed or oriented on the paper.
- **Reduce/Enlarge Document**: Change the size of the printed image by selecting a different paper size or by scaling it by a specific percentage.
- **Copies**: Select the number of copies to print.
- **Multi-Page**: Customize multi-page printing. You don’t need to use this option when printing photos.
- **Watermark**: You can add a watermark to a printed page with a specific message. Use this option when printing text only; it doesn’t work well with photos.

8. Make your choices on the Page Layout tab.

9. Select the Maintenance tab. Test and set up your specific printer with this tab (as shown in Figure 12-8). It varies from printer to printer. Refer to your printer’s manual or online help for specific instructions.

10. After you finish making any print option changes, click OK.
Choose Print Media

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>What It’s Good For</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard copy paper</td>
<td>Text, reports containing inserted images</td>
</tr>
<tr>
<td>Ink jet paper</td>
<td>Minimizes ink jet smearing</td>
</tr>
<tr>
<td>Glossy photographic quality paper</td>
<td>Photo printing for quality ink jet and laser printing similar to photographic quality</td>
</tr>
<tr>
<td>Matte paper</td>
<td>Photo printing for matted images</td>
</tr>
<tr>
<td>Dye sublimation paper</td>
<td>Print glossy, durable photos</td>
</tr>
<tr>
<td>Transparency film</td>
<td>Plastic sheets used with overhead projectors and as report covers</td>
</tr>
<tr>
<td>Special cards</td>
<td>Business, wedding, greeting, invitation, and other cards available for printing photos</td>
</tr>
</tbody>
</table>

Evaluate the Cost of Printing Photos

<table>
<thead>
<tr>
<th>Printer Mfg</th>
<th>Ink Cost</th>
<th>Paper Cost (4x6)</th>
<th>Typical Cost per Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP</td>
<td>$0.41</td>
<td>$0.35</td>
<td>$0.76</td>
</tr>
<tr>
<td>Epson</td>
<td>$0.33</td>
<td>$0.35</td>
<td>$0.68</td>
</tr>
<tr>
<td>Canon</td>
<td>$0.29</td>
<td>$0.35</td>
<td>$0.64</td>
</tr>
</tbody>
</table>

When buying paper you can choose either generic or branded paper. Printer manufacturers have their own brands tested to work with their line of inks and print mechanisms. They will try to persuade you that their branded product is best, and it may be. On the other hand, many generic paper brands are high quality and may be much cheaper. The best way to find out which is best is to experiment with a variety of paper types and brands. The paper that gives you the results you like is the best paper. Figure 12-9 shows a selection of paper types.

The real expense of a color printer may not be in the initial price, but in the cost of replacement ink and toner cartridges. If you do much color printing, you use LOTS of ink! Ink and toner cartridges vary widely in both cost and lifetime. Paying more for the printer may be more cost effective in the long run, if the inks and toner cartridges last longer or are less expensive. Researching these costs beforehand is wise.
Print from a Memory Card

1. Insert your memory card into the card slot in your computer or in the printer attached to your computer, as shown in Figure 12-10.

2. Open My Computer in Windows (choose Start ➪ My Computer in Windows XP).

3. Select the drive identified as the memory card slot.

4. With the memory card open to the DCIM folder, open the appropriate folder. The photos on your memory card display just as if they were on a directory on your hard drive.

   If you don’t have a memory card slot on your computer or printer, you can also upload your pictures by connecting your camera to the computer and accessing the memory card from your computer according to the manufacturer’s instructions. Card readers are reasonable in price and both simplify and speed up the process of uploading images.

5. Select the image you wish to print. It displays at the top of the screen.

6. Right-click the image and choose Print from the pop-up menu. The Photo Printing Wizard opens (see Figure 12-11); click Next.

7. To print your photograph, click Next.
Print from a Digital Camera Using PictBridge

1. Plug your digital camera’s PictBridge cable into your PictBridge printer, as shown in Figure 12-12. PictBridge is an industry standard technology designed to allow printing directly from a camera without a computer or external software. To use PictBridge, both your printer and camera must be equipped with PictBridge.

2. Turn your camera’s power on. PictBridge devices all include a camera-to-printer connection, single-image printing, and a uniform message system for errors and other information. In addition, some devices include more advanced features including multiple-image printing, choice of quantity and size, and more.

3. Choose the commands and features from the LCD screen or camera viewfinder, as shown in Figure 12-13. Advanced commands might include
   • Multiple image printing
   • Print the image index
   • Print all the images
   • Print a part of the image by choosing a clip area
   • Multiple copies of a single image
   • Print images with a date stamp

4. The printer sends a message back to the camera’s LCD or viewfinder when the job is complete or if it finds any errors.
Use Online Photo Printing Services

1. Find and compare online digital photo processing services by pointing your browser to http://dir.yahoo.com and clicking Business and Economy Shopping and Services Photography Digital Labs. Yahoo! provides major categories by most popular and alphabetical. The Most Popular sites list provides the sites most clicked through by Yahoo! users, and Yahoo! updates the list on an ongoing basis. The Most Popular sites list makes a pretty good place to start your search.

2. Fill out the sign-up form with the online service.

3. Upload your images to the online service. Most services provide three ways to upload images:
   - **One-by-one**: Upload pictures one at a time at the services Web site by clicking an Add Pictures or Upload button.
   - **Using a browser plug-in**: Many services provide a Web browser plug-in that allows you to upload many pictures at the same time.
   - **Using the service’s software**: Most services provide a proprietary software solution for uploading and purchasing prints.

4. Edit your photos as necessary (most of the services provide tools for the most usual needs, such as cropping, removing red eye, color balancing, rotating, and so on).

5. Choose the sizes for the prints you wish.

6. Check out and pay. Your photos usually arrive at your front door in around a week.

Online photo processing is a great service when you’re on vacation. You can have the photos waiting for you in your mailbox when you return home. It is also a great service when you need a large number of images or multiple copies printed. It can also save you the cost and trouble of owning and maintaining a photo printer of your own.

The Photo Print Wizard provides the option to print using online services. Naturally, the photo service choices that you’re presented with are the ones that have paid Microsoft for advertising (see Figure 12-14). These may not be the best choices for your needs or budget. If you like the service choices, however, this is a simple way to access vendors and complete the print ordering process.

Figure 12-14: Microsoft’s Online Print Service Wizard
Use In-Store Photo Printing Services

1. Take the memory card from your digital camera to a local retail store that offers digital printing. (You can also drop off a CD or floppy disk.)

Most in-store film processing services now offer digital photo printing. Some stores now offer kiosks, as shown in Figure 12-15, designed for self-service digital photo printing. The quality of the prints is usually much better than home-printed photos, particularly if you don’t have a high-quality printer or time to set one up properly. These services are easy to use.

2. If you use a photo service, leave your digital picture memory card with the operators just like a roll of film for processing. Come back later for your professionally printed pictures.

You may consider buying an extra memory card for your camera just to take photos to the printing service. If you transferred your photos from the cards to your computer, you can select the ones you wish to print and copy those back to the extra memory card. Doing so allows you to continue using your camera while the photos are being processed.

3. If you choose to use a self-service kiosk, follow the instruction on the kiosk or ask assistance from the store customer service staff.

In-store kiosks can be a great convenience and timesaver. Although they don’t provide the hands-on opportunity for fine-tuning that you can achieve in your editing package, many in-store kiosks provide color balance, red eye removal, brightness, contrast, cropping, enlarging, and other features prior to printing out your pictures. If you’re away from home and you don’t travel with your laptop and printer (and many of us don’t), using an in-store kiosk can enable you to print out a good set of pictures while on vacation or any other time you don’t want to edit your prints yourself. Many services also allow you to store your photos on a CD at a modest cost.
Photoshop Album is a popular package used by amateur photographers to manage, print, and share their photos. Photoshop Album is an inexpensive and powerful choice for the amateur photographer to use as a central control panel for digital photography activity. The program provides one-stop shopping for the most popular photo management functions, everything from storing photos to e-mailing them. Album even links to a selection of editing software packages, such as Adobe Photoshop, that you might have installed on your computer, and then allows you to click once on a picture and launch the editing package with the picture preloaded.

This chapter covers the basics of Photoshop Album, including using a number of its project-oriented wizards. Many other wizards and tools are available from the Adobe Web site, www.adobe.com, as well as from third-party vendors and freeware from other users on the Internet. Album can be useful even to more advanced photographers for quick fixes and for last-minute small projects, such as a greeting card, without the complications of more sophisticated software.

The point of digital photography for the amateur is enjoyment. Photoshop Album and similar software programs can simplify tasks and let the user focus on the fun. To find out more about Photoshop Album, check out Photoshop Album For Dummies, by Barbara Obermeier.

Get ready to . . .

➟ Import Photos into Photoshop Album........144
➟ Organize Photos with Photoshop Album....145
➟ Categorize Photos with Tags ..............146
➟ Search for Photos Bearing Particular Tags ........................................................147
➟ Rename a Group of Photos at the Same Time ..............................................147
➟ Make a Digital Slideshow ..................148
➟ Create a Photo Album .................150
➟ Create a Greeting Card .............150
➟ Burn a Video CD ...........................151
➟ Share Photos via E-Mail..................152
Import Photos into Photoshop Album

1. In Photoshop Album, decide on the method you want to use to import photos. Your choices are
   - **Navigate to a particular folder**: Navigate to a folder that contains photos you want to import by choosing `File` ➤ `Get Photos` ➤ `From Files and Folders` (see Figure 13-1).
   - **Drag and drop**: Drag images from your desktop, Windows Explorer, or an image editing program into Photoshop Album.
   - **Search for files on your hard drive**: Search your hard drive by choosing `File` ➤ `Get Photos` ➤ `By Searching`, and then clicking the Search button.

   If you’re just getting started with Photoshop Album, I suggest that you try the search option first. It’s the simplest way to import a large number of photos into the program in a short amount of time.

   - **From a camera or card reader**: Import photos from your camera or a memory card in one fell swoop by choosing `File` ➤ `Get Photos` ➤ `From a Camera or Card Reader`.

2. Execute the appropriate menu command to import your photos. A dialog box with photo files opens, as shown in Figure 13-2.

3. Select the particular photos that you want to import.

   - **Ctrl+A** selects all photos. **Ctrl+click** photos to select some photos but not others.

4. Click the Get Photos button. The photos appear in Photoshop Album’s Photo Well, ready for you to work with them.

---

**Figure 13-1**: Ready to import photos into Photoshop Album

**Figure 13-2**: The dialog box showing photos to import
Organize Photos with Photoshop Album

1. To view your photos in a particular way in Adobe Photoshop Album, choose View ➪ Arrangement as shown in Figure 13-3. You can sort your photos by the following criteria:

   - **Date (Newest First):** The photo you most recently took shows up in the upper-left corner of the Photo Well.
   - **Date (Oldest First):** The photo you most recently took shows up in the bottom-right corner of the Photo Well.
   - **Import Batch:** Sorts the photos with other photos collected from the same folder. Use this option if you already have a good organizational scheme at work.
   - **Folder Location:** If you use a rigorous filing system on your computer, then you may have good luck using the Folder Location criterion to sort.
   - **Color Similarity:** If you’re looking for a particular photo that was taken at night, for example, choosing this option makes it easier to find photos of this type.
   - **Collection Order:** Places the pictures in the same order that you have them.

2. Select the method that you want to sort your images. Photoshop Album displays your photos based on the criterion you choose, as shown in Figure 13-4.

Another great way to view your photos is by using the timeline, as highlighted in Figure 13-4. To find photos taken within a particular time period on the timeline, drag the double arrows on either side of the timeline inward. You can also use the month-finder window to display photos taken during a particular month.
Categorize Photos with Tags

1. To attach a tag to a photo in Photoshop Album (and make it easier to find the photo later), display the Tags pane by clicking the Organize button (or choosing View ➪ Tags), as shown in Figure 13-5.

2. Select the photo(s) that you want to attach a tag to.

3. Right-click and choose Attach Tag and navigate to the tag that you want to attach, as shown in Figure 13-6. An icon representing the selected tag appears in the corner of the photo. You can’t delete the default tag choices (but you can add your own). Your choices are
   - **Favorites:** Photos that you access frequently.
   - **Hidden:** Photos that you don’t want to show up in the Photo Well unless you specifically tell them to.
   - **People:** A good tag to put on shots with people (or perhaps your pets) in them.
   - **Places:** Highlight vacation trips to particular spots.
   - **Events:** Birthdays, Christmas, and other events.
   - **Other:** When it just doesn’t fit anywhere else.

You can create tag subcategories as well by choosing Tags ➪ New subcategory, typing a name, and choosing the category to place the new subcategory in. It’s especially helpful to have particular name or “family” subcategories within the People category, for example, in case you want to look at every picture of your baby or grandbaby (and why wouldn’t you?).

To remove a tag from a photo, right-click the tag in the photo and choose Remove Tag from the pop-up menu that appears. Removing a tag merely removes it from a particular picture; deleting a tag, however, completely removes the tag from Photoshop Album and from every picture in it.
Search for Photos Bearing Particular Tags

1. To show only photos that bear particular tags, ensure that the Tags pane is visible (if not, click the Organize tab).

2. In the Tags pane, click the arrows of the category that houses the subcategory tag you’re interested in, if necessary, to expand the category.

3. Select each tag category that you want to view. Only photos bearing that particular tag are visible in the Photo Well, as shown in Figure 13-7.

4. Repeat Steps 2 and 3 for other tags to further refine the results of your search.

Rename a Group of Photos at the Same Time

1. To batch rename a group of photos, select the photos you want to rename in the Photo Well.

2. Choose File ➪ Rename.

3. Type a name into the Common Base Name box, as shown in Figure 13-8.

4. Click OK. The photos are renamed using the common base name and a number, such as digital photo-01, digital photo-02, and so on.
Make a Digital Slideshow

1. Choose Slideshow ➪ Creations ➪ Album to summon the Slideshow Creation Wizard, as shown in Figure 13-9. The slideshow menu button is located on the tool menu below the menu bar at the top of the screen.

You can include video clips in a slideshow. The video prints the first frame of the video if you choose to print the slideshow on paper.

2. Select the slideshow style you want to create (refer to Figure 13-9) and click Next.

Photoshop Album comes with a number of attractive slideshow types. Click each style to view the example on the right-hand side to make your decision.

3. Choose the layout of your slideshow in Step 3 of the wizard and then click Next. Enter the following information, as shown in Figure 13-10:

- Type the information you want to appear on the title and subsequent pages of your slideshow.
- Select the number of slides to show per page and whether you want captions to show.
- Select any music and transition options you desire.

The Transition options are the type of dissolve, fade, or other effect you want to use to move from one slide to the next. You can attach any music file on your computer (for example, a track downloaded as an MP3 file or taken from your favorite CD).
4. Select the photos you want to include in your slideshow and arrange them in the proper order, and click Next.

5. Preview your slideshow, as shown in Figure 13-11. Keep clicking Next until you reach the end of the preview.

6. Choose the format in which you want to publish your slideshow, as shown in Figure 13-12. The Output Options are
   - **Save as PDF**: Creates an Adobe Acrobat Reader eBook or PDF file.
   - **Print**: Prints a hardcopy of your slideshow.
   - **E-mail**: Creates a PDF file and sends your slideshow to someone by e-mail.
   - **Burn**: Burns a CD-ROM or DVD of your slideshow that plays on a DVD player attached to a TV.

   Both DVD and video CDs are viewable on a standard DVD player hooked up to a TV set. In most cases, a standard video CD is just as good as a DVD (although with less space) and you can make one on a CD burner even if you don’t have DVD burning capability.

   - **Order Online**: Orders a printed version from an online printing service.

7. After you publish your slideshow, click the Done button.
Create a Photo Album

2. Select the album style you want to create and click Next.
3. Type the information you want to appear on the title and subsequent pages, as shown in Figure 13-13, and click Next.
4. Pick the photos you want to include and click Next.
5. Review the album in the Preview window. Click Next.
6. Choose the format in which you wish to publish your album.
7. After you publish your album, click the Done button.

Create a Greeting Card

2. Select the greeting card style you want to create, as shown in Figure 13-14, and click Next.
3. Type the title, greeting, and message you want to include in your card and click Next.
4. Pick the photo you want to display on the cover of your greeting card and click Next.
5. Review the greeting card in the Preview window and then click Next.
6. Click the Print button from Output Options and follow the printing instructions for your printer.
7. Click the Done button to finish.
Burn a Video CD

1. With a folder of images open in Adobe Photoshop Album, select the images you wish to add to a gallery.

   A video CD is the standard format that plays in most DVD players attached to a TV set. This type of CD makes sharing slideshows of your photo with friends and family easy.

2. Choose Creations $\rightarrow$ Video CD. The Video CD Creation Wizard opens.

3. Select the video CD style you want to create and click Next.

4. Type the information you want to appear for the title, choose music, transitions, and other options, as shown in Figure 13-15, and click Next.

5. Select the photos you want to include in your video CD and click Next.

6. Review the video CD show and then click Next.

7. Click the Burn button from Output Options.

8. Insert a blank CD in your CD drive and click OK. The Burn dialog box appears, as shown in Figure 13-16.

9. Select the destination drive, the video format, the drive speed, and click OK. The burn process begins.

   U.S. video playback is NTSC. Europe and most of the rest of the world uses PAL. Select according to the video playback you need.

10. After the burn process is complete, click OK to finish.

11. Click the Done button to eject the video CD.

Figure 13-15: The Set Up Your Video CD window

Figure 13-16: Burning a video CD
Share Photos via E-Mail

1. With a folder of images open in Adobe Photoshop Album, select the image you want to e-mail and then choose Share ➪ E-Mail to open the Attach Selected Items to E-Mail dialog box, as shown in Figure 13-17.
2. Review the photo or photos you selected to attach to your e-mail.
3. Choose the recipients you wish to receive the e-mail in the Select Recipients box.
4. Choose the file type or attachments you wish to include in the Choose File Type box.
5. Select the size and quality of the photo you’re sending.
6. Click the OK button to send the e-mail. The Send window for your e-mail client opens.
7. Add a message and send the e-mail from your computer, as shown in Figure 13-18.

The e-mail client you use determines the specific steps to add a message and send your message. I used Microsoft Outlook for Figure 13-18.
Part IV
Special Projects

The 5th Wave
By Rich Tennant

"Remember, your Elvis should appear bald and slightly hunched. Nice Big Foot, Brad. Keep your two-headed animals in the shadows and your alien spacecraft crisp and defined."

TEAM LINQ - LIVE, INFORMATIVE, NON-COST AND GENUINE!
### Chapter 14: Taking Close-Up Photos for eBay
- Set Up the Camera for a Close-Up
- Set Up Lighting for the Item
- Use a Copy Stand to Support the Camera
- Set Up and Shoot
- Shoot Particular Item Types
- Upload Your Photos to eBay
- Host eBay Pictures at a Hosting Service

### Chapter 15: Restoring Old Photos
- Scan a Photo
- Crop the Image
- Adjust Photo Color
- Remove Scratches and Specks
- Remove Spots and Damaged Areas
- Touch-Up with the Airbrush Tool
- Archive Printed Photos

### Chapter 16: Documenting Your Travels
- Research and Plan Your Photo Shoots
- Gear Up for the Trip
- Tell the Story
- Include People and Pets in Your Photos
- Take Creative Travel Pictures
- Edit Photos on the Road
- E-Mail Photos from the Road
- Create a Photo Travel Blog

### Chapter 17: Creative Mini-Projects
- Plan a Wedding Shoot
- Make a Wedding Announcement
- Plan a Digital Family Album
- Make a Digital Family Album
- Make an Insurance Inventory
- Make a Photo T-Shirt
- Set a Digital Image as Your Wallpaper
- Create an Organization Photo Directory
- Show Photos on Your TV
- Make a Mini-Movie Clip
- Record Sound Notes
Taking Close-Up Photos for eBay

A picture’s worth a thousand words. That may be a cliché, but it’s true — especially when it comes to information about an item for sale. Bidders on eBay make their decisions about whether to bid and how much to bid on an item based on a relatively small amount of information. The single most important part of this information — possibly more important than the price — is the picture. Studies show that when identical items are listed for sale on eBay by different sellers, the items with the best pictures sell for a higher price.

Sellers often place a small picture of the item for sale on the opening page of the list of similar items and a larger picture on the information page attached to their item. The buyer sees a small picture immediately upon looking through the list of goodies for sale. Many sellers don’t post a picture on this opening screen, reserving their pictures for the second, detailed information page. This is a mistake! Serious buyers on eBay (and they are legion!) resent having to click through to a description page to find out if the item is something they’re interested in or not. A good picture on the opening list page positively encourages potential buyers to select the item for a closer look and more information.

The ease of taking good quality pictures with a digital camera means you can take and post excellent pictures on eBay, increasing the price you expect to receive when your item sells. Ka-ching!
Set Up the Camera for a Close-Up

1. Set your camera to its most manual setting. Ideally, you want control over aperture, shutter speed, and exposure value.

   Setting up the camera for a close-up is critical. This is one case where automatic settings can work against you. Manual settings provide the most control for setting up close-up photos.

2. Adjust the Aperture setting to increase or decrease depth of field. For eBay pictures, you want the depth of field only as deep as the picture. The background should ideally be out of focus to concentrate attention on the item for sale.

   Aperture refers to the iris — the adjustable opening behind the lens that regulates the amount of light that enters the camera to create the digital picture. The aperture size is expressed as f-stops (f16, f8, f4, f2, and so on). As the f-stop numbers get smaller, the iris lets in twice as much light as the next larger f-stop, which increases the depth of field and brings the background into focus. A larger f-stop setting results in reduced depth of field, which blurs the background. Compare Figures 14-1 and 14-2 for an example of reduced and increased depth of field.

3. Adjust the shutter speed, if necessary.

   Shutter speed determines the length of time the shutter remains open and allows light to enter the camera to expose the digital film. Shutter speed is expressed in fractions of a second (½th of a second, ¼th of a second, and so on). When you shoot bright subject, it requires a shorter exposure time or a faster shutter speed.

4. Adjust the exposure value, as necessary.
Set Up Lighting for the Item

1. Prepare the lighting for the object that you’re shooting. You want the lighting to eliminate shadows from the object as much as possible.

2. Distribute the light evenly. Evenly distributed lighting reduces shadows that can obscure details of the item. Some methods of distributing light are:
   - **Fluorescent lighting:** Using multiple fluorescent light sources provides good light coverage and can help to eliminate shadows. Fluorescent light, as shown in Figure 14-3, is more diffuse and less likely to reflect back into the camera than an ordinary bulb light. Aim light from as low an angle as possible to minimize reflection into the camera lens.
   - **Diffuser:** You can also devise a simple diffuser by suspending thin white muslin between the light source and the subject. If you’re using a copy stand or have a set-up shot, you might make a tent of the muslin to assure uniform diffuse light.

   ![Figure 14-3: A fluorescent close-up light](image)

   If you’re shooting outdoors, you can light the subject by reflecting sunlight onto the source using a piece of white cardboard or foam core. Have a friend give you a hand with this.

3. Use a flash to bring out the color, texture, and detail of the item.

   ![Figure 14-4: A lens-mounted ring flash is designed especially for close-ups](image)

   Keep in mind that use of a flash increases depth of field and that a camera flash can overexpose close-ups and cause impossible glare on reflective subjects. If you’re doing much close-up work and your camera allows lens attachments, see if you can get a ring flash attachment, as shown in Figure 14-4, for your camera. These are designed especially for close-up flash photography.
Use a Copy Stand to Support the Camera

1. Mount your camera on the copy stand, as shown in Figure 14-5.

   A copy stand is ideal for shooting close-ups of objects. It holds the camera steady and in the proper orientation. It also creates a uniform set-up for multiple pictures and speeds the process.

   If you don’t have or can’t borrow a copy stand, you can use your tripod turned on its side. Another option is an inexpensive tabletop tripod. You can successfully substitute a tripod for a copy stand when shooting small objects. See Figure 14-6.

2. Align the copy stand so that it’s perpendicular to the copy board (the base of the copy stand where the object is placed) and the item being photographed.

   Many copy boards have gridded backgrounds and require a cloth or paper cover to give the final background for your photo.

3. Shoot test shots and experiment until you have the distance, angle, and focus perfect.

   eBay is a great place to watch for copy stands. Copy stands with lights are usually much more expensive than stands without lights.

Figure 14-5: A copy stand with lighting arms

Figure 14-6: A tabletop tripod
Set Up and Shoot

1. Select an appropriate background for your subject.
   - Flat black or gray paper works well. If you’re photographing silver or other jewelry, blue-gray fabric or paper complements the reflections in the silver surface. Whatever you’re shooting, if you’re shooting in color, choose a complementary color for the background. Experiment and make test shots to determine the best background.

2. Set up a copy stand perpendicular to the background and image.

3. Consider the depth of field when you’re setting up. A tall vase only remains in focus for the first few inches of depth of the object nearest the camera and then blur out. A shot of an object laying on a background, or another collection of complementary objects makes a better close-up, as shown in Figure 14-7.

4. Compose a close-up shot with the subject prominently in the frame, as shown in Figure 14-8.

5. When setting up and choosing lighting, think about light and shadow. Determine whether dramatic shadows are best for the effect you’re trying to achieve, or if clarity of the details of the item, and therefore more diffuse lighting, is required.

   - Unless you have an extremely good reason to the contrary, light up your subject well and use diffuse lighting for eBay photography.

6. Ensure that the item looks its best. The eye ignores these fine details, but the camera sees and reports them all.

7. If you have an automatic camera, press the shutter button halfway to bring the shot into focus before taking the shot.
# Shoot Particular Item Types

<table>
<thead>
<tr>
<th>Type of Item</th>
<th>Tips for a Successful Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silver</td>
<td>1. Use a light-blue background to display silver to its best advantage (see Figure 14-9).</td>
</tr>
<tr>
<td></td>
<td>2. Use a piece of poster board to reflect light back on the piece, but mask the image of your hands or camera that may reflect in the surface of a silver bowl or vase.</td>
</tr>
<tr>
<td></td>
<td>3. Add small colorful accessories to pictures of silver, such as a flower, to add interesting reflections and a punch of color.</td>
</tr>
<tr>
<td></td>
<td>4. If possible, show a close-up of a maker’s identifying mark and whether the piece is plated or sterling, as shown in Figure 14-10.</td>
</tr>
<tr>
<td>Jewelry</td>
<td>1. Use black velvet backgrounds to display jewelry at its best, particularly diamonds. White or gray are also effective.</td>
</tr>
<tr>
<td></td>
<td>2. Place flat jewelry pieces directly on your scanner and scan them into your computer.</td>
</tr>
<tr>
<td></td>
<td>3. Position pieces so the most interesting part of the piece is visible. Prop up rings, for example, using a small piece of museum wax or silly putty, or cut a small slit in a piece of foam core board with a razor blade and push the band of the ring down into the slit, making the ring stand up.</td>
</tr>
<tr>
<td></td>
<td>4. Make certain photos are well lighted, and the details are clear, as shown in Figure 14-11. Good jewelry is an investment, and nobody is going to offer top dollar for something that appears fuzzy or dirty.</td>
</tr>
<tr>
<td></td>
<td>5. Sharp, close-up photos of jewelry may require use of a macro lens and a special lighting set up.</td>
</tr>
</tbody>
</table>

Figure 14-9: Photographing silver

Figure 14-10: Shoot details of your silver, such as the maker’s mark
<table>
<thead>
<tr>
<th>Type of Item</th>
<th>Tips for a Successful Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td>China or porcelain</td>
<td>1. Place china piece(s) against colored background that plays up one of the colors in the pattern.</td>
</tr>
<tr>
<td></td>
<td>2. Include a close-up of the most interesting part of the pattern, as shown in Figure 14-12.</td>
</tr>
<tr>
<td></td>
<td>3. Include a close-up of the maker’s mark.</td>
</tr>
<tr>
<td></td>
<td>4. Include close-ups of any chips or imperfections. Honesty pays.</td>
</tr>
<tr>
<td></td>
<td>5. Experiment with lighting until you get a picture with accurate color. China patterns come in hundreds of similar patterns, so it’s easy to be misled by inaccurate color.</td>
</tr>
<tr>
<td>Clothing</td>
<td>1. Whenever possible, photograph clothing on a person. Empty clothes are difficult to see clearly or to visualize.</td>
</tr>
<tr>
<td></td>
<td>2. Pose the model to show off the clothing to its best advantage (spread out full skirt and so on).</td>
</tr>
<tr>
<td></td>
<td>3. Use good lighting, outdoors if possible, as it reproduces color the most accurately.</td>
</tr>
<tr>
<td></td>
<td>4. Accessorize if it makes the garments look better, but do not clutter or obscure the sale item.</td>
</tr>
<tr>
<td></td>
<td>5. Clearly show any flaws or stains.</td>
</tr>
<tr>
<td>Furniture</td>
<td>1. Dust and/or polish items before photographing.</td>
</tr>
<tr>
<td></td>
<td>2. Place furniture against a neutral, uncluttered background, as shown in Figure 14-13.</td>
</tr>
<tr>
<td></td>
<td>3. Light picture so that the color is warm and accurate.</td>
</tr>
<tr>
<td></td>
<td>4. Include a close-up of any carving, inlay, or other details that add to beauty or value of piece.</td>
</tr>
<tr>
<td></td>
<td>5. Include an accessorizing object to indicate scale, a book or bowl for example.</td>
</tr>
</tbody>
</table>
## Type of Item | Tips for a Successful Shot
--- | ---
**Paintings and prints** | 1. If it’s your own work and it’s small enough, scanning the artwork produces the most accurate reproduction of the image, as shown in Figure 14-14. Make sure to save it as a compressed JPEG to limit the file size.

2. It’s crucial that the camera be absolutely parallel to the artwork, or you get the “keystone” effect — the parallel lines not appearing straight. Use a copy stand if possible, or a tripod and take test shots to make sure edges appear straight.

3. Watch out for reflections if the art is under glass. Remove glass if possible before shooting pictures.

**All Items** | 1. Make the image fill the picture. Too much background detracts from the interest of the image, as shown in Figure 14-14.

2. Use a tripod for steady images.

3. Take several pictures with different exposure values — −2, normal, and +2 — to ensure at least one of your shots is well-exposed.

4. Pay particular attention to the lighting. Every aspect of a close-up shot becomes more prominent, especially the lighting.

5. Use a lens attachment if your camera allows one to reduce depth of field and reduce impossible glare from reflective subjects.

6. Take a test shot and view it on the LCS and then make final adjustments.

7. Edit your photo in an image-editing program, such as Adobe Photoshop Elements, if necessary.

---

**Figure 14-13:** Shoot furniture against a neutral background

**Figure 14-14:** For best results, scan your artwork
Upload Your Photos to eBay

1. To upload photos to your auction using eBay Picture services, choose the Sell link on the eBay Navigation bar and click the Sell Your Item button to display the Sell Your Item form. Fill out this form.

2. In the Add Pictures section, choose eBay Picture Services, as shown in Figure 14-15.

   Add photos to your eBay listing in two different ways. You can host your pictures on an outside Web site or you can use eBay Picture services. With eBay Picture services, one picture without enhancements is free, but charges add up as you add features. Picture services gives you the most flexibility, but it may add unwanted cost to your auction.

   As important as a good picture, having a fast-loading auction picture is even more important. Buyers are impatient, so don’t keep them waiting!

3. The first time you use Enhanced eBay Picture services, you’re prompted to download a software utility that allows you to use eBay Picture services from your computer. Click Yes to download the eBay software utility.

4. To add pictures to your form, click one of the Add Picture buttons on the left and navigate to the picture you wish to add.

5. Click Open to add the photo.

6. Follow the Sell Your Item form’s instructions on how to crop and rotate the picture for best presentation.

7. Complete your Sell Your Item form and submit it to eBay to begin your auction or sale. Your finished page looks similar to the one shown in Figure 14-16.
Host eBay Pictures at a Hosting Service

1. Post your photo or photos according to the instructions of the hosting service you prefer.

2. Take note of the URL for the photo because you need to enter it in the eBay form.


3. In the eBay Sell Your Item form, navigate to the Add Pictures section and choose eBay Picture Services, as shown in Figure 14-17.

4. Click the Your Own Web Hosting tab at the top of the Add Pictures section of the form.

5. Enter the URL of your hosted photos in the Picture Web Address box. Your photo link is automatically added to your sell page.

   Multiple images are a good idea, particularly when a maker’s mark or pattern detail is needed. Keep file size to under 50K for fast loading.

6. Complete the Sell Your Item form and submit it to eBay to begin your auction or sale. Figure 14-18 shows a sell page with a photo.

   You can include a link in your eBay item description field to an outside Web site with more information about your items or to a Web store that offers other products.
Restoring Old Photos

Every family has them — old albums filled with black, crumbling pages and fading, sepia-toned photographs. Normally, the people shown in these photos wear big hats, high collars, and other funky styles. If you’re very lucky, names and dates are scrawled below the pictures. All these pictures have one thing in common — they represent a link between the past and the future, and such links are worth preserving for those who follow you. Unfortunately, the materials used in these albums and the jumbled trunks and boxes they’re stored in may have damaged those precious old photos. Fear not: Help is on the way.

Preserving, restoring, and conserving your collection of photos is a primary motive for many people to learn the ins and outs of digital photo-editing tools, such as Adobe Photoshop Elements and others. Keep in mind that you need to turn your old print photos into digital images before you can use these digital photo-editing tools. You can easily find and purchase a scanner to help make this transition happen. Check out Scanners For Dummies, 2nd Edition, by Mark L. Chambers, for great information on scanners. Also, turn to Chapter 5 for step-by-step instructions on the many ways to use a scanner.

This chapter guides you through the basics of digitizing and restoring damaged prints and storing and conserving both digital and film photo prints. I discuss most of these tools elsewhere in the book in other contexts, but who wants to go flipping about hither and yon when precious old photos are crying for help? This chapter provides you with one-stop shopping for your photo restoration needs: Everything from scanning in old photos to fixing fading colors to repairing fixes and tears. Here’s to history!
Scan a Photo

1. Place the photograph you want to scan on your scanner glass plate and close the cover.

   For good results, you should use at least 300 dpi and a maximum of 600 dpi for scanning, restoring, and printing photos. This is a comparable resolution for digital photographs. Experiment with various settings to see what works best for you. A problem with very high resolution scans is that they take up a lot of disk space and they require a lot of memory to edit.

2. With your scanner software open, choose Scan ➪ New Scan. The scanner creates a preview scan of your photograph.

3. When the preview scan completes, drag the dotted select window around the portion of the photo you wish to scan, as shown in Figure 15-1.

   The default output type and other file attributes display below the Preview window, as shown in Figure 15-1. You can select different settings from the menu bar or alternately from the option window. The best file type to use for editing and archiving scanned photos is TIFF, which provides you the maximum image quality and does not deteriorate when compressed.

4. Click the Accept button, as shown in Figure 15-2.

5. The finished scan is stored in the directory you selected to store your photos.
Crop the Image

1. With your image open in Adobe Photoshop Elements, select the Rectangular Marquee tool.

You need to crop the white borders from your photo because the next step adjusts the color and luminosity level. This process analyzes the images attributes (or histogram). White areas such as borders distort the software’s accuracy in making the adjustments, resulting in poor quality. If you want a border in your finished print, you can cut the restored image and paste it onto a larger white background.

2. Select the area you want to crop.

3. Select Image ➪ Crop, as shown in Figure 15-3. Photoshop Elements crops the image as you specified.


Adjust Photo Color

1. With your image open in Adobe Photoshop Elements, choose Enhance ➪ Adjust Color ➪ Adjust Hue/Saturation, as shown in Figure 15-4.

2. Adjust the Hue, Saturation, and Lightness sliders until you’re satisfied with the photo.

An alternative color adjustment process is available by choosing Enhance ➪ Adjust Color ➪ Color Variations. The resulting Color Variations dialog box gives you visual alternatives in adjusting the color attributes of the image.

3. Click the OK button to make the adjustments permanent.


Figure 15-3: Cropping a photo

Figure 15-4: Fixing the color of an old photo
**Remove Scratches and Specks**

1. To remove the scratches and specks that accumulate on old photos in Adobe Photoshop Elements, select the Rectangular Marquee tool, as shown in Figure 15-5.

   Avoid adding more specks to your scanned photo by cleaning the scanner window with an ammonia-based window cleaner before a scan session and dusting your photos with a soft brush or cloth before scanning them.

2. Drag the tool around the area that contains specks or scratches.


4. Select Preview, as shown in Figure 15-6, to preview the changes.

5. Drag the Radius slider all the way to the left to determine the size of the speck or blemish that the software removes.

6. Drag the Threshold slider all the way to the right. This slider determines how aggressive the filter is applied. If you use too much threshold, large parts of the original image might disappear.

7. Drag the Threshold slider to the left until the lines or specks are removed.

   The only way to achieve good results with this filter is to experiment until you have a good balance between dust removal and the softening effect that this filter adds to your photo. If you use too high a setting, the photo becomes artificial looking.

8. Click the OK button to make the adjustments permanent.

Remove Spots and Damaged Areas

1. With your image open in Adobe Photoshop Elements, choose View ➪ Actual Pixels to view the picture at its actual size.

   Viewing the actual pixels in the image allows you to see every element that’s present in the image. If an image displays smaller than full size, much of the image is not displayed.

2. Select the Clone Stamp tool from the toolbox, as shown in Figure 15-7. It looks like a rubber stamp.

3. Select the soft-edged brush from the Brushes menu on the Options bar, as shown in Figure 15-7.

4. Position the pointer over an undamaged area of the photo with a similar color, texture, and tone to the damaged area.

5. Alt+click to select the undamaged area as a sample.

   Keep sampling colors from the photo with the dropper tool until you get a good match for the area you’re covering. Don’t hesitate to use Edit ➪ Step Backward if you don’t like your early efforts.

6. Drag the Clone Stamp over the damaged area and paint.

   Resample areas close to the look of the blemished area to paint with as you go to assure the best match.

7. Continue until the spots and blemishes are removed, as shown in Figure 15-8.

8. Click the OK button.

Touch-Up with the Airbrush Tool

1. With an image open in Adobe Photoshop Elements, select the Color Selection box in the toolbox, as shown in Figure 15-9.

   The Airbrush tool is one of the best paint tools to use in restoring photographs. The Airbrush tool gives you a soft edge that blends with the original photo. It also adds color with a degree of transparency that looks more natural and less like a patch.

2. Select a paint color from the Color Picker.

   Drag the vertical slider on the color bar (located to the right of the color palette) to select a color family for the palette. You can select a color to paint with from the photograph by selecting the Eyedropper tool from the toolbox and clicking on a color within the photograph.

3. Click OK.

4. Select the Paintbrush tool.

5. Select the Airbrush tool from the menu to paint an area with the selected color, as shown in Figure 15-10.

   Airbrushing is a great, natural-looking way to get rid of small imperfections in a digital photo. It can erase a blemish in an old photo or a real-live blemish that can make a close-up unflattering!


Figure 15-9: Selecting a color to paint with

Figure 15-10: Airbrushing a photo
Archive Printed Photos

1. Purchase special storage boxes (shown in Figure 15-11) for your printed photos or albums from a conservation supplier or art supply store, such as Michaels. Make sure the storage boxes have the following characteristics:
   - Tight fitting lids to prevent dust and bugs from intruding.
   - Acid-free and labeled for archive use.

   Safely store loose photographs in acid-free archival-quality photo index boxes. Make sure to encase photos in acid-free frames or mats.

2. Purchase materials for photo albums, as shown in Figure 15-12. Archive-safe materials include:
   - **High-quality 3-ring binders**: These should have tight fitting binder rings and have acid free material in any area that comes into contact with photos.
   - **Acid-free, archival-quality paper**: This paper, cardboard, and other material is specially manufactured to cause no harm to paper, photographs, and other art materials.
   - **Nonreactive corner tabs**: These mounting tabs are made from acid-free archive materials and use glues that do not cause harm. They are glued to the mounting paper or leaves in such a way that they hold the four corners of the photos.
   - **Plastic sleeves**: If you want plastic covered pages, be absolutely certain they are PVC (polyvinyl chloride)-free. Most of these sleeves come with an internal acid-free cardboard mounting page to mount your photos behind the plastic. The magnetic, plastic-covered album pages available everywhere are terribly destructive to photographs.

![Figure 15-11: Archival resources](image1)

![Figure 15-12: An archive photo album](image2)
3. Place the paper in the album and attach the photos to the paper by using the nonreactive corner tabs (never glue or tape) or archive-quality mounting tape, as shown in Figure 15-13.

4. Store your photo boxes and albums in a cool, dry cabinet or closet, safe from pests and pets.

   As extreme temperature changes and humidity are destructive to photographs, avoid placing them against outside walls, and never store them in attics, basements, or garages where they are susceptible to mildew, rapid aging, and other damage.

5. If you decide to frame your photographs for display, be sure to use acid-free mats, board, tape, and other supplies. If possible, use UV resistant glass, and hang the photographs away from direct sunlight or rotate them frequently to avoid fading.

   Keeping precious photographs under glass permanently is not best; doing so can trap moisture and dust, creating a hostile environment for your photos. For permanent display, use copies rather than originals.

6. Scan your old photo collection and save your new digital photos on archive-quality CD-Rs, as shown in Figure 15-14. Make two copies and store one in a safe-deposit box to avoid fire or theft loss.
Documenting Your Travels

Vacations, vacations, vacations. Wherever and however you go, you will want to make your great memories permanent by taking great pictures. More than simply recording events, looking through a camera lens can give you a perspective that you might otherwise miss. Thinking about that little “window” on reality focuses your perception of composition. The more pictures you take, the more sensitive you become to recognizing what makes a good picture. Taking pictures trains your eye.

Doing a great series of photos is as much a function of planning as it is of pointing and shooting. If you think about what you’re going to do, what things of interest you want to take pictures of, you will be ready and you won’t miss the moment when it comes. But you also have to be prepared for the unexpected great photo op that may come along.

Most vacation pictures are ho-hum boring to those who didn’t go along, yet most of us sit through other people’s vacation pictures so they will look at ours. By adding planning to the process, and preparation to the planning, you could be the exception: coming back with a series of photographs that “tell the story,” and interest those you share them with. Ready? Round ’em up, and head ’em out!
Research and Plan Your Photo Shoots

1. Start planning your vacation photos as you plan your trip. Planning is key to making a really good vacation documentary — be it a print album, digital album, or Web site.

   If you’re planning a special photo vacation, say shooting interesting architecture, paintings, sculpture, or faces on the street, you need to plan special equipment that supports that kind of photography. A wide angle lens or lens adapter helps if you’re shooting architecture. A 35mm equivalent lens is about right without fish-eye effects. The zoom lens helps with both people shots and scenery. Take the longest zoom lens you have.

2. List the things you want photos of. If you’re going to Paris, then you naturally want pictures of the Eiffel Tower. Leave room in your plan for impromptu snapshots, but think ahead about what pictures are important in telling your story.

   The Eiffel Tower has its own official Web site that provides a wealth of information for planning photographs. The Web site is at www.tour-eiffel.fr, as shown in Figure 16-1.

3. Read about what and how to shoot photos of where you’re going. If you’re planning to photograph a particular monument, building, or museum collection, check out photo books or Web sites on the subject. They can guide you in advance with ideas and inside information that you might otherwise miss.

   Andrew Hudson, founder of PhotoSecrets, publishes guidebooks designed for travel photographers. Go to www.photosecrets.com for more information, as shown in Figure 16-2.
Gear Up for the Trip

1. Choose the right gear for your photo adventure. The key to it all is the camera you take.
   - A mid-level or prosumer camera gives you the option of shooting in RAW mode, which allows you to get dramatic effects with your editing software.
   - An ultra-compact camera as a second or backup camera is a good choice. You can slip it in your pocket when you go dancing and sneak shots when no one is looking.
   - A point-and-shoot camera is the easiest to operate and is small enough for candid shots. This is a good all-around compromise camera or second camera.

2. Plan for extra memory, and bring as much as you can afford. Depending on where you go, buying more could be tricky.

3. Pack a spare battery and make sure that your charger works on the power supply in foreign countries.

   Most hotels provide adapters for your use, but inexpensive travel power adapter kits are available in travel stores and airports, as shown in Figure 16-3. These also come in handy for other electronic gear.

4. Take a lightweight tripod or monopod with you, as shown in Figure 16-4. These are small enough to pack in your suitcase.

5. Pack extra lenses and filters if your camera uses them. Plan ahead for the type of shots you want to take at each location and bring the appropriate accessories with you.

6. Take a laptop computer if you can. You can download your photos, review your shots, organize them, store them on a CD, e-mail shots to family, and much more.
Tell the Story

1. Take shots that tell the story of your trip. Start with long lines at the airport, checking into the hotel, and so on. You don’t need to use them all in your album, but you can’t go back and add shots once you’re home.

   Think beyond snapshots. Photo records are more interesting to everyone if they tell a story. You can tell the story of the architecture or landscapes of the country you are visiting. You may be interested in showing the local faces, as shown in Figure 16-5, fashion, or folk costumes. You can always include the kids but try to catch them in action, doing something fun or interesting.

2. If you’re shooting a “theme” travelogue such as art, architecture, or doorways, as shown in Figure 16-6, here is a list of considerations:
   - **Put the subject in context.** If you’re shooting paintings in museums, make sure that you also include shots of the museum and its surroundings. It gives the art a focus.
   - **Make sure that you have balanced coverage.** For example, shoot things that you like and contrast them with things you don’t.
   - **Start at the beginning.** Tell the whole story, don’t just focus on one aspect of it.

3. Shoot mini-movie clips if you plan to make a Web site or digital album. This movie can spice up your presentation. If you plan to shoot this way, remember that movie clips take more memory.

4. Shoot everything. One of the beauties of digital photography is the ability to shoot and shoot and shoot.
Include People and Pets in Your Photos

<table>
<thead>
<tr>
<th>Use People . . .</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>For scale</td>
<td>The Eiffel tower is much more impressive if you have at least one shot with people featured. It provides a scale reference for the viewer.</td>
</tr>
<tr>
<td>For cultural context</td>
<td>If you’re in India, include shots of the people to set the location within a cultural setting. Photos of fascinating architecture are good, but photos of streets and buildings that include crowds going to work tells the additional story about living conditions in the area.</td>
</tr>
<tr>
<td>To show relationships</td>
<td>Some of the most memorable moments of a vacation are the conversations with strangers in restaurants, hotels, or trains. They may be local or fellow travelers, or pets as shown in Figure 16-7. Be sure to include them in some of your shots. On most digital cameras, you can record brief audio clips of these new friends talking. Include the clips in Web and digital albums.</td>
</tr>
<tr>
<td>To record events</td>
<td>Try to catch your fellow travelers doing something, as shown in Figure 16-8, or talking to someone. If you must pose them, try for humor instead of boring smile shots.</td>
</tr>
</tbody>
</table>

Try to include families and people of all ages. Shots of people in local costume are terrific.

Figure 16-7: A new friend at Golden Gate Park

Figure 16-8: Admiring a pot
Take Creative Travel Pictures

<table>
<thead>
<tr>
<th>Creative Effect</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use alternative compositions</td>
<td>Turn the camera on its side. Take close-ups of textures and interesting objects in a local market, as shown in Figure 16-9.</td>
</tr>
<tr>
<td>Pay attention to lighting</td>
<td>Take pictures at dawn or dusk to increase shadowing and modeling to photos of buildings, mountains, and sculpture. Sometimes you discover that bad lighting can become good lighting, as shown in Figure 16-10. Shoot the city lights popping on at dusk.</td>
</tr>
<tr>
<td>Get off the beaten path</td>
<td>You may find an interesting neighborhood just around the corner from a famous landmark. Be open for the unexpected and the unusual.</td>
</tr>
<tr>
<td>Shoot panoramas of landscapes</td>
<td>Panoramas require a steady tripod and a bit of patience. Review the technical requirements for panoramas before shooting.</td>
</tr>
<tr>
<td>Take advantage of surprises</td>
<td>Funny road signs (anyone remember Burma Shave?). Roadside “tourist traps” with alligators and snakes. An absence of gravity. The world’s largest ball of twine.</td>
</tr>
</tbody>
</table>

Keep a journal of your trip to record the context of the photos, keep the names of new friends, a poem or two about the beautiful sunset or the crowded subway train. Collect postcards, maps, menus, and other items of interest. You can scan these items when you get home and add them to the digital album or just paste them into your scrapbook along with the photos. Incorporate any or all of these items into a multimedia album or a scrapbook of your trip.
Edit Photos on the Road

1. If you don’t have a laptop computer with your favorite image-editing software on it, go to a digital photo kiosk within the city you’re visiting, as shown in Figure 16-11. Many national chain stores, including Wal-Mart and Target, now have digital photo kiosks available across the United States.

2. Insert your memory card into the kiosk. The digital photos download into the kiosk (they remain on your card until you delete them).

3. Edit the photos on the kiosk, as shown in Figure 16-12. Most kiosks provide a wide range of editing facilities, including
   • Color correction
   • Brightness and contrast correction
   • Cropping
   • Saving for the Web

4. Order prints for the photos you want. You can also order a CD that you can then take to a public-access computer for e-mailing or posting photos online.

   Downloading your images to a CD at a photo kiosk is another good and inexpensive way to clear your memory card for more photos. You don’t need to make prints at the kiosk; you can choose only to burn a CD of your photos.
E-Mail Photos from the Road

1. In Hotmail, Yahoo! Mail, or whatever Web-based mail service you use, click Compose Message.
2. Click the Attachment link.
3. Navigate to the directory containing your file and select the photo you want to send, as shown in Figure 16-13.

Load the photo you are sending by e-mail into Adobe Photoshop Elements or another photo-editing package to reduce the original size before sending. Typical Web size is 640x480 pixels.

4. Type an accompanying message and click Send.

Create a Photo Travel Blog


2. Sign up with the blog service. www.blogspot has only three steps to establish a free account and start. Be sure to set up your blog before leaving home, and e-mail family and friends the URL address so they can check it regularly.

3. Download software to help you post your images to your blog. For example, Hello Bloggerbot is available from www.hello.com/how_bloggerbot_works.php. This software automatically prepares your photos for posting to a blog and allows you to post thumbnails of your images to your blog.

4. Enable public comments in the options when you set up your blog page, so your friends can comment on your postings. See Figure 16-14 for a blog example.
Creative Mini-Projects

Finding how cameras and editing software work can be fun. Well, some people think it can be fun. The real fun is in using these tools to create projects that communicate, excite, move, tell stories, solve problems, and more. This chapter adds a few additional tricks for you to consider, as well as a number of creative projects to impress your friends and family with your expertise and creativity.

Interesting ideas range from shooting a wedding to making a photo directory for your church, school, business, or organization. The Internet can also be a source of project ideas and solutions to your technical problems. Visit the Web sites of your camera or printer’s manufacturer. Sony (www.sony.com) and Hewlett Packard (www.hp.com) have great sites with project ideas, technical solutions, and lots of free stuff. Adobe (www.adobe.com) and Microsoft (www.microsoft.com) also have great sites with project ideas, training, and downloads. Have fun!
Plan a Wedding Shoot

1. Make a list of candid shots that you want to take at a wedding. The list can be in a notebook, or on your computer, but you want to have a copy of it with you for quick reference during several phases of the project.

Candid shots taken by family and friends at a wedding are invaluable, even if a professional photographer is taking the major number of pictures. Unlike the copyrighted pro shots, you can post these photos on Web sites, publish them in newsletters, and share them with everyone in the family. Make a list of the important moments you want to capture at the wedding and plan accordingly.

Some examples of candid shots to consider are

- Bride arriving at the site of the wedding
- Groom and attendants waiting for the bride
- Bride coming down the aisle
- The exchange of rings
- The kiss
- Mr. and Mrs., as shown in Figure 17-1
- Bride and groom dancing at reception, as shown in Figure 17-2
- That first bite of wedding cake, as shown in Figure 17-3
- Bride and groom leaving reception

Professional photographers are experts at finding good vantage points from which to take pictures. They also set up photo situations at weddings. Take advantage of this fact and stand nearby. The pro may not smile, but probably won’t object; just don’t get into his or her way.
2. Visit the site of the wedding, and take some pictures in advance of the wedding. These reference shots are an invaluable reminder of the advantages and limitations of the site in creating your list of proposed pictures.

   If the wedding is to be outdoors, be sure to check the fallback indoor facilities nearby. Rain, like life, sometimes happens while you make other plans.

3. If the wedding is held in a church, be sure to talk to the clergy about picture taking. Some churches and clergy have a “no photographs” policy (particularly with flash) during a religious service.

4. If the church allows photographs, be sure to find the best, unobtrusive places to stand in advance. This avoids running around during the service; something no one thanks you for.

   Never get between the wedding party and the guests, particularly the parents of the bride and groom, except for the briefest of moments. They are there to see the kids get married, not the back of the photographer. And don’t forget the preacher, as shown in Figure 17-4!

5. Pack carefully.

   Be sure to take along plenty of memory cards (or your particular storage media) to avoid worrying about running out of memory with the best shots yet to come. Also take plenty of batteries and be as conservative with the camera’s power as you can to avoid running out. See Chapter 2 for the steps to take to conserve your battery’s power and to replace your memory card. Chapter 1 helps you determine your memory needs.

6. Take along a manila envelope or other container, clearly marked, to store the memory cards containing the wedding pictures until you move them to more permanent storage. Nothing is worse than losing the cards among others for the next twelve years, by which time nobody cares.
Make a Wedding Announcement

2. Choose File ➪ Page Setup and enter the size of paper you want to print your announcement on. Figure 17-5 shows 4.25” × 5.5”.
3. Choose Insert ➪ Picture ➪ From File and select a photo to use in the invitation.
   Choose a picture of the bride and groom from one of the big moments of the wedding, for example the kiss or cutting the cake. Make sure it is a reasonably close shot and clearly shows off their wedding finery and happy faces without too much background.
4. Add appropriate text to your announcement, as shown in Figure 17-6.
   Microsoft provides Word and Publisher templates for many occasions on its Web site that you can adapt for your own needs. Point your browser to http://office.microsoft.com and search for invitation to get started with the right fonts.
5. Choose File ➪ Save to open the Save As dialog box.
6. Type a name for your file in the File Name box.
7. Click the Save button to save your file.
   Use good quality 65-pound card stock or photo paper for your announcement. You can buy ready made announcement sets that include cards and envelopes.
Plan a Digital Family Album

1. Write out a list of living relatives and contact them for photographs. Keep this list in your computer so you can note which pictures you received from various people. Include names and contact information on the list, as well as their relationship to the family line being researched.

2. Create a form letter on your word processor to be sent to everyone on your list. Include the following information and requests in your letter:
   - Introduce yourself, if the relative is distant, and you’re not well acquainted.
   - Outline your project, including the family line you’re focusing on, and ask for the specific images of people, houses, and documents that you’re looking for (such as the home in Figure 17-7).
   - If the owner of the pictures has the ability to scan the photos, or is willing to have a photo CD made at the appropriate resolution, this saves mailing precious original photos back and forth.
   - Give instructions identifying the pictures. Ask for them to include the owner’s name, and the name, location, and date of the subject (if known). The photos should be numbered with a soft pencil on the back, and the corresponding information sent on a separate sheet or floppy disk.
   - If there is any story or additional information about the occasion of the photo or the people and places it depicts (see Figure 17-8), ask for that information as well.
   - Request a response regarding the number of photos the owners are sending prior to actually mailing them. This is important in planning postage and packaging for the next step.

Figure 17-7: Childhood home

Figure 17-8: Relatives at former family home

After collecting and scanning original family photos, consider storing and sharing them on the Web. Many online photofinishing services offer image storage and the capability to share photos with friends and family. Some Web sites offer this service free, and others charge a nominal monthly fee based upon the number of photos you upload. Check out the photofinishing operations at www.ofoto.com, www.shutterfly.com, and www.snapfish.com.
Chapter 17: Creative Mini-Projects

3. When you know how many and what size pictures you are receiving from someone, send them a large, self-addressed padded mailer specifically for photos (marked “photos, do not bend”) with enough postage for the photos. If someone is sending a box full, you can send them the postage in advance.

Creating a family history isn’t just a project; it’s an obligation to future generations. An important component of such a history is a digital album, including pictures of as many family members as you have, old and new. Few of us have pictures of our ancestors dating further than the early twentieth century, but some people are blessed with very early photographs of their ancestors during the American Civil War and beyond. Scan and preserve these pictures — and distribute them as digital family albums for everyone in the family to treasure.

As all families are made up of other families, begin with one particular line — for example, your maternal grandmother’s family (her parents, brothers, sisters, spouse, her children, their spouses, their children, their spouses . . . ). Then you can progress to your maternal grandfather’s family, and so on. (This could keep you gainfully employed for a loooong time and makes a great retirement project!)

4. When you locate and organize old family photographs with as much identifying information as you have, create an archival file. Include printouts of the identifying information for each photo for quick reference. Use acid-free paper dividers and boxes to protect the photos. The best containers are archival photo boxes, but you may use portfolios or other types of containers that are roomy enough for the photos. Avoid crowding, and make sure the photos are protected from scratching, and from contact with plastic or nonacid free surfaces.

Figure 17-9: Adobe Photoshop Album

Figure 17-10: Aunt Mary as a child
5. List the locations of family homes, especially old home places; organize them with the photographs of the people who lived there. If you can’t locate photos of old family homes, find out if they still exist and make arrangements to photograph them.

6. Organize the pictures from the oldest to the newest members of the family, including birth and death dates if known and the town, county, and state they resided in. (This makes genealogical research much easier.)

7. Use an album program, such as Adobe Photoshop Album, to create and organize your database of images, as shown in Figure 17-9.

8. Try to include pictures of each family member at different ages, as in Figure 17-10. For example, a picture of your grandmother as a young girl, as a young mother, and as you know her today. Or dad and uncles as young men, as shown in Figure 17-11. Children especially love seeing their relatives dressed in the clothes of “the olden days,” as shown in Figure 17-12.
Make a Digital Family Album

1. Scan your family photographs into your computer. Be very careful scanning old photographs, particularly if they’re in old cardboard folders. If you can safely remove the photos from the folders, then do so.

   Once you scan the pictures, return them to their owners — a good idea as people are very anxious about their photographs!

2. With your folder of images open in Adobe Photoshop Album, select the images you wish to add to a gallery.

3. Choose Creations ➪ Album from the tool menu at the top of your screen. The Album Creation Wizard opens.

4. Select the album style you wish to create and click Next. This is a good choice for a basic database.

5. Type the information you wish to appear on the title and subsequent pages; then click Next.

6. Select the photos you wish to include in your album by selecting the photos in the Pick Your Photos window, as shown in Figure 17-13; then click Next.

7. Review the album by clicking Full Screen Preview. When you’re satisfied with your choices, click Next.

8. Click the Save as PDF button and follow the directions to create an Adobe Acrobat Reader eBook or PDF file of your album.

9. After you publish your Album, as shown in Figure 17-14, click the Done button.
Make an Insurance Inventory

1. Begin by taking wide shots of each room (an example is shown in Figure 17-15).

2. Start in one corner of a room and move around taking pictures of everything in it, including carpets, draperies, blinds, flooring, cabinetry, and furniture.

3. Keep a record in a notebook of all the pictures, noting the subject of each photo for later reference.

4. Set up a flat surface with a dark neutral background for shooting small and/or valuable objects away from clutter, as shown in Figure 17-16.

5. For sets of items, such as china, take one picture of the entire set; then take a separate shot of one of the items close-up to show the pattern. Also take a shot of one of the maker’s marks, if the items have one.

6. If your electronics gear has a serial number, take a close up. If equipment is etched with your name, even better.

   Take care when you shoot pictures of objects that include glass, mirrors, and reflective surfaces (including protective glass). Use your flash, but angle the shot so that light doesn’t reflect directly into the camera’s lens.

7. Shoot pictures of your open closets to show the quantity of clothing and some close-ups of labels to indicate its quality. Do the same for drawers of clothing or linens.

8. Make sure your inventory includes everything you own from mattresses to garden tools to musical instruments to art supplies to — well of course, cameras. Don’t skimp!

   Store your home inventory on CD-ROM, away from home. Some people put them in safe deposit boxes, others take advantage of storing digital photographs in cyberspace with Internet Service Providers. Remember, however, your inventory is only as accurate as its last update. New stuff, new inventory!

Figure 17-15: A context shot of a room

Figure 17-16: A close-up with neutral background
Make a Photo T-Shirt

1. Choose the type of iron-on transfers (available at craft and office supply stores) appropriate for your project. There are transfer papers for use on dark and light colored fabric and backgrounds, and for laser or ink jet printers.

Most t-shirt transfer papers require that the image be printed as a mirror image, but some, particularly those for use on dark colored backgrounds do not. The package instructions tell you whether or not the step of reversing the image is necessary.

2. If your paper requires that the image be reversed, open the image you wish to transfer to your t-shirt in Microsoft Photo Editor and choose Image ➤ Rotate to open the Flip and Rotate dialog box. (If your paper does not require this step, simply open your image and skip to Step 6.)

3. Select Mirror.

4. Click OK to accept the change in the image. Figure 17-17 shows a rotated image.

5. Choose File ➤ Save.


7. Print a test of your image on plain paper.

8. Load your transfer paper into your printer, following the transfer package instructions.

9. Choose File ➤ Print to print the transfer.

Set Canon printers to the Normal Paper Quality setting; Epson printers to 300 dpi or higher and use the Special Coated Paper setting; Hewlett Packard printers to the Plain Paper or T-Shirt Transfer setting.

Figure 17-17: Flipping an image in the Rotate dialog box

Figure 17-18: A completed T-shirt
10. Set your iron temperature according to the transfer paper package directions, with the steam setting turned off.

11. Iron your t-shirt so the area to receive the transfer is wrinkle-free and let it cool completely.

12. Lay the transfer on the shirt with the image side down, and iron on the transfer according to the manufacturers instructions, as shown in Figure 17-18.

13. Wait until the shirt and transfer are completely cool (at least 5 minutes), and then peel the transfer from the fabric.

Individual packages of transfers have slightly different instructions. Some require a longer ironing process than others. Though this process is really easy, always read the package instructions before beginning to iron on the transfer.

Set a Digital Image as Your Wallpaper

1. To spice up your computer by displaying a digital photo that you’ve taken, right-click anywhere on your desktop.

2. In the pop-up menu that appears, select Properties.

3. Choose the Desktop tab, as shown in Figure 17-19.

4. Click the Browse button and select the image you wish to use as wallpaper.

Avoid busy images for your desktop; they make it difficult to see your icons.

5. Click the Apply button to make this image your wallpaper, as shown in Figure 17-20.

6. Click OK to exit the Desktop window.
Create an Organization Photo Directory

1. Scan or shoot photos of the people that you wish to include in your photo directory.

   Photo directories for organizations include pictures as well as the contact information of the people listed. Photographs used in directories may be either formal portraits or candid shots.

2. For formal shots, set up a neutral background and place a chair for the people being photographed in front of it.

   You can simply use a blank wall as the background, or pose the subjects in front of curtains. A more interesting choice is the photographic backdrop paper available from photographic supply stores. Such paper is available in different sizes, and a wide array of colors, textures and patterns, including scenes, clouds, and so on. Using such paper may be a creative addition to the project, but take care you don’t choose too busy a background or it detracts from the portraits themselves.

3. Set up your tripod and camera in front of the background.

4. Set your camera to Portrait mode as shown in Figure 17-21.

   Find out how to use Portrait mode and flash in Chapter 3.

5. Have the person being photographed sit in the chair, and check the focus of your camera for every person before taking the picture.
You may use candid shots rather than formal portraits. At an organizational gathering, circulate among the members and take full face candid shots of each person. Use Portrait mode and fill-in flash, if needed. Figure 17-22 shows a fill-in flash.

6. If you don’t shoot digital images for your photo directory, you can use existing print photos. In order to do this, assemble the images and scan them. Open Microsoft Word and choose File➪New➪Blank Document.

You can use software, such as Microsoft Publisher, for this kind of project if you need to make unusual layouts or print the directory in booklet form. Publisher allows you to create books and booklets in different sizes and shapes.

7. Choose Insert➪Picture➪From File and select the photo you wish to use, as shown in Figure 17-23.

8. Add appropriate text to your directory, as shown in Figure 17-24.

9. Repeat Steps 7 and 8 until you complete your directory.


11. Choose File➪Print to print out the directory.
Show Photos on Your TV

1. There are frequent occasions when you want to share photos you have recently shot with family or friends. You also might like to use photos in a school or business presentation but don’t have time to make a CD-ROM or PowerPoint presentation. Most digital cameras allow you to show photos directly from the camera on a TV set. In order to do this, attach the supplied AV cable to the AV outlet on your camera, as shown in Figure 17-25.

   Most digital cameras have AV outputs and come with appropriate cables to attach the cameras to a TV set to display images. The yellow plug is for video and the white is for audio.

2. Set your camera up in the same way as to display the images in memory on the LCD screen.

   See Chapter 4 to find out how to view digital pictures on your LCD screen.

3. Show your photos on your TV for family and friends, as shown in Figure 17-26. You can scroll through the pictures displayed on the TV just as you do viewing on the LCD screen.

   You can copy a set of photos onto a memory card and carry them to a family reunion, business presentation, or other event and make a slide presentation using your digital camera and TV set or video projector.

Figure 17-25: Hooking a camera to a TV

Figure 17-26: Viewing a slideshow on TV
Make a Mini-Movie Clip

1. Set your camera to movie mode.

   The ability to capture mini-movie clips is a creative feature of most digital cameras. You can also use your digital camera to capture important brief moments, such as the baby’s first steps, when you don’t have a video camera handy.

   Select the resolution or image size of the mini-movie in your camera setup screen. The larger the image, the more memory it takes to store the same length of video. Small clips are good for comments or to share a brief moment in a child’s life. Larger clips are better when there is specific information to share, such as how to install a washer in a leaky faucet.

2. Hold down the button to shoot your brief movie clips.

   Remember that movie clips take up more memory than still images. Keep your clips brief. You can also mix video and still images on your memory card so switching from still to movie mode during a shoot is simple.

3. Transfer your movie clips to your computer from your memory card or by connecting your USB cable (as you do for transferring still images).

4. Copy your movie clips to your computer, as shown in Figure 17-27.

5. Play back your movie clips using Microsoft Media Player, as shown in Figure 17-28.
Record Sound Notes

1. Recording sound notes on your camera is a great help when you’re shooting a series of images, such as when shooting a home insurance inventory. To record a brief sound note on your computer, begin by setting your camera to sound record mode.

![Step 1](image1.png)

You can “annotate” your still images with a brief audio message so you can remember the context of the photo you’re shooting later. Using sound clips for this purpose, although exacting a premium in media storage space, keeps your hands on the camera rather than switching back and forth to a notebook. The steps for planning and shooting a home insurance inventory appear earlier in this chapter, in the section “Make an Insurance Inventory.”

2. Shoot your brief sound note.

![Step 2](image2.png)

Sound clips take up a significant amount of memory. Keep your sound notes brief.

3. Transfer your sound notes to your computer from your memory card or by connecting your USB cable as you do for transferring still images.

4. Copy your sound notes to your computer, which looks much the same as copying a picture or movie to your computer, as shown in Figure 17-29.

5. Play back your sound notes using Microsoft Media Player as shown in Figure 17-30.

![Figure 17-29: Transferring sound notes to computer](image3.png)

![Figure 17-30: Playing back sound notes with Media Player](image4.png)
• A •

accessories, choosing, 12, 23. See also specific accessories
add-on (attachment) lenses, 33
Adobe. See also Photoshop Album (Adobe);
Photoshop Elements (Adobe)
Photoshop, 75, 109
Web site, 143
airbrush tool for touch-up, 170
albums of photos, 150, 171–172, 185–188
alkaline batteries, 13
animals, taking shots of, 45, 177
Aperture Priority mode, 16, 30
aperture setting for close-ups, 156
applications. See software; specific programs
archiving printed photos, 171–172
arranging layers in Photoshop Elements, 122
attachment lenses, 33
Auto mode, 16, 27
automatic focus
defined, 17
locking, 40, 47

• B •

background
adding from another photo, 128–129
bright, lighting subject with flash, 43
eliminating clutter in portraits, 42
eliminating distracting elements, 36
establishing scale for, 37
for nature shots, 46
for pet or animal shots, 45
batteries
charger for, 23
choosing a camera and, 13, 26
external battery packs, 13
installing, 26
reducing usage of, 31
travel and, 175
black and white (grayscale) images, 97
blemishes on photos, removing, 95
blog creation, 180
BMP format, 74–75
bracketing exposure, 47
brightness, adjusting
when editing images, 82, 90
when scanning images, 66
Bullseye icon, 1
burning video CDs, 151
Burst mode, 16

• C •
camera bags, 23
cameras. See choosing a camera; digital cameras
card readers, 23, 49, 51–52
card storage. See memory cards
categorizing photos with tags, 146
CCD RAW format, 14, 15
CD-R storage
  for archiving printed photos, 172
  in cameras, 10
  copying photos to, 57
  creating video CDs, 151
chalk effect, 100
charcoal effect, 100
china, tips for shooting, 161
choosing a camera
  camera functions (modes), 16–17
  for documenting travels, 175
flash features, 20
form factors, 6
goals, 5
image transfer solutions, 18
lens features, 8–9
miscellaneous features, 21–22
output formats, 14
photo storage solutions, 10
power solutions (batteries), 13, 26
resolution (megapixels), 7
technologies, 19
zoom lenses, 11

choosing a printer, 133–135
choosing accessories, 12, 23
chrome effect, 111
close-up (macro) lenses, 8, 33
close-up shots. See also shooting close-ups for eBay
  composition rule for, 37
  insurance inventory, 189
  of nature, 46–47
  setting up the camera, 156
clothing, tips for shooting, 161
clouds effect, 115
collages, creating, 97–98
color
  adjusting for photos, 167
  adjusting when scanning images, 67
  balance, adjusting, 82
  converting to grayscale, 97
  faded photos, fixing, 91
  hue/saturation adjustment, 91, 167
  inverting image colors, 78
  sorting photos by similarity, 145
color laser printers, 134–135. See also printers;
  printing photos
colored pencil effect, 112
Compact Flash cards, 10
composing photos
  changing your position, 36
  eliminating distracting elements, 36
  framing stationary subjects, 38
  general rules, 37
  horizontal subjects, 36
  landscapes, 44
  moving the subject out of the center, 37, 40
  of nature, 46, 47
rule of thirds, 36, 44
vertical subjects, 36
compression of image files, 14
computer. See also Windows (Microsoft)
  connecting camera to, 51
  installing camera drivers, 52
  setting wallpaper for, 191
  transferring images from camera, 53, 56
connecting camera to computer, 51
contrast, adjusting, 82, 90
converting
  color to grayscale, 97
  image to new format, 74–75
copy stand for camera support, 158
copying. See also transferring images
  burning video CDs, 151
  images on layers in Photoshop Elements, 123
  photos to CD, 57
costs
  of cameras, 6, 7
  of printing, 138
damage in photos, removing, 95, 169
cropping images, 77, 167
damaged photos. See repairing digital images
date and time stamps, 21
date, sorting and viewing photos by, 145
deleting. See also removing
  layers in Photoshop Elements, 124
  photos in camera, 50, 54
depth of field, 30, 47
despeckling images, 87, 168
diffuser for light, 157
digital cameras. See also choosing a camera
  connecting to computers, 51
deleting photos in, 50, 54
  film cameras versus, 35
  installing drivers for, 52
  printing directly from, 19, 133, 135, 140
  reviewing photos in, 50
  setting up, 26–27
  showing photos on TV, 194
  transferring images to computer, 53, 56
digital family album, 185–188
digital slideshows
  creating in Photoshop Album, 148–149
  viewing in Windows, 57
  viewing on TV, 194
digital zoom, 8, 11, 28
digitizing existing images. See scanning images
Director (HP) software, 62–67
directory, photo, 192–193
displaying images. See viewing images
distortion around an axis, 114
documenting travels
  blog creation, 180
  choosing gear, 175
  creative effects, 178
  editing photos on the road, 179
  e-mailing photos from the road, 180
  including people and pets in photos, 177
  overview, 173
  researching and planning photo shoots, 174
  telling the story, 176
drivers, installing for camera, 52
dust in digital images, removing, 94
dye sublimation printers, 133–135. See also
  printers; printing photos
• **E** •
eBay photos. *See* shooting close-ups for eBay editing images. *See also* layers (Photoshop Elements); resizing images; special effects adding background from another photo, 128–129
adding digital frame, 128
brightness adjustment, 82, 90
changing proportions, 73
collages, creating, 97–98
color balance adjustment, 82
contrast adjustment, 82, 90
converting color to grayscale, 97
converting to new format, 74–75
creases and blemishes, removing, 95, 169
cropping, 77, 167
despeckling, 87, 168
dust and scratches, removing, 94, 168
depicted photos, fixing, 91
fixing common problems, 81–87
flipping or rotating, 76, 92, 98
focus problems, fixing, 92
inverting colors, 78
layers for, 117–129
opening an image to edit, 72
painting on an image, 127
red eye removal, 93
repairing digital images, 89–98
on the road, 179
sharpening, 83
smudging, 86
softening, 85
special effects (Photo Editor), 99–107
special effects (Photoshop Elements), 100–107, 108–115
torn photos, fixing, 96
effects. *See* special effects
e-mailing photos, 152, 180
emboss effect, 101
erasing. *See* deleting; removing
Exif 2.1 technology, 19
Exif 2.2 technology, 19, 135
exposure, bracketing, 47
exposure compensation, 16, 41
exposure problems, fixing, 82, 90
external battery packs, 13
eyepiece viewfinders, 22
eyes, shooting at level of, 37
• **F** •
faded photos, fixing, 91, 167
family album, 185–188
file extensions, 75
file formats, 14, 15, 74–75
filling the frame, 37
filters for lenses, 9
filters (software). *See* special effects
Firewire (IEEE 1394), 18
fixed focus, 17, 39
fixing common image problems. *See also* repairing digital images
brightness adjustment, 82
color balance adjustment, 82
contrast adjustment, 82
despeckling images, 87, 168
flipping or rotating, 76, 92
focus problems, 92
need for, 81
posterizing images, 84
red eye removal, 93
sharpening images, 83
smudging images, 86
softening images, 85
flash
attachments, using, 32
built-in versus attachments, 32
camera features for, 20
choosing a camera and, 20
for close-ups for eBay, 157
hot shoe, 32
for improving bad light, 41, 43
for outdoor portraits, 43
red eye removal, 93
reducing battery usage, 31
sync connector, 32
flipping images, 76, 92
floppy disks, as storage in cameras, 10
fluorescent lighting, 157
focal length of lenses, 8, 9
focus and exposure lock, 17, 40, 47
focusing
automatic focus, 40, 47, 92
fixed focus, 17, 39
fixing focus problems, 92
locking Autofocus, 40, 47
manual focus, 17, 39
in middle distance, 39
form factors
of batteries, proprietary, 13
of cameras, 6, 21
framing photos digitally, 128
framing shots. See composing photos
f-stop setting for close-ups, 156
furniture, tips for shooting, 161

• G •

GIF format, 74–75
greyscale images, 97
greeting cards, creating, 150

• H •
hiding layers in Photoshop Elements, 124
horizon, avoiding as center line, 37, 44
hosting services for eBay, 164
hot shoe flash attachment, 32
HP Director software, 62–67

• I •
IEEE 1394 (Firewire), 18
Image Director (HP), 62–67
importing photos into Photoshop Album, 144
indoor shots, 41, 42. See also flash
infrared image transfer, 18
ink jet printers, 133–135. See also printers;
printing photos
installing
batteries, 26
camera or card reader drivers, 52
insurance inventory, 189
Internet resources. See also shooting close-ups for eBay
Adobe Web site, 143
blog sites, 180
conventions for Web site addresses, 1
focal length effect, 9
picture-hosting services, 164
printing services online, 57, 61, 141
inventory for insurance, 189
inverting
image colors, 78
images (flipping vertically), 76, 92

• J •
Jasc Paint Shop Pro. See Paint Shop Pro (Jasc)
jewelry, tips for shooting, 160
JPEG format, 14, 15, 74–75

• L •
Landscape mode, 17, 44
landscapes, shooting, 44
laser printers, color, 134–135. See also printers; printing photos
layers (Photoshop Elements)
adding a new, blank layer, 120
adding background from another photo, 128–129
adding digital frame to photo, 128
changing order of, 122
copying images on, 123
deleting, 124
editing, 123
hiding or displaying, 124
linking, 121
moving image elements to new photo, 126
moving images on, 123
moving selection to new layer, 119–120
painting on an image, 127
power of, 117
renaming, 121
resizing images on, 123
selecting area to move to layer, 118–119
text, adding to images, 125
LCD display on printers, 135
LCD shield, 23
LCD viewfinder, 22, 23, 50
leading lines, 37
lens cloth, 23
lens extenders, 9, 33
lenses, 8–9, 33. See also specific types
lighting
bad, shooting in, 41
for close-ups for eBay, 157
effects, 113
for nature shots, 46
outdoor portraits and, 43
linking layers in Photoshop Elements, 121
Lion (lithium ion) batteries, 13
lithium batteries, 13
locking
Autofocus, 40, 47
memory cards, 50
lossless versus lossy compression, 14
macro lenses, 8, 33
macro mode, 8
managing photos
in Photoshop Album, 145–147
in Windows, 56–57
manual focus, 17, 39
Manual mode, 16
megapixels, 7, 26–27
memory cards. See also specific types
card readers, 23
choosing a camera and, 10
deleting photos in camera, 50
image transfer solutions, 18
installing, 26
locking to protect photos, 50
number of photos stored by, 10, 15, 27
printing directly from, 135, 139
reusing, 49
transferring images to computer, 53, 56
Memory Stick (Sony), 10
Microsoft Paint, 79
Microsoft Photo Editor. See Photo Editor (Microsoft)
Microsoft Windows. See Windows (Microsoft)
mini-movie clip, 195
mirroring images (flipping horizontally), 76, 92
MMC cards, 10
modes of cameras, 16–17
monopods, 12
mood, establishing, 37
mosaic effect, 110
movement
creating, 37
wind effect, 110
movie clip, making, 195
multiple exposures, 21
naming
conventions for photos, 57
file extensions and, 75
renaming groups of photos, 55, 147
renaming layers in Photoshop Elements, 121
renaming photos in Windows, 55, 57
scanned images in Windows, 61
nature, shooting photos of, 46–47
negatives
inverting colors of scanned negatives, 78
scanning, 64
nickel cadmium batteries, 13
NiMH (nickel-metal hydride) batteries, 13
normal lens, 8
Notepaper effect (Photo Editor), 103
Obermeier, Barbara (Photoshop Album For Dummies), 143
online photo printing services, 57, 61, 141
online photo storage, 164, 185
optical zoom, 8, 11, 28. See also zoom lenses
organization photo directory, 192–193
organizing photos. See Photoshop Album (Adobe)
outdoor shots. See also documenting travels
animal photography, 45
in bad light, 41
close-ups for eBay, 157
landscapes, 44
nature, 46–47
portraits, 43
wedding shoot, 182–183
outlining edges of images, 107
output formats, 14, 15

Paint (Microsoft), 79
Paint Shop Pro (Jasc)
brightness adjustment, 82
contrast adjustment, 82
converting image to new format, 75
cropping images, 77
flipping or rotating images, 76
smudging images, 86
softening images, 85
painting on images, 127
paintings and prints, tips for shooting, 162
panoramic feature, 21
paper for printing photos, 138
pen-and-ink effect, 106
pets, taking shots of, 45
photo albums, 150, 171–172, 185–188
photo directory, 192–193

Photo Editor (Microsoft)
chalk effect, 100
charcoal effect, 100
emboss effect, 101
Notepaper effect, 103
outlining edges, 107
pen-and-ink effect, 106
special effects, 99–107
stained glass effect, 104
textured effect, 105
undoing effects, 101
watercolor effect, 102
photo T-shirt, 190–191
photographic effects. See special effects
Photoshop (Adobe), 75, 109
Photoshop Album (Adobe)
burning video CDs, 151
categorizing photos with tags, 146
described, 143
digital slideshow creation, 148–149
family album creation, 188
greeting card creation, 150
importing photos into, 144
organizing photos with, 145
photo album creation, 150
renaming groups of photos, 147
searching for tagged photos, 147
sharing photos via e-mail, 152
sorting photos by criteria, 145
Photoshop Album For Dummies
(Obermeier, Barbara), 143
Photoshop Elements (Adobe). See also layers (Photoshop Elements)
adding background from another photo, 128–129
adding digital frame to photo, 128
brightness adjustment, 82, 90
chalk effect, 100
charcoal effect, 100
chrome effect, 111
collages, creating, 97–98
colored pencil effect, 112
contrast adjustment, 82, 90
converting color to grayscale, 97
converting image to new format, 75
creases and blemishes, removing, 95, 169
cropping images, 77, 167
despeckling images, 87, 168
distortion around an axis, 114
dust and scratches, removing, 94, 168
emboss effect, 101
faded photos, fixing, 91
flipping or rotating images, 76, 92, 98
focus problems, fixing, 92
hue/saturation adjustment, 82, 91, 167
inverting image colors, 78
JPEG compression adjustment in, 75
layers, 117–129
lighting effects, 113
mosaic effect, 110
moving image elements to new photo, 126
outlining edges, 107
painting on an image, 127
pen-and-ink effect, 106
Photoshop versus, 109
posterizing images, 84
Quick Fix View, 90–92
resizing images, 73
saving image for Web, 79
red eye removal, 93
selecting area of image, 118–119
sharpening images, 83
smudging images, 86
softening images, 85
special effects, 100–107, 108–115
stained glass effect, 104
textured effects, 103, 105
torn photos, fixing, 96
touch-up with airbrush tool, 170
watercolor effect, 102
wind effect, 110
PictBridge technology, 19, 135, 140
picture-hosting services for eBay, 164
PIM (Print Image Matching) technology, 19, 135
PNG format, 74–75
point-and-shoot cameras, 6, 12, 175
Portrait mode, 17, 28, 42–43. See also portraits
portraits. See also subject
digital family album, 185–188
eliminating background clutter, 42
indoors, 42
moving the subject out of the center, 40
outdoors, 43
of pets or animals, 45
photo directory, 192–193
shooting at eye level, 37
wedding announcement creation, 184
wedding shoot, 182–183
posterizing images, 84
power solutions. See batteries
previewing images. See viewing images
price of cameras, 6, 7
Print Image Matching (PIM) technology, 19, 135
printers
extra features, 135
resolution of, 133, 134
setting options for, 136–137
speed of, 135
types of, 133, 134
printing photos
archiving printed photos, 171–172
choosing media for, 138
costs, evaluating, 138
directly from cameras, 19, 133, 135, 140
directly from memory cards, 135, 139
Exif 2.2 technology and, 19
PictBridge technology for, 19, 135, 140
setting printer options, 136–137
using in-store printing services, 142
using online printing services, 141
in Windows, 57
printing services
in-store, 142
online, 57, 61, 141
professional cameras. See prosumer cameras;
SLR (single lens reflex) cameras
Program mode, 28
programs. See software; specific programs
projects. See also specific projects
close-up photos for eBay, 155–164
digital family album, 185–188
documenting travels, 173–180
insurance inventory, 189
mini-movie clip, 195
photo directory, 192–193
photo T-shirt, 190–191
restoring old photos, 165–172
setting image as computer wallpaper, 191
showing photos on TV, 194
sound note recording, 196
wedding announcement creation, 182–183
wedding shoot, 182–183
prosumer cameras
for documenting travels, 175
form factor, 6
interchangeable lenses for, 9
tripods for, 12
raised image effect, 101
RAW format, 14, 15
recording sound notes, 196
red eye removal, 93
reducing images. See resizing images
remote control, 21
removing. See also deleting
color (converting to grayscale), 97
creases and blemishes, 95, 169
dust and scratches, 94, 168
red eye, 93
renaming. See naming
repairing digital images. See also fixing common image problems
brightness adjustment, 82, 90
contrast adjustment, 82, 90
converting color to grayscale, 97
creases and blemishes, removing, 95, 169
cropping, 167
dust and scratches, removing, 94, 168
faded photos, fixing, 91, 167
focus problems, fixing, 83, 92
hue/saturation adjustment, 91, 167
red eye removal, 93
rotating images, 92
scanning photos to repair, 89, 166
torn photos, fixing, 96
touch-up with airbrush tool, 170
resampling images, 73
resizing images
changing proportions during, 73
cropping, 77, 167
enlarging, quality and, 73
Free Transform in Photoshop Elements, 98
on layers in Photoshop Elements, 123
need for reducing, 71
steps, 73
when scanning, 65
resolution
of cameras (megapixels), 7, 26–27
of images, memory card capacity and, 10, 15, 27
of printers, 133, 134
restoring photos. See repairing digital images
reviewing images. See viewing images
rotating images, 76, 92, 98
rule of thirds, 36, 44

saturation of colors, adjusting, 91, 167
scale, establishing, 37
scanning images. See also repairing digital images
Color Adjustment option, 67
damaged photos for repair, 89, 166
for family album, 188
HP Director software for, 62–67
inverting colors of scanned negatives, 78
Lighten/Darken option, 66
negatives, 64, 78
photos, 60–62
Resize option for, 65
Sharpen option, 67
slides, 63
uses for, 59
Windows Scanner and Camera Wizard for,
60–61
scratches on photos, removing, 94, 168
SD cards, 10
self-timer, 21
setting up the camera
for close-ups, 156
overview, 26–27
sharpening images
  outlining edges, 107
  when scanning images, 67
shooting close-ups for eBay
  advantages of, 155
  setting up lighting, 157
  setting up the camera, 156
  setting up the shot and shooting, 159
tips for particular item types, 160–162
uploading photos to eBay, 163
using a copy stand for camera support, 158
using hosting services, 164
shooting photos. See also projects
  adjusting brightness in Program mode, 28
  in Auto mode, 27
  in bad light, 41
  composing shots, 36–37
  elements of great photos, 35
  focusing in middle distance, 39
  framing stationary subjects, 38
  landscapes, 44
  lengthening depth of field, 30
  moving the subject out of the center, 37, 40
  nature shots, 46–47
  of pets or animals, 45
  in Portrait mode, 28
  portraits, indoors, 42
  portraits, outdoors, 43
  reducing battery usage, 31
  setting up the camera, 26–27, 156
  in Shutter Priority mode, 30
  stopping action in Sport mode, 29
  using attachment lenses, 33
  using flash attachment, 32
using tripod, 31
zooming, 28
Shutter Priority mode, 16, 30
shutter speed
  for close-ups for eBay, 156
  hand-held shots and, 30
  Shutter Priority mode, 16, 30
silver, tips for shooting, 160
single lens reflex cameras. See SLR cameras
  form factor, 6
  interchangeable lenses for, 9
  through the lens viewing in, 22
  tripods for, 12
smudging images, 86
snapping photos. See shooting close-ups for eBay; shooting photos
softening images, 85
software. See also specific programs
  choosing a camera and, 22
  photo editing software, 71, 81
Sony Memory Stick, 10
sorting photos in Photoshop Album, 145
sound recording, 21, 196
special effects
  chalk, 100
  charcoal, 100
  chrome, 111
  clouds, 115
  colored pencil, 112
distortion around an axis, 114
emboss, 101
lighting effects, 113
mosaic, 110
outlining edges, 107
pen-and-ink, 106
in Photo Editor, 99–107
in Photoshop Elements, 100–107, 108–115
posterizing, 84
sharpening, 83
softening, 85
stained glass, 104
textured, 103, 105
undoing in Photo Editor, 99, 101
watercolor, 102
wind, 110
speed of printers, 135
speed of shutter. See shutter speed
Sport mode, 17, 29
stained glass effect, 104
stationary shots, framing, 38
still photography, tripods for, 12
stopping action, Sport mode for, 29
storage media in cameras. See also memory cards
  choosing a camera and, 10
  number of photos stored, 10, 15, 27
storing photos online, 164, 185
storing printed photos, 171–172
straps, camera, 23
subcompact cameras, 6
subject. See also portraits
  horizontal versus vertical, 36
  making prominent, 37
moving out of the center, 37, 40
pets or animals, 45
stationary, framing, 38
sync connector for flash, 32

tagging photos in Photoshop Album
  searching for tagged photos, 147
  steps, 146
taking photos. See shooting close-ups for eBay;
  shooting photos
tears in photos, fixing, 96
telephoto lenses, 8, 33
text layers, adding to images, 125
textured effects, 103, 105
thirds, rule of, 36, 44
trough the lens viewing, 22
TIFF format, 14, 15, 74–75
time and date stamps, 21
time, sorting and viewing photos by, 145
Time-lapse mode, 16
torn photos, fixing, 96
touch-up with airbrush tool, 170
transferring images. See also copying
  from camera to computer, 53, 56
  choosing a camera and, 18
  connecting camera to computer, 51
  methods for, 18
transparency film for printing, 138
transposing images (mirroring and inverting), 76
travel photos. See documenting travels
tripods, 12, 21, 30, 31
T-shirt, photo, 190–191
TV, showing photos on, 194

● U ●
ultra compact cameras, 6, 175
uploading photos to eBay, 163
USB cable, 18, 51, 133

● V ●
vacation photos. See documenting travels
video CDs, burning, 151
Video mode, 16
video photography
mini-movie clip, 195
tripods for, 12
viewing images
in camera, 50
digital slideshows, 57, 148–149, 194
layers, hiding or displaying, 124
in Photoshop Album, 145
previewing before scanning, 61, 62
on TV, 194
in Windows, 56, 57

● W ●
wallpaper for computer, 191
watercolor effect, 102
Web resources. See Internet resources
Web sites, publishing pictures to, 61
wedding announcement creation, 184
wedding shoot, planning, 182–183
weight of cameras, 21
white balance, 17
wide angle lenses, 8, 33
wind effect, 110
Windows (Microsoft)
batch-renaming function, 55
deleting camera images from, 54
managing photos in, 56–57
opening an image to edit, 72
Photo Printing Wizard, 136, 139
renaming photos, 55, 57
Scanner and Camera Installation Wizard, 52
Scanner and Camera Wizard, 60–61
viewing photos in, 56, 57

● X ●
XD cards, 10

● Z ●
zoom lenses
choosing a camera and, 9, 11
defined, 8
limitations of, 33
optical versus digital zoom, 8, 11
using, 28
zoom ratio, 11
Don’t forget about these best-selling For Dummies® books!

Windows® XP
FOR
DUMMIES®
2nd Edition
A Reference for the Rest of Us!
Revised with expanded e-mail, security, and upgrading answers
Andy Rathbone
0764573268
Author of Managing Your PC and Windows Media Center
Dummies

eBay
FOR
DUMMIES®
4th Edition
A Reference for the Rest of Us!
Expert advice on bidding to win and successful selling
Marsha Collier
0764556541
Author of Selling on eBay Business For Dummies

TEAM LIN G - LIVE, INFORMATIVE, NON-COST AND GENUINE!
Don’t forget about these best-selling For Dummies® books!